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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product 
value chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains 
the latest versions of the Agile PLM PDF files. You can view or download these 
manuals from the Web site, or you can ask your Agile administrator if there is an Agile 
PLM Documentation folder available on your network from which you can access the 
Agile PLM documentation (PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.



x

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1About Agile PLM 9.3.5

This chapter contains important information about this product release.

Oracle Software Delivery Cloud Download Checklist
Oracle products are distributed as “Product Packs”. A Product Pack is an electronic 
version of the software. Refer to the Media Pack description or the list of products that 
you purchased on your Oracle Ordering Document.

Then, view the Quick Install Guide License List to help you decide which Product 
Pack you need to select.

Prior to downloading, verify that the product you are looking for is in the License and 
Options section of the Product Pack "Readme".

Oracle recommends that you print this "Readme" document for reference.

Please download each Product Pack from the Oracle Software Delivery Cloud web site 
(https://edelivery.oracle.com/) as specified below.

1. Oracle Agile PLM Application Components

2. Oracle Fusion Middleware 12.1.3 infrastructure (includes WebLogic Server)

3. Oracle Database

There will be an itemized part list within each of the packs. You will need to download 
all items in order to have the complete download for the desired Oracle Agile release.

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly 
portable Zip utility. After downloading one or more of the archives, you will need the 
UnZip utility (for UNIX or Windows platforms) or the WinZip utility (for Windows 
platform) to extract the files. You must unzip the archive on the platform for which it 
was intended.

Verify that the file size of your downloaded file matches the file size displayed on 
Oracle Software Delivery Cloud.

Unzip each Zip file to its own temporary directory.

For example, create a directory structure called agile935downloads on your hard drive:

■ c:\agile935downloads

Then create a new directory for each Zip file you downloaded:

■ C:\agile935downloads\wls12

■ C:\agile935downloads\AgilePLM935_Disk1
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After extracting the software from the Zip files, you can install from your computer's 
hard drive.

Install and Test Notice

Important:  Install and test this release on a designated test server 
before installing it on your production environment. Your test 
environment should mirror your production environment as closely 
as possible to provide accurate testing results. It is important to 
validate the installation of this release, and confirm your integrations 
are working correctly as part of your minimum due diligence. Any 
problems or questions noted during your system testing should be 
resolved before installing this release on your production 
environment.

Platform Support
Refer to the Software Requirements section in the Agile PLM Capacity Planning Guide 
for platform support details.

Minimum Versions of Additional Agile PLM Software
Agile PLM 9.3.5 requires new versions of OPLA, AutoVue, EC MCAD, EC ECAD, 
PLM Mobile, D2R AIA PIP for EBS, D2R AIA PIP for SAP, and a patch to enable RMW 
9.3.4. Please refer to the Agile PLM Capacity Planning Guide for specific version 
information. These additional software components will release after the initial release 
of Agile PLM 9.3.5.

Oracle Agile Product Overview Checklist
After reading the content of this Oracle Agile PLM release document, we suggest 
performing the following tasks:

■ Feature Review:

– Review the New Features and Resolved Issues sections to make sure you 
understand the overall product changes in this release.

■ Business Process Review:

– After completing the New Feature and Resolved Issues review, make sure you 
understand if any of your current business processes are impacted by this 
release and/or if they might need to be modified and re-evaluated. This is a 
very important preparation step as you move forward with implementing any 
Agile release. Make sure all of your key business processes are thoroughly 
documented and you have an overall business owner who understands each 
process. Use this list of processes as a checklist against the features and 
changes in this Agile release. You may want to assign a "weight" to each 
change in terms of how significant an impact it has to your organization (think 
about re-training users, changing current integrations, etc.)

■ Identify resources to install and test this release.

– Make sure that a test environment is ready and that tests have been developed 
to ensure this release performs the functions necessary for your business. 
Verify that the system can be rolled back in the unlikely event of a failure. 
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Make sure that your testing includes all aspects of the product features, all of 
your business processes and any integration that you may have (AIS, SDK, 
ChangeCAST, ACS, etc.). If considering switching to LDAP authentication, 
come up with a plan to test the LDAP integration. Make sure to cover common 
scenarios like changing password, removing a user, etc.

■ Create an upgrade plan and strategy.

– For a release, we recommend engaging our Oracle Consulting Organization 
for your upgrade. Validate the hardware configuration according to the 
Capacity Planning Guide. If you plan to manage your own upgrade, create a 
very detailed upgrade plan that includes a scheduled start time, an established 
number of “dry” runs, a pre-determined rollout date, and a designated team 
of individuals across your organization with detailed knowledge of product, 
technology, networking, business process, etc.

■ Prepare end-user training.

– We recommend exposing a number of your power users to the new version 
well in advance of a production rollout to ensure that your users deeply 
understand the product functionality. Much of the end user training will 
actually begin during the testing phase. Use this feedback as a basis for your 
overall end-user training.

Accessing Agile PLM Documentation
The following sections describe how to access Agile PLM documentation and sample 
code and scripts.

PLM Solution and Administration Manuals
Please use this Web site to access your Agile PLM 9.3.x documentation, which includes 
manuals about installing PLM, configuring and administering PLM, and all the PLM 
solutions for users:

http://www.oracle.com/technetwork/documentation/agile-085940.html

Note: The documentation of Agile PLM 9.3.x is no longer accessed 
through Metalink.

PLM Sample Code and Scripts
Sample code and scripts pertaining to Agile solutions may be found on the Oracle 
Agile PLM Sample Code page:

http://www.oracle.com/technetwork/indexes/samplecode/agileplm-sample-52094
5.html

New Features in Agile PLM Solutions
For information about the new features and enhancements in this release, see the Agile 
PLM 9.3.5 New Features Overview White Paper.
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2Issues Resolved by Hot Fix Releases

Hot fixes included in this product release are:

PLM Release 9.3.1.0
This section includes Hot Fixes included in Agile PLM 9.3.1.0.

9310_146
Bug ID 19870258: UNABLE TO IMPORT ITEM SUPPLIER DATA WITHOUT SITES 
LICENSE ENABLED

Root Cause: Import side uses supplier id:::site id as unique id to identify one supplier 
row. If site license is disabled, the unique id will be supplier id:::, and import side will 
always execute the add operation. For some supplier rows, import side should do an 
update operation.

Resolution: If the site license is disabled, change site id to common site id.

PLM Release 9.3.1.1
This section includes Hot Fixes included in Agile PLM 9.3.1.1.

9310_319
Bug ID 20174988: ATO FAILING TO COMPLETE 

Root Cause: Item does not have privilege check.

Resolution: Add code to check privilege.

9311_322
Bug ID 20635300: NOTIFY AT APPROVAL OF ROUTING SLIP ON FILE FOLDERS

Root Cause: There is no OOTB notification template defined for FileFolders approval.

Resolution: Added notification templates for file folder & design object per PM's 
requirement.

9311_324
Bug ID 21559688: CREATE CHANGE WORKFLOW CRITERIA USING AN ITEM 
PAGE2 DYN. LIST $USERGROUP FAILS

Root Cause: $USERGROUP is not handled specially for admin criteria.
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Resolution: Specially handle for $USERGROUP.

PLM Release 9.3.1.2
This section includes Hot Fixes included in Agile PLM 9.3.1.2.

9312_297
Bug ID 19544784: COMPLIANCE CALCULATION IS INCORRECT

Root Cause: The different order of adding spec to declaration have different order of 
composition id when already a mfn part is added, so it leads to random picking up of 
compositions.

Resolution: Changed the code to sort the composition by the spec name (ASCII order). 
The user can modify the spec name that they want to reuse.

9312_298
Bug ID 19715310: USER PERFORMS A SAVED SEARCH AND RECEIVES ERROR

Root Cause: We did not support multiple search windows before, so when the 
customer launched multiple windows from MCAD it caused inconsistent/NullPoint 
issues.

Resolution: Refresh search Criteria if there are different BaseClassId/ClassId between 
Cache and UI. Set a flag to indicate search launched from MCAD URL or others. Use a 
special handler for the MCAD case; it should not read last session criteria.

9312_299
Bug ID 19732368: ATTRIBUTES NOT CORRECT AFTER SUBCLASS CHANGE 
THROUGH PROCESS EXTENSION

Root Cause: The attributes in the title block and Page Two do not change according to 
the Part type change when edited in the Item.

Resolution: When Part type changes, save the new subclass and return to view the 
model with attributes refreshed.

9312_300
Bug ID 19826176: QUICKVIEW WINDOW DOES NOT DISPLAY ALL 
INFORMATION

Root Cause: In general, Quick View only looks at Rev information stored in the 
changeKey of VO rows, but for Quick View from search results, the changeKey does 
not have set values.

Resolution: Set the correct Change Key for query result rows from Search, and make 
the Rev consistent in the UI side.

9312_302
Bug ID 20048703: IMPORT OF XLSX FILE CAUSES ERROR BUT XLS FILE IMPORT IS 
OK

Root Cause: The logic used to parse Excel is wrong and some special formats are 
mishandled. 
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Resolution: Change the parsing logic to consider the special format.

9312_303
Bug ID 20093294: AFTER THE 9312_298 PATCH, DASHBOARD WIDGET 
CONFIGURATION SEARCH- NO CRITERIA DISPLAYED

Root Cause: The undefined form causes the problem.

Resolution: Catch the empty form when loading the search criteria.

9312_304
Bug ID 20075954: LINK IN THUMBNAIL ON ITEMS OPENS THE WRONG FILE IN 
AUTOVUE

Root Cause: Those attachment rows added by Search from the same File Folder or 
Design object share the same thumbnail from the corresponding File Folder and 
Design object. URLs generated to view the corresponding file of this thumbnail uses 
incorrect file information from the first row of File Folder or Design object. That is the 
reason why the 2nd row is set as Master thumbnail and the 1st row file is incorrectly 
displayed in viewer applet.

Resolution: Fixed in code to pick up the correct file information by examining the row 
with the same thumbnail id and its file name against the thumbnail caption.

9312_307
Bug ID 20367752: WHERE USED REPORT THROWS UNEXPECTED ERROR

Root Cause: A special handler is missing. The Where Used Report uses relationship 
search, which uses $CURREV and $LATESTREV. The code does not handle the two 
variables very well in some situations. In this case, there is a special privilege 
configured with special criteria.

Resolution: A special handler for $CURREV and $LASTESTREV.

9312_308
Bug ID 20333682: UNABLE TO MODIFY THE CURRENT PRICE PERIOD OF A 
SOURCING PROJECT AF

Root Cause: Date format is not passed as parameter, so in the calendar it only gets the 
default.

Resolution: Show the proper date depending on the passed date format.

9312_309
Bug ID 20378079: FATAL EXCEPTION OCCURED JAVA HEAP SPACE WHEN 
IMPORTING ITEMS

Root Cause: Wrong parameter is used for dummy table row.

Resolution: Use the right parameter to create dummy BaseRow.

9312_310
Bug ID 19060190: AGILE SDK API ISSUE - II - PCM MODULE UNABLE TO ADD 
SOME ITEMS TO 
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Root Cause: In the sc_item table, PCM converts all small letters to capital letters for 
Part Number, but PC does not. Therefore, Agile can not find the proper Item even it 
existed in the PC side when the RFQ was created.

Resolution: Convert all small letters to capital letters when retrieving Part Number in 
sc_item.

9312_311
Bug ID 20671443: TITLE BLOCK PAGE DOES NOT RENDER PALLETS CORRECTLY 
WHEN USING IE11

Root Cause: IE compatability  issue.

Resolution: Enforce IE into IE7 mode, and fix the UI issues.

9312_312
Bug ID 20596790: EC RELINKS WRONG CAD FILES ON LOAD

Root Cause: For an internal object cache, to avoid loading more than one duplicate, the 
ID's hash code was used, which could have generated duplicate hash values although 
it should not.

Resolution: The internal object cache's key value was changed from the hash code to 
the ID string and now we cannot have duplicate values anymore, which could cause 
an incorrect object to be loaded.

9312_314
Bug ID 20605650: MANUFACTURER WHERE USED FIELDS ARE NOT 
POPULATING IN EXPORT COMPLETE

Root Cause: There is no code to output the itemP2 attribute for the manufacturer 
Where Used table.

Resolution: Added code for it.

9312_315
Bug ID 20606980: ACCESSING PRICE TAB FOR ASSEMBLIES WITH HIGH 
REVISIONS AND MORE NU

Root Cause: Duplicate manufacture part id is included in list. 

Resolution: Exclude the duplicate manufacture part id.

9312_317
Bug ID 20735706: THE RECENT DISCUSSIONS REPORT IS NOT RUNNING 
AUTOMATICALLY

Root Cause: When multiple scheduled reports are attempted to be scheduled, some of 
them may fail due to some reason. The correct behavior is re-scheduling the failed 
reports to the next scheduling cycle, but the code doesn’t handle it very well.

Resolution: Correct the related behavior.
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9312_318
Bug ID 19595950: AUTOVUE FOR AGILE TAKES MUCH LONGER TO OPEN FILES 
COMPARED TO STAN

Root Cause: Two factors - 1. Pinging DFM costs a lot of time. 2. When replicating and 
checking if a file exists, the W S call costs a lot of time.

Resolution: 1. Ping action correctly to normal ping servlet approach.2. Remove file 
exists WS call, instead use get file size WS call.

9312_319
Bug ID 21425766: AGILE CORE WEB SERVICES NOT WORKING ON 9.3.1.2

Root Cause: HF 9.3.1.2.179 introduced a NullPointerException error while getting the 
API name of list Item of Lifecycle Phase.

Resolution: Added a null object check and converted the list Item name to API name if 
the API name is null.

PLM Release 9.3.2.0
This section includes Hot Fixes included in Agile PLM 9.3.2.0.

9320_139
Bug ID 19424273: RECEIVED MESSAGE STATING YOUR CHANGES HAVE BEEN 
SUCCESSFULLY SAVED, BUT CHANGES NOT SAVED

Root Cause: When cover page info is edited on object1 in window1, the object id in 
action context was object1, then if switched to window2 (in one HTTP session) and the 
user executes some actions on object2, at this time, the object id in action context 
changes to object2, so if the user comes back to window1 and the user clicks the save 
or validate button, the current object id in window1 could not match the object id in 
action context, so the cover page info which the user edited was lost.

Resolution: Handle this multiple windows case on the objects which in PC, PGC, 
PCM, PPM and common modules, check the object id in current request and in action 
context when the user clicks the Save or Validate buttons in the Cover Page tab, if 
these 2 object ids can not be matched, throw the block error message.

9320_143
Bug ID 19658167: LEGACY BOM COMPARISON REPORT DOES NOT DETECT 
DIFFERENCES IN FIND NUM

Root Cause: It uses a wrong data type to compare Find Numbers when running the 
Legacy BOM Comparison Report.

Resolution: Corrected the code to use correct data type.

9320_144
Bug ID 19690151: 'HAS ATTACHMENTS' EMPTY IN CHANGE AI TAB AS ADDING 
ATTACHMENT MODI 

Root Cause: The system caches a wrong row of the pendinglist. When adding a new 
attachment, it sets the flag value to 1 in the wrong row. So the Has Attachment 
attribute in the Affected Items (AI) tab show empty
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Resolution: Forced Refresh the cache before add the attachment. The affected area is 
the ¿Has Attachment¿ attribute in AI tab of change.

9320_145
Bug ID 19513662: THE WINDOW COULD NOT BE CLOSED(ADVANCED SEARCH ) 

Root Cause: When the count of list (Workflow status) entry is over 2500, the display 
type setting is changed from list to search. An error is thrown when saving the value.

Resolution: Fixed the defect that occurred when the value is saved.

9320_147
Bug ID 19790432: SUBSTANCES ROLLUP DOES NOT HANDLE A THRESHOLD OF 
0 (ZERO) PPM CORRECTLY

Root Cause: External rollup does not handle a threshold of 0 PPM correctly when 
calculating rollup result.

Resolution: Update the logic to take 0 in such a scenario.

9320_150
Bug ID 19645659: SCALE CANNOT BE CHANGED ON SOME PART COMPLIANCE 
ATTRIBUTES

Root Cause: Scale, Min Value and Max Value properties of the following 15 attributes 
are disabled and not editable: Parts.Compliance.Substances.Numeric01~Numeric10 
Specifications.Substances.Numeric01~Numeric05

Resolution:Scale, Min Value and Max Value properties of the above 15 attributes are 
enabled and editable.

9320_152
Bug ID 20003697: EXTERNAL ROLLUP RETURNING INCONSISTENT & 
INCORRECT CALCULATED CONC RESULTS ON SP

Root Cause: There are duplicated rows in SPECIFICATION_SUBSTANCES table, 
which is generated during external rollup. The duplicated rows look like bad data 
resulted from multiple threads of external rollup.

Resolution: The DISTINCT keyword can be used to resolve the problem

Related bug: 

Bug 20003697: PPM ASSIGNS THE INCORRECT UNIT OF MEASURE (GRAM 
INSTEAD OF KILOGRAM

Bug 19878897: PPM  ASSIGNS THE INCORRECT UNIT OF MEASURE (GRAM 
INSTEAD OF KILOGRAM

9320_154
Bug ID 19421515: PARTS IN PART GROUP DO NOT SHOW SAME COMPLIANCE 
AS PART GROUP 

Root Cause: When the Declaration has no supplier the SUPPLIER in the database is 
stored as NULL, but in the SQL generated in Java we use NVL(supplier,0) which turns 
NULL to 0. Therefore, in the search query we should use 0 to indicate the case of no 
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supplier instead of NULL or, the composition cannot be returned so the view 
substance table will not be published to objects(item/mpn) under Part Group.

Resolution: Change the SQL accordingly.

9320_155
Bug ID 20078454: SCHEDULED SPECIFICATION MANAGEMENT TASK FAILS

Root Cause: There is an incorrect attribute id when performing specification 
management task.

Resolution: Update with the correct attribute id.

9320_156
Bug ID 19873397: SCHEDULE STATUS REASON IS NOT REFLECTED CORRECTLY 
IN CASE OF USING

Root Cause: When a project is created, the reason stored in Schedule Status Reason of 
the root project is Children are Off Track which is in English. After the language is 
switched to Japanese and completed Phase 1, the status of its parent changes from Off 
Track to Need Attention which is correct. Before overriding the value of Schedule 
Status Reason in the parent, the system checks if it's been modified by customer by 
comparing the value stored in the Schedule Status Reason field with the default reason 
of status "Off Track".

The first value is Children are Off Track in English, but the second one is Children are 
Off Track in Japanese. They are different although they have the same meaning. 
Therefore, in this case the system treats the situation as if the user has changed the 
default value of Schedule Status Reason and keep the user specific value.

Resolution: 1. Add a locale check before the Schedule Status Reason attribute is 
updated;

2. Compare the existing value with all enabled languages and update the reason 
attribute with current user's preferred language except the existing value does not 
equal to any of the enabled locales.

9320_161
Bug ID 20216218: CURSOR FOCUS NOT IN FIRST EDITABLE FIELD

Root Cause: 934 ME-001 project (Two Columns project), fields have new CSS classes 
assigned.

Resolution: The code to set focus on fields honors the Two Column mode.

9320_162
Bug ID 20260062: DISPLAYS JAVA.NET.PROTOCOLEXCEPTION ON AGILE SSO 
ENVIRONMENT WHEN ADDING ANY OBJECT TO RELATIONSHIP TAB OF ITEM

Root Cause: The response buffer flush for adding object by search is not correct.

Resolution: Set correct response string length, and fresh buffer.

9320_164
Bug ID 20255774: PPM PROJECT IS CREATED FROM PROJECT TEMPLATE THE 
CONTENT RULE IS NOT TRANSFERRED
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Root Cause: The system retrieves the wrong subscription when creating from template 
with affected relationship

Resolution: Update the Get Subscription method.

9320_166
Bug ID 20419123: FAIL TO RUN WORKFLOW JOB FUNCTIONS WITHOUT USERS 
REPORT

Root Cause: When the customer does not have a license for some base classes, the 
system generates  a NullPointerException when sorting with Null value.

Resolution: Sort while filtering out Null value.

9320_167
Bug ID 20448203: CALCULATED PPM IS INVALID

Root Cause: PGC uses float type for returned results from external rollup, but the 
customer's use case involves many decimals so the precision is decreased.

Resolution: Change float to double when appending result rows in server layer.

Related Bug 20447116: PGC DECIMALS WRONG

9320_168
Bug ID 20533983: REPLACE SPECIFICATION FEATURE DOES NOT REPLACE 
AFTER SPECIFICATION 

Root Cause: The status is hard-coded as Default Declarations' Pending status when 
getting pending declaration for specification management task, which leads to the 
issue.

Resolution: Replaced the Status id with status type of Pending.

9320_169
Bug ID 20583495: COMPOSITIONS.DECLARATION LIFECYCLE PHASE IS BLANK 
ON ADVANCED SEARCH RESULT

Root Cause: The attribute, Parts.Compliance.Declaration Lifecycle Phase, is a special 
list. It is not handled properly.

Resolution: Added special handling for Parts.Compliance.Declaration Lifecycle Phase, 
Manufacturer parts.Compliance.Declaration Lifecycle Phase, and Part 
groups.Compliance.Declaration Lifecycle Phase

9320_171
Bug ID 20508162: INVALID CALCULATIONS DUE TO MULTIPLICATION AND/OR 
ROUNDING RESULTS 

Root Cause: The decimal precision at in the database is 2 for Calculated PPM in 
external rollup logic when calculating the value. For example, if calculated PPM is 
0.001, it will be rounded to 0 and regarded as an invalid substance. The Whole 
Substances view is ignored if invalid substance exists.

Resolution: Remove decimal precision limitation in the database for Calculated PPM.
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9320_172
Bug ID 20675200: GLOBAL REPLACE CAN NOT REPLACE ACKNOWLEDGERS

Root Cause: The Replace All function became missing with the introduction of 
acknowledger in 932.

Resolution: Add this function to system.

9320_174
Bug ID 20732886: ACP IMPORT ERROR: UNABLE TO RESOLVE THE VALUE

Root Cause: When migrating the default value of the list attribute, we need a special 
handler.

Resolution: Added a special handler for the default value of list attribute via ACP.

9320_175
Bug ID 20774469: EC RELINKING WRONG CAD FILES ON LOAD

Root Cause: The cache uses the hashCode of a string, which is generated by 
concatenating the class ID and the Design numbers. In such cases, the hash is 
computed as identical, which it should not.

Resolution: The internal object cache's key value was changed from the hash code to 
the ID string and cannot have duplicate values anymore. This can cause the wrong 
object to be loaded.

9320_176
Bug ID 20759265: ACP IMPORT ERROR: DUPLICATE NAME ENTERED

Root Cause: The way to generate hidden sub-cascade list name is like 'UOM00', 
'UOM01', 'UOM02' when migrating cascading list from source to target, which causes 
duplicated names in the database side.

Resolution: Changed the method of generation with UOM plus nano seconds of 
current time.

9320_177
Bug ID 20691530: MATERIAL PPV(%) DOES NOT SHOW IN PERCENTAGE FOR 
ITEM OBJECT PRICE

Root Cause: We do not filter the money attributes that include the currency.

Resolution: Made the Item.Price tab money attribute always show as numeric without 
currency regardless of the money type so that it will look the same as Price.Priceline.

9320_178
Bug ID 20550124: PC - BOM/BOI READ PRIVILEGE DOES NOT FLOW TO 
BOM/BOI OF A PARENT PART

Root Cause: The BOM children's BOM attributes’ privilege check are only based on the 
direct parent level. For example, a level 3 object only follows the level 2's attributes 
privileges.
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Resolution: For the BOM object on level N, we should enforce the code logic to check 
BOM attributes privilege for all parent objects from level 0,1,...to N-1. It should be an 
intersection of all parent objects' BOM privileges.

9320_180
Bug ID 20814351: IMPORT SHOULD NOT ALLOW THE OBJECT CONTAINS 
CHARACTER 

Root Cause: There is a lack of number validation while calling createMultiListValue.

Resolution: Add number validation.

9320_181
Bug ID 20680887: AGILE SCHEDULED REPORTS IS FAILING

Root Cause: When multiple scheduled reports are attempted to be scheduled, some of 
them may fail due to some reason. The correct behavior is rescheduling the failed 
reports to next scheduling cycle.

Resolution: Correct the related behavior.

9320_182
Bug ID 21162497: EXTERNAL ROLLUP DOES NOT CHECK FOR SHIPPABLE ITEMS

Root Cause: QTY with decimal is not supported in fact_table_task. Scheduled task and 
On Demand Calculate use two tables to store the object data to be externally rolled up.

Resolution: Change the QTY column of the fact_table_task property at the DB level.

Related Bugs: 

21164947: PATCH 9.3.2.171 NEEDS TO BE APPLIED TO EXTERNAL ROLLUP BATCH 
JOB

21165056: PART OF PATCH 9.3.2.167 NEEDS TO APPLIED TO EXTERNAL ROLLUP 
BATCH JOB

9320_183
Bug ID 20901466: CANNOT SELECT VALUE FOR DECLARATION LIFECYCLE 
PHASE IN ADVANCED SEARCH

Root Cause: The list of statuses for Compositions.Declaration Lifecycle Phase is 
special, and not handled properly.

Resolution: Fetch the list of statuses from Declarations.Cover Page.Status list

9320_186
Bug ID 21228608: CANNOT UPDATE SUPPLIER INFORMATION BY IMPORTING A 
SPREADSHEET

Root Cause: Import side use supplier id:::site id as unique id to identify one supplier 
row. If the site license is disabled, the unique id will be supplier id:::, and import side 
will always do add the operation. For some supplier rows import side should do 
update operation

Resolution: If site license is disabled, change site id to common site id.
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9320_187
Bug ID 21290555: RELATIONSHIP TAB DOES NOT SHOW THE CORRECT 
SUPPLIER TYPE

Root Cause: There are two columns in DB to store the supplier object subclass value 
and when it's modified in cover page only one of them is changed in DB. However the 
relationship table is generated based on another one.

Resolution: For the relationship table we used the column which always stores the 
latest subclass value.

9320_188
Bug ID 20359771: AGILE LDAP USER SYNC IS NOT WORKING FOR GENERIC 
LDAP CONFIGURATION

Root Cause: For generic LDAP server, it needs map objectGUID atribute to entryGUID 
in groovy script. but the map value is not saved into agile user.

Resolution: Added code to save the values.

9320_190
Bug ID 21454680: THE HOME DISPLAY ERROR WHEN A USER LOG IN TO THE 
AGILE

Root Cause: This is caused by a code defect. The NULL pointer is not handled for this 
case.

Resolution: Need to handle null pointer exception.

9320_193
Bug ID 21497037: REDLINE FOR PART P3 ATTRIBUTES ON ECO SYSTEM DOES 
NOT SHOW CORRECT

Root Cause: In redline edit mode, the system does not hide the fields which the current 
user had no privilege to read.

Resolution: Hide the fields that the user does not have read privilege for in redline edit 
mode.

9320_195
Bug ID 21630515: "WORKFLOW ALREADY IN USE ERROR" WHEN CREATING 
NEW WORKFLOW

Root Cause: When the user adds a new status in workflow, we need to check if the 
workflow is in use (value of some criteria of query equals to id of workflow). In the 
current code, it only checks for value, not for attribute id.

Resolution: When validating if the workflow is in use, we need to check for both value 
and attribute id of criteria of query.

PLM Release 9.3.3.0
This section includes Hot Fixes included in Agile PLM 9.3.3.0.
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9330_35
Bug ID 20065993: VIN: LOADING TO VIN WITH A9 OBJECTS IS TAKING VERY 
LONG TIME

Root Cause: The performance issue is resolved from the A9 side. This bug can be 
resolved directly or transfer to Fusion IM for further follow up from the Fusion IM 
side.

Resolution: The issue is resolved on the A9 side by providing batch creation, need 
Fusion IM to uptake the new method.

9330_104
Bug ID 19424458: NEED TO HAVE USERID PASSED IN WEB SERVICE REQUEST 
FROM REF OBJECTS

Root Cause: There is no user login ID in the Reference Object request.

Resolution: Add the user login ID into the Reference Object request.

9330_109
Bug ID 19206503: CHECKOUT LOCATION ON THE ATTACHMENT TAB DOES 
NOT POPULATE

Root Cause: Modern web browser security limitations do not allow us to populate this 
information or read this directly from the user system. As we removed Java 
technology from the application for file transfers to simplify deployments, this 
capability became obsolete. There is no HTML 5 capability to enable this capability on 
a Web Browser.

Resolution: Hard code in WebClient to disable check location in following places:

1. Item table,Attachment tab, Checkout Location field

2. File table, Title Block tab, Checkout Location field

3. File table, Files tab, Checkout Location field

9330_118
Bug ID 19530388: EXPECTED ALL EVENT MESSAGES TO DISPLAY HTML AFTER 
PATCH 16932062

Root Cause: Security encodes HTML entities in the messages.

Resolution: Does not encode HTML entities.

9330_119
Bug ID 19559430: TIMESHEET SEARCH RESULT DISPLAYS SAME SET OF DATA 
MULTIPLE TIMES

Root Cause: Each page returns all table rows in the timesheet search data model.

Resolution: Overwrite the getdata method in the timesheet search data model to return 
the right rows in each page.
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9330_124
Bug ID 18704328: EXPORTS ITEM DATA EXCEPT THE MFR/MFR. PARTS 
COLUMNS APPEAR BLANK

Root Cause: The PCO Affected Price tab price does not check the privileges for Price, 
Item, Manufacturer Part, and Manufacturer privilege.

Resolution: Need to check the Read privilege for objects in the Affected Price tab.

9330_125
Bug ID 19607674: JAVA PX ACTIONRESULT.EXCEPTION DOES NOT DISPLAY NEW 
LINES

Root Cause: Does not transfer '\r','\n' to <br>.

Resolution Transfer '\r','\n' to <br>.

9330_126
Bug ID 19777509: ENHANCE THE ADDROWS WEB SERVICE TO RETURN THE ID 
OF THE ADDED ROW

Root Cause: When adding a row through the addRows WebService, the response 
includes only the status message but no id for the added rows.

Resolution: Return the rowId if the client specifies the flag in the request.

Related Bugs:

19777495: NEED TO BE ABLE TO SPECIFY THE REVISION OF AN ITEM BY CO ID 

19777429: NEED FLAG IN THE RESPONSE OF THE GETOBJECT WS FOR LATEST 
REVISION

19777531: NEED A WEB SERVICE IN A9 WHICH DELIVERS ROLLED UP 
RESOURCE INFORMATION 

20212266: TABLE#LOADTABLE SERVICE RETURN ATTRIBUTE "ITEMREV" TYPE 
AS "XS:STR 

9330_127
Bug ID 19690342: UNABLE TO SET COMMODITY CODE VALUE TO ITEM IF 
COMMODITY CODE HAS MORE PARTS

Root Cause: To display the latest description of the Item object, a PGC developer fixed 
one bug to get it from the Item service directly since the PART_DESC in map table has 
an incorrect value. It causes performance issues on the customer DB if the Part family 
relates to many Item objects. Then, this approach was changed to update the PART_
DESC in the map table every time when loadTable() is invoked. Otherwise this causes 
another performance issue when customer has certain Part family to update all 
descriptions of related Items (10000+).

Resolution: According to a PGC functional request, here the latest description of Item 
is needed. Get the description of Item from PC ITEM table directly by joining it.

9330_130
Bug ID 19821011: COMPLIANCE IS NOT CALCULATED ON EXTERNAL 
SPECIFICATION COMPOSITION
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Root Cause: Incorrect logic is used in the procedure for declaration external rollup.

Resolution: Update the logic to take 0 into consideration.

9330_131
Bug ID 19634477: UNABLE TO DISPLAY MULTIPLE ERROR MESSAGES IN NEW 
LINE WITH CHANGE 

Root Cause: Does not transfer '\r','\n' to <br>.

Resolution: Transfer '\r','\n' to <br>.

9330_132
Bug ID 19633350: JAPANESE CHARACTERS GET GARBLED WHEN USER 
DOWNLOADS TEMPLATE FOR DECLARATION

Root Cause: When the user sets the encoding type as their local setting, when   
downloading the declaration template there are garbled characters in the Excel file.

Resolution: During export, ensure that the file is written using the customer setting

9330_134
Bug ID 19863760: UNABLE TO PERFORM SAVE AS ON DECLARATION OBJECT 
THROUGH AGILE API 

Root Cause: The Supplier attribute is required when executing a Save As using SDK 
code.

Resolution: Made the Supplier attribute not required.

9330_135
Bug ID 19664431: AGILE 933 PROXY SERVER SETUP

Root Cause: 1. Only the URL entered in Java Client's Web Server URL can be used to 
do file uploads. This is used to check the origin of request that can be allowed to access 
the file server for uploading from the Web Client, but there are situations where the 
customer may need multiple accessing URLs to Agile such proxy server, https 2. 
Deploy Agile with HTTP URLs in Java Client and File Server's configuration file 
"server.conf", and want to access Agile in HTTP for internal users and HTTPS for 
external users.

Resolution: To achieve above, we provided configuration in the File Server's 
server.conf for those extra access URLs so that the File Server considers those URLs as 
valid "Access-Control-Allow-Origin"

9330_136
Bug ID 19781390: NUMERIC ATTRIBUTES CONFIGURED WITH A SCALE DO NOT 
DISPLAY CORRECTLY

Root Cause: Numeric attributes keep trailing zeros.

Resolution: Remove trailing zeros for Numeric attributes. 

9330_139
Bug ID 19803007: WHERE USED REPORT SHOWS DUPLICATE ITEM NUMBERS
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Root Cause: If one search involved both BOM and Manufacturing table and it is not a 
Where Used one level all released search, at this time, the SQL does not filter data 
completely, which causes issues with duplicates.

Resolution: Add more logic conditions to avoid duplicated results.

9330_141
Bug ID 19937803: PROGRAM TOP DISCUSSION REPORT DOES NOT CONTAIN 
MESSAGE FIELD

Root Cause: ER type request

Resolution: Add "MESSAGE" field on 3 reports - Project Top Discussions Report/My 
Discussions Report/Portfolio Priority Discussions Report.

9330_142
Bug ID 19764503: UNABLE TO IMPORT MULITPLE BOS ROWS WITH JAPANESE 
USER

Root Cause: The class type is hard-coded when creating compositions in import logic.

Resolution: Replace the hard-code with a localized string.

9330_143
Bug ID 19429852: AGILE 9.3.3 DRAG AND DROP ON SCO AFFECTED ITEM TAB 
DOES NOT WORK

Root Cause: When user clicks on type-in or search, request is sent for grid information, 
while grid information is NOT available.

Resolution: Find Grid information by grid ID sent in response.

9330_145
Bug ID 19986501: BOM EXPLOSION REPORT LIMITS CALCULATION SHOULD 
BASED ON TYPES

Root Cause: The estimated number of objects is not affected by the chosen Item types 
in the error message when the BOM numbers exceed the limit.

Resolution: Based calculation on chosen item types.

9330_146
Bug ID 19876100: AFFECTED ITEM IS REMOVED FROM COMPLETED QCR

Root Cause: The current design is not reasonable since the customer needs to be 
informed when the Affected Items are removed from Change objects, if the AI's related 
rev is used in the QCR.

Resolution: Display an error message when this situation occurs per PM's requirement.

9330_147
Bug ID 19594997: AGILE 9.3.3, AFTER PATCH 9.3.3.30 UPLOADED FILES FILE 
NAME WILL APPEAR GARBLED

Root Cause: UTF-8 encoding is required to parse the HTTP request during file upload.
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Resolution: Use proper encoding UTF-8

9330_148
Bug ID 20101405: CHECKED THE AML THAT WHEN MFR NAME CONTAINS 
CHINESE, IT APPEAR GARBLED IN BOM COMPARISON REPORT

Root Cause: There is an encoding issue in attribute values of the BOM Comparison 
Report.

Resolution: Read the input stream as UTF-8 encoding.

9330_150
Bug ID 20016668: UNRELEASED CHILD ITEM ERROR HYPERLINK BEHAVIOUR

Root Cause: Always show the Add Row Successfully message.

Resolution: Show error message when there is lack of privilege.

9330_151
Bug ID 20092469: PROGRAM TOP DISCUSSION REPORT TAKES TOO LONG TO 
LOAD ROOT PROJECT 

Root Cause: GSK has more than 100,000 root projects. It takes a long time to display all 
of them in the list.

Resolution: Change the root project selector to search mode so that users can get the 
root project quickly through search criteria.

9330_152
Bug ID 20025999: BOM BULK CHANGE LIMITS ROWS TO 500 AFTER SORTING 
DATA

Root Cause: When the table is sorted the "max query result" setting in Java Client is 
used.

Resolution: In this case, the customer's requirement is to see all available results so the 
sort action should have a special handler for the wizard coming from Bulk Change.

9330_153
Bug ID 20077709: GLOBAL SEARCH PRIVILEGE DOES NOT SHOW INSUFFICIENT 
PRIVILEGE MESSAGE WHEN INSUFFICIENT PRIVILEGES

Root Cause: If the user presses the Save button, the system loads search results and 
refreshes the attention for insufficient privilege users.

Resolution: If the user presses the Save button, we do not load search results if the user 
does not have the privilege to save Global search.

9330_154
Bug ID 20160653: JOINED USER MISSING IN NOTIFICATION LIST OF REPLY POP 
UP IN DISCUSSION

Root Cause: An incorrect method is used to get the Notify Users list from the reply 
table.
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Resolution: Correct the method to get the Notify Users list from the Discussion table.

9330_155
Bug ID 20180141: AGILE 9.3.3 CUSTOM REPORTS DATE FIELD ISSUES

Root Cause: Query treats date and time as date only to transform, make a empty string 
to output.

Resolution: Judge by attribute DateTimeFormat and follow related business logic.

9330_156
Bug ID 20042051: SMARTRULE - OBJECT EDIT CONFLICTS SET TO ALLOW IS NOT 
ALLOWING 

Root Cause: We do not refresh object status before a save.

Resolution: When trying to save an object, refresh its status.

9330_157
Bug ID 20175591: UNABLE TO DELETE BLANK ROW IN A BOM TAB IF EVENT 
UPDATE IS ENABLED

Root Cause: For BOM blank row, an exception is thrown when an event is triggered.

Resolution: Need a special handler for BOM blank row when an event is triggered.

9330_161
Bug ID 20200089: REDLINE CHANGES DO NOT STRIKE OUT FOR THE NUMERIC 
ATTRIBUTES

Root Cause: We use the incorrect way to show the Numeric attribute in redline table.

Resolution: Use the correct way to show the Numeric attribute in redline table.

9330_162
Bug ID 20222911: EXPORT OBJECT FOR ADVANCED SEARCH RESULTS IS 
EXPORTING ONLY THE INTRODUCTORY PART

Root Cause: The wrong rev is assigned to the Item.

Resolution: Assign the correct id to the Item.

9330_166
Bug ID 19720866: LOAD TO CAD IS NOT LOADING THE SPECIFIED VERSION 
FROM SEARCH RESULTS

Root Cause: The function getobjectbyid() can not get the right version from design in 
search result.

Resolution: Get the version using rowID instead.

9330_167
Bug ID 20313134: REDLINE REMOVED BOM IS NOT SORTED BY ITEM NUMBER
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Root Cause: Introduced by bug 8934597. When the redline action is deleted, the old 
value takes part in the sort. The new value is always null, so sorting does not work on 
deleted rows. 

Resolution: Special handle the delete redline case when sorting.

9330_168
Bug ID 20239774: IMPORTING MPNS CREATES MPNS WITHOUT ACCEPTING 
THE WARNING

Root Cause: 933 feature bug

Resolution: Added some additional code for AutoNumber Object.

9330_170
Bug ID 20573338: LEGACY BOM COMPARISON REPORT SHOWS BOM ITEMS 
THAT ARE COMMON AFTER APPLYING 9.3.2.0.143.

Root Cause: HF 9320.143 changed the logic of the legacy BOM Comparison Report in 
which when two BOMS have the same Find Number, both still appear in the report.

Resolution: Update the logic. 

9330_172
Bug ID 20312059: AXML EXPORTED BY AGILE CONTENT SERVICE HAVE NO 
REDLINES WHEN BOMNOTES BE DELETED 

Root Cause: The empty tag was removed when fixing bug 14835608.

Resolution: Populate empty tag to reflect the redline delete action, if the new value is 
empty and the old value is not empty.

9330_173
Bug ID 19978648: AGILE 9.3.3 CUSTOM DASHBOARD TABLES NOT SORTING AND 
TAKING A LOT OF

Root Cause: This is caused by the customized Dashboard table. For the first column 
header 'Change icon', they do not want to show column name (same behavior with 
system Dashboard table), but for customized Dashboard table creation, the name is 
required.

Resolution: Add a special handler for the customized Dashboard table. If content type 
is image and if it is also the first column, set the name as blank.

9330_174
Bug ID 20371919: RESIZING AFFECTED ITEM WINDOW ON INTERNET 
EXPLORER DOES NOTT WORK CORRECTLY

Root Cause: The fix for 13440210 (9311.109) replaces the common UI resize function 
with a specific one for the Redline Title block sub page, which leads to the unexpected 
UI behavior while resizing.

Resolution: Put the special handler in the common file.
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9330_175
Bug ID 20389760: ISSUE WITH OOTB ROLE SAVED TO CUSTOM ROLE

Root Cause: When the building activity discover object with Team.Name attribute, the 
new save-as role is not synchronized to the new user.

Resolution: When building activity discover object with Team.Name attribute, 
synchronize the new save-as role to the new user.

9330_178
Bug ID 20419717: AFTER PATCH 9.3.3.30 UPLOADED FILE NAME WILL APPEAR 
GARBLED

Root Cause: UTF-8 encoding is required to parse the HTTP request while uploading 
file.

Resolution: Use proper encoding UTF-8.

9330_179
Bug ID 20419572: ECO AFFECTED ITEM, REDLINE OF ITEMS LAST BOM 
COMPONENT NOT ABLE TO DOUBLE-CLICK

Root Cause: If the Y coordinate of the bottom of the edit box exceeds the bottom of the 
grid table, the edit box is hidden.

Resolution: Change the approach to calculate the bottom Y of the grid table.

9330_180
Bug ID 20109411: SEARCH RESULTS NOT SORTING PROPERLY IN CUSTOM 
SEARCH FOR DASHBOARD

Root Cause: Currently, we only support sorting in the database by SQL order clause. 
Some attributes are stored in the DB with id, and for these attributes, it does not make 
sense to sort against id. We should sort by their values.

Resolution: Added sorting process in memory for list and multilist type data

9330_182
Bug ID 20310381: DURATION SIGNOFF CALCULATION COUNTS WEEKEND

Root Cause: We do not take the weekend into consideration when calculating signoff 
duration

Resolution: Take weekend into consideration when calculating signoff duration.

9330_183
Bug ID 20456439: CHANGE PACKAGE REPORT GETS TRUNCATED WHEN 
EXPORTED TO EXCEL

Root Cause: There is an incorrect operation which puts the HTML serializer string as 
report value map key for Ref Des attribute in Change Package Report.

Resolution: Correct the incorrect operation.
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9330_184
Bug ID 20350238: 9.3.3 RELEASE SUPPORT SAFARI7

Root Cause: This case for Keynote file is not a valid case as it is a real folder, not a 
single file.

Resolution: Suggest customer to go with the workaround (zip it manually and upload 
it).

9330_185
Bug ID 20442074: ADVANCED SEARCH ON TEAM TAB DOES NOT SHOW 
RESOURCE POOLS WHEN USING SELECT WITHIN USER GROUP

Root Cause: Agile attempts to filter user group list for the attribute, 
Activities.Team.Name, but this is invalid when there is no activity in the context.

Resolution: Skip the filter when there is no activity in the context, that is, objid == -1

9330_187
Bug ID 20350257: GLOBAL NAVIGATION BAR UI ISSUE

Root Cause: The minimum width of the top panel is 600px, and is not enough so the 
quick search moves to the next line.

Resolution: Change minimum width of the top panel to 650px.

9330_189
Bug ID 20517573: INVALID COLUMN INDEX ISSUE ON FILE FOLDER OBJECTS 

Root Cause: This is a code issue. Values of variables are not cleared at the end of a 
loop. This leads to disproportionate parameters while compiling SQL.

Resolution: Added code to clear values of the variables at the end of loop

9330_190
Bug ID 20462854: TIME BUFFER VALUE ON DEPENDENCIES TAB SHOWS 
INCORRECTLY AFTER PROJECT IS CREATED USING XML FILE

Root Cause: This is caused by the String parse on Int that falls outside.

Resolution: Use long instead.

9330_191
Bug ID 20486888: IMPORTING RFQ RESPONSE DOES NOT UPDATE VALID FROM 
ATTRIBUTE VALUE

Root Cause: There is a code defect. We do not update the Valid From attribute if it has 
been changed.

Resolution: Changed code to implement this feature.

9330_192
Bug ID 20460694: UNABLE TO SET IMPORT PREFERENCE BLANK DATA ACTION 
USING AIS 
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Root Cause: Ais does not support to the ability to specify blank data action. This bug is 
an enhancement.

Resolution: Customer can specify the option 
ParsingAndValidationOptions|BlankDataAction=Retain using AIS.

9330_195
Bug ID 20525826: PCM - UNABLE TO CREATE RFQS

Root Cause: We update the attribute rs_event_state of the Response table with null 
value.

Resolution: Update attribute rs_event_state of the Response table without null value.

9330_196
Bug ID 20584699: ENABLE ASCENDING/DESCENDING ORDER ON HISTORICAL 
REPORT TAB

Root Cause: There is a NullPointerException blocked Report History Records sorting 
when retrieving table view information.

Resolution: Replaced the null value with a default one. 

9330_197
Bug ID 20556123: CRITERIA FOR DOCUMENTS USING CASCADE LIST SAVES AS 
PARTS

Root Cause: when creating admin criteria using AI list attibute assigned by a 
cascading list and select one value like [Documents]AAA|BBB, it will always be saved 
as [Parts]AAA|BBB.

Resolution: when cascading list shows up, build proper class id to each leaf/parent 
node of the list.

9330_198
Bug ID 20486572: ACP IS NOT ABLE TO MIGRATE THE WORKFLOW 
CONFIGURATIONS PROPERLY.

Root Cause: Some recently added properties are missing in ACP.

Resolution: Added the new properties to ACP.

9330_201
Bug ID 20632276: ANALYSIS TAB FILTER PART WITH BEST PRICE DISPLAYS 
MANY RECORDS WITH NO BID

Root Cause: This is a code defect. We include the Response Lines without supplier, if 
the view is Parts with Best Price.

Resolution: Exclude the Response Lines without supplier, if the view is Parts with Best 
Price.

9330_202
Bug ID 20563019: MANUFACTURER PARTS CANNOT BE CREATED DUE TO 
HARDCODED ID 1488
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Root Cause: A hard- coded id 1488 in the fix of 14506225 introduced this issue. If the 
customer removes the default subclass and uses a newly created Manufacturer Part 
subclass. The error occurs when we get the subclass node (1488).

Resolution: Get the attribute name via class id instead of subclass id.

9330_203
Bug ID 20605559: JAVA.LANG.NULLPOINTEREXCEPTION WHEN CHANGING 
STATUS OF CERTAIN CHANGE

Root Cause: We do not consider a null value for the variable.

Resolution: Added logic for null.

9330_212
Bug ID 20545040: AFTER APPLYING HF 9.3.3.0.170, DOWNLOAD ATTACHMENT 
FILENAME IS CORRUPT

Root Cause: The filename has been encoded to Hex and the browser token("MSIE") has 
been removed from IE11.

Resolution: We decode file name to UTF8 before setting it to the HTTP request. We also 
added an additional check for IE11 using token "Trident"

9330_213
Bug ID 20690991: SEARCH WITH PROMPT CHECKED CANNOT SEARCH 
JAPANESE CHARACTER CORRECTLY

Root Cause: Add an additional wildcard for search on MutiByte characters.

Resolution: Remove the wildcard for prompt search in the UI side since server code 
can separate handler MultiByte characters or singlerByte characters well.

9330_214
Bug ID 20677051: SOURCING PROJECT, ADD ITEMS WITH BOM FILTERS IS NOT 
WORKING,QTY:NO

Root Cause: BOM filter does not work correctly if the privilege, Enforce Field Level 
Read, is disabled.

Resolution: Added a condition to avoid this case as privilege, Enforce Field Level 
Read, is disabled and returns null for readable attribute.

9330_215
Bug ID 20598314: UNABLE TO OPEN FILE WHICH CONTAINS THE SPACE IN 
FILENAME USING IE

Root Cause: Do not decode file name in the server side.

Resolution: Decode the filename in the server side and open file.

9330_217
Bug ID 20769504: 'ADD BACK REFERENCE' ATTRIBUTE NOT PROPAGATED VIA 
ACP
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Root Cause: The ’ADD BACK REFERENCE' was introduced in 933, but is missing for 
ACP.

Resolution: Added it to ACP.

9330_219
Bug ID 20739798: REQUIRE HF 117 IS INCOMPATIBLE WITH HF98 AND HF149

Root Cause: Hot fix 9330.117 is incompatible with 9330.149.

Resolution: Code base is 9330.149 and merged the code fix of 9330.117.

9330_220
Bug ID 20786122: UPDATE BOM TABLE EVENT NOT WORKING PROPERLY WHEN 
ITEMS ARE ADDED B

Root Cause: This is caused by a code defect. The wrong data row is passed from UI.

Resolution: Correct the code to get the correct row by row index.

9330_221
Bug ID 20837401: MCO DOES NOT INCLUDE THE LATEST RELEASED REVISION 
IN THE AXML PACK

Root Cause: The loop index is incorrect when iterating the sorted Revision list.

Resolution: Use the correct index.

9330_225
Bug ID 20759916: DISPLAY NO PRIVILEGE ON PPM REPORTS REPORTS

Root Cause: This issue is caused by the wrong report privilege check when the user 
adds the Enforce field level read privilege.

Resolution: Changed the privilege check.

9330_226
Bug ID 20868129: UNKNOWN NUMBER: OBJECT DOES NOT EXIST AND NO 
PRIVILEGE ERRORS

Root Cause: The object’s subclass is not set.

Resolution: Set object’s subclass.

9330_228
Bug ID 20880673: ACP FAILS FOR EVENT: NODE XXXXXX DOES NOT EXIST IN 
THE CACHE

Root Cause: When an event is propagated to the target system, it can not match the 
object type node id of the newly created subclass.

Resolution: Refresh ID node of object type by API name.
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9330_229
Bug ID 20880646: ACP FAILS TO PROPAGATE EVENT ASSOCIATED WITH NEW 
SUBCLASS

Root Cause: When the user chooses the Approve for Workflow event type and <All> 
workflow, the <All> workflow is not handled correctly in ACP.

Resolution: Handle the <All> workflow correctly.

9330_231
Bug ID 20887518: USER GETS ERROR MESSAGE: INVALID API LICENSE ERROR

Root Cause: Multiple threads access the cached table descriptors. Before the first 
thread can complete initializing the cache table descriptors, the attempted access from 
a subsequent thread cause incorrect information to be returned.

Resolution: Ensured that the cached table data completes initialization before it is 
accessed by multiple threads.

9330_232
Bug ID 20849515: ONE-OFF - ISSUE WITH UPDATE TITLE BLOCK EVENT WHILE 
EDITING ACTIVITY.PLM_REFERENCE

Root Cause: There is a lack of number validation in createMultiListValue.

Resolution: Add number validation.

9330_233
Bug ID 19340584: AGILE ALLOWS USER TO UPLOAD FILES WITH SPECIAL 
CHARACTERS AFTER APPLYING HOT FIX

Root Cause: After applying HF122, it rolls back HF30's fix for specific characters.

Resolution: Merge HF30 back. Add invalid character support.

9330_234
Bug ID 20701110: ATTACHMENTS ARE MISSING WHEN ACCESSING 
ATTACHMENTS TAB VIA WHERE USED OBJECT

Root Cause: Do not get correct class id for Where Used object.

Resolution: Load current object class id for Where Used object.

9330_236
Bug ID 20925303: PGC DECIMALS WRONG

Root Cause: The BOM quantity is rounded in external rollup.

Resolution: Changed the type definition of the staging table used during external 
rollup so the actual quantity will be used.

9330_237
Bug ID 20508126: INVALID CALCULATIONS DUE TO MULTIPLICATION AND/OR 
ROUNDING RESULTS
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Root Cause: The decimal precision in the database is 2 for Calculated PPM in external 
rollup logic when calculating the value. For example, if calculated PPM is 0.001, it will 
be rounded to 0 and regarded as invalid substance, then the whole substances view 
will be ignored if invalid substance exists.

Resolution: Remove decimal precision limitation on the database side for Calculated 
PPM.

9330_241
Bug ID 20859562: ACP IMPORT ERROR: UNABLE TO RESOLVE THE VALUE 

Root Cause: When migrating the default value of a list attribute, we need to handle it 
specially

Resolution: Added special handler for default value of list attribute via ACP.

9330_242
Bug ID 20957469: REDLINE CHANGES DOES NOT WORK IF USING BULK 
CHANGE

Root Cause: The current bulk change logic only supports updating Item number, but 
no other attributes, which leads to this issue.

Resolution: Enhance the logic to handle event PX of updating attributes in 
BOM/Manufacturer Bulk Change.

9330_243
Bug ID 21022937: "NO PRIVILEGES"  MESSAGE IN MY ASSIGNMENT WHEN TASK 
OWNER HAS ENOUGH PRIVILEGE

Root Cause: This bug is caused by lack off subClassId parameter when doing the 
privilege check.

Resolution: Add the sbuClassId parameter when doing the privilege check.

9330_244
Bug ID 20990470: SORT ON THE HAS ATTACHMENT ICON DOES NOT WORK IN 
QUICK SEARCH

Root Cause: Since Java 7, it throws "comparison method violates its general contract" 
exception on sorting attachment column.

https://docs.oracle.com/javase/7/docs/api/java/util/Comparator.html

Resolution: Define a comparison that observes the general contract.

9330_246
Bug ID 7312: ACP IMPORTED GLOBAL SEARCHES DOES NOT APPEAR IN WEB 
CLIENT/JAVA CLIENT

Root Cause: Since the id of the subclass of the source system is different from the target 
system, it cannot be found due to a non-existing id. This is why it has errors when 
importing.

Resolution: Find object by name/apiname instead of id in the target system.
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9330_247
Bug ID 20984245: SOME CTOS ARE MISSING ACKNOWLEDGEMENTS ON 
HISTORY TAB

Root Cause: When a transfer order object is transmitted successfully, ACS updates the 
Where Sent status first, then resets the specific destination. Finally it logs the history to 
record the package information, but in some special scenarios, reset destination fails 
and the log history record is skipped.

Resolution: Log the history record before we reset the ACS destination.

9330_249
Bug ID 21072325: ACS/EXPORT BLOCKED

Root Cause: When sorting the redlined AML Parts of item by created date, and if all 
the AML parts are with same created date, the ExtractOutputStreamWriter#quickSort() 
method runs in to an infinite loop.

Resolution: Change the loop index to break out from the infinite loop.

9330_250
Bug ID 21036387: MERGE PATCHES 20239958 AND 19893948 TO REMOVE 
INCOMPATIBILITIES

Root Cause: Code conflicts.

Resolution: Merge the fix of HF51(18606832) to HF250.

9330_251
Bug ID 21037469: TRANSFERRED CHANGE COULD NOT FILTER BY PENDING 
DAYS IN WORKFLOW RO

Root Cause: For the TA case the query SQL does not take the date filer into 
consideration.

Resolution: Add the date filter check for the TA case when generating the query.

9330_252
Bug ID 21085253: RUNNING SAVED SEARCH MANUALLY ON INACTIVE LIST 
VALUE RETURNS INCORRECT DATA

Root Cause: SDK fails to get the correct multilist value from the server if the value is 
inactive.

Resolution: Changed the code to get the correct multilist value.

9330_254
Bug ID 21119198: MANUFACTURER PART NUMBER IN LOWER CASE GETS 
CONVERTED TO UPPER CASE

Root Cause: To support upper/lower/mixed case, the method, 
createRealObjNumberCollection, of super class BatchHandler.java should be 
overwritten, but Item/Manufacturer/Manufacturer Part handler does not overwrite it.

Resolution: Overwrite the method, createRealObjNumberCollection, to support 
upper/lower/mixed case for creating Item/Manufacturer/Manufacturer Part.
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9330_257
Bug ID 21119435: PROJECTS MUTLIST01 ATTRIBUTE VALUE ON FILES TAB OF 
FILE FOLDER IS NOT ON ATTACHMENT TAB

Root Cause: This is a program cache issue. It does not refresh the cache after 
attachment file is changed.

Resolution: Remove cache from programbasecache, and use agile base cache.

9330_258
Bug ID 21175511: FAILS TO IMPORT A .XLSX FILE

Root Cause: The logic of parsing Excel is incorrect. It mishandles the format like 
below:

<sst xmlns="http://schemas.openxmlformats.org/spreadsheetml/2006/main" 
count="4"uniqueCount="4"><si><t>b</t></si><si><t>a</t></si>

<si><t>12d</t></si><si><r><txml:space="preserve">I'm ok </t></r><r><rPr><sz

val="11"/><color theme="1"/><rFont val="Arial Black"/><family

val="2"/></rPr><t>with</t></r><r><rPr><sz

val="11"/><color theme="1"/><rFont

val="Calibri"/><family val="2"/><scheme

val="minor"/></rPr><t xml:space="preserve">

it</t></r></si></sst>

An <si> tag may have multiple <t> tags.

Resolution: Changed the parsing logic to consider multiple <t> tags situation.

9330_259
Bug ID 21107032: SCHEDULED ROLLUP TASK DOES NOT ROLLUP EXTERNAL 
REACH SPEC COMPLIANCE

Root Cause: We do not support external specification mapping in external rollup task 
in the current logic.

Resolution: Add this function.

9330_261
Bug ID 21097659: ADVANCED SEARCH USING CHANGEHISTORY 
FINALCOMPETE DATE IS INVALID

Root Cause: Get more incorrect data from SQL, as one table with two unnecessary 
alias names in from clause.

Resolution: Update the Alias Table Name in SQL, in order to remove one surplus table 
name.

9330_262
Bug ID 21200048: MANUFACTURER PARTS GET SOFT DELETED AT THE 
CREATION TIME
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Root Cause: When the user has no modify privilege for change.AI.item number the 
add button is still enabled in the Redline tab. If the customer Adds by Create any 
MPN, the "insufficient priv" error shows up and newly created MPN is soft deleted in 
the system. Next time when the customer tries to create this MPN again the "object has 
existed" error shows up.

Resolution: If the customer does not have the modify privilege of change.AI.item 
number, the Add/Remove button of the Redline tab should be greyed out to disallow 
the customer to add by creating any new object.

9330_263
Bug ID 21150307: ALTER TIME OUT FUNCTIONALITY WHEN USERS ACCESS VIA 
SSO

Root Cause: In SSO, the web client disables the prompt for the timeout alert due to a 
previous bug. so the customer can get different error after performing some actions.

Resolution: Enabled the prompt, then reloaded the browser with location.reload api, 
and do not invalidate the agile session and logout in SSO. so that the end user does not 
have a change to modify and get errors after time out.

9330_265
Bug ID 21151206: AGILE933HF122 IS NOT COMPATIBLE WITH 9.3.3.24

Root Cause: Browser detection fails when running in IE11.

Resolution: Force IE to go to the IE7 document mode and resolve corresponding bugs.

9330_266
Bug ID 21131595: SCRIPT API IBASESCRIPTOBJ.GETDIRTYATTRIDS() RETURNS 
WRONG DATA

Root Cause: Number has Scale, so the number in the database may be different with 
the one shown in the UI, for example, scale a numeric field is 2, we enter a value 
1.1256, 1.1256 is stored in database, but in the UI it is shown as 1.13. If we compare 
1.1256 to 1.13, they are different, so before we compare the numbers with the scale 
setting, we need to format them first.

Resolution: Before we compare the numbers with scale setting, we format them first.

9330_269
Bug ID 21189843: ARRAYINDEXOUTOFBOUNDSEXCEPTION IS THROWN WHEN 
API AGILE SDK API

Root Cause: This is caused by an incorrect hard-coded tableID when the event is sent.

Resolution: Get the correct tableIDs based on the changed attributes id.

9330_270
Bug ID 21191845: ERROR IN IE 10

Root Cause: IE10/11 passes an entire location of uploading a file to the server and the 
server does not handle it properly.

Resolution: Fixed code to handle the entire location of file and retrieve real file name.



PLM Release 9.3.3.0

Issues Resolved by Hot Fix Releases 2-29

9330_271
Bug ID 21269154: IMPORTING DATE ATTRIBUTE DOES NOT CONSIDER USER 
TIME ZONE PREFERENCE

Root Cause: For Date Only attributes, Agile import uses user time zone preference 
setting to convert date string to date object.

Resolution: For Date Only attributes, use GMT time zone to convert date string to date 
object.

9330_272
Bug ID 21071127: SIMPLE LIST VALUES ARE GETTING DISAPPEAR ON GENERAL 
INFO WHEN CLICERROR IN IE 10

Root Cause: When creating the element for simple list fields in the Manufacturer’s title 
block, both edit mode and modify privilege are checked. So if a user has no modify 
privilege for the attribute, the value is not generated in edit mode.

Resolution: Only check edit mode.

9330_273
Bug ID 21166119: PPM PROJECT IS CREATED FROM PROJECT TEMPLATE AND 
THE CONTENT RULE FROM TEMPLATE DOES NOT SHOW IN PROJECT TASK 

Root Cause: The get the wrong subscription when creating from template with an 
"affected" relationship.

Resolution: Change the get subscription method when creating  from template with 
"affected" relationship.

Related Bug: 21302952: DISPLAY NO PRIVILEGE ON PPM REPORTS REPORTS 

9330_275
Bug ID 21200329: PARTS ARE NOT ADDED TO CTO SELECTED CONTENT VIA 
SDK

Root Cause: SDK adds an object into Transfer Order's Selected Content table with its 
Object Class Name, not Class API Name.

Resolution: Use object Class API Name instead.

9330_276
Bug ID 21322467: CAN NOT ADD OBJECTS TO RELATIONSHIP TAB IN AGILE 
WEB

Root Cause: The response buffer flush is not correct for adding object by search.

Resolution: Set the correct response string length and refresh buffer.

9330_278
Bug ID 21293828: INTERNET EXPLORER 11 DOES NOT ALLOW MULTIPLE FILE 
DOWNLOAD AFTER 9.3.3.0.122.

Root Cause: Between different frames, postMessage does not working with IE 
Document Mode 7 for opener.zipFileDone() after applying 9.3.3.0.122.
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Resolution: Only using it in its own frame, not different frames.

9330_280
Bug ID 21294565: IMPORT INCLUDING RECORD WHICH VIOLATES CHARACTER 
SET SETTING REJECTS ALL RECORDS

Root Cause: Import does not validate the input number against custom character set.

Resolution: Add validation for custom character set.

9330_281
Bug ID 21381747: ALL CHANGES TO ANY WHEN SAVING FILTER IN JAPANESE 
INSTANCE

Root Cause: <personalisation><sort><sortcriteria><attribute> 
2000007767</attribute><order>2</order></sortcrit er ia></sort><filter>  
<logicOperator>??</logicOperator> 

Resolution: Pass logicOperator to server with non-english.

9330_282
Bug ID 21380153: UNABLE TO GET THE BASELINE SCHEDULE OF GRANDCHILD 
ACTIVITIES US

Root Cause: This bug occurs because the baseline version is lost when loading the 
Schedule table.

Resolution: Add the baseline version when loading the Schedule table.

9330_285
Bug ID 21380153: WE ARE NOT ABLE TO MASS DOWNLOAD ATTACHMENTS 
FROM AN OBJECT

Root Cause: Between different frames, postMessage does not work with IE Document 
Mode 7 for opener.zipFileDone().

Resolution: Only use it in its own frame, not different frames.

9330_288
Bug ID 21482532: SETVALUE TO DATEONLY ATTRIBUTE SETS THE WRONG DATE 
CONVERTED BY TIMEZONE

Root Cause: If the target attribute is a Date Only attribute and the user provided 
parameter is a Date object, SDK will clear HOUR,MINUTE, SECOND, and 
MILLISECOND field of the Date object directly before calling the server side API.

Resolution: Set the time zone to GMT before clearing HOUR, MINUTE, SECOND, and 
MILLISECOND field of Date object for Date Only attributes.

9330_289
Bug ID 21487492: MERGE PATCH 20598314 (9.3.3.0.215)WITH PATCH 
21322467(9.3.3.0.276

Root Cause: N/A
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Resolution: N/A

9330_292
Bug ID 21549264: REMOVE THE CONFLICTS BETWEEN HF 199 AND HF 278

Root Cause: Between different frames, postMessage does not work with IE Document 
Mode 7 for opener.zipFileDone().

Resolution: Only use it in its own frame, not different frames.

9330_293
Bug ID 21527159: TWO PXS AT NCR WORKFLOW CLOSE 'FIRING' TWICE

Root Cause: Nested change status action is performed when a user triggers an Event 
PX from Web Client. Then the Event PX does a change action by SDK API to trigger 
the custom workflow Process Extension.

Resolution: Added next status condition validation before triggering a custom 
workflow Process Extension.

9330_294
Bug ID 21527994: DISPLAY NO PRIVILEGE ON PPM-MY DOCUMENTS REPORT 

Root Cause: This is caused by the wrong report attribute privilege check when user 
adds the Enforce field level rea privilege.

Resolution: Change the report attributes to use Activity Class attributes.

9330_295
Bug ID 21328738: JAVA CLIENT DOES NOT SHOW ANY LIST FIELD VALUES

Root Cause: Something is wrong in a circle statement. We only get the first value of 
list, and if the first value is inactive, there no value return.

Resolution: Update the circle statement and make it sensible.

9330_297
Bug ID 21564387: DRAG & DROP OF MULTIPLE ITEMS TO TASK CONTENT 
CAUSES INSUFFICIENT PRIVILEGE ERROR

Root Cause: RevforPart value of Usercontext is not set correctly if the user added a 
part as a relationship row by drag & drop.

Resolution: Evaluate the read privilege. Then set RevforPart into Usercontext correctly.

9330_298
Bug ID 21623282: ATOS FAILS WITH TRANSMISSION NOTES ERROR 

Root Cause: Null point exception.

Resolution: Check whether the object is null before using it.
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9330_299
Bug ID 21620050: EJBEXCEPTION SHOWN IN UI INSTEAD OF CUSTOM 
EXCEPTION IN PROCESS EXTENSION WHILE CLOSING THE RFQ

Root Cause: The lockRFQ and closeRFQ's transaction types are "Not supported".

Resolution: Check whether the object is null before using it.

9330_300
Bug ID 21630080: CANNOT SELECT USER GROUP IN NOTIFY WINDOW

Root Cause: When adding a user to a user group in the UG's Escatation tab, there is a 
parsing error since the selected user includes the user group's info.

Resolution: Parse selected user excluding user group's info.

9330_302
Bug ID 21759729: HIGLIGHT OF REQUIRED FILED IS MISSING WHILE CREATING 
NEW OBJECTS

Root Cause: A code defect that refreshes the required fields to default values when 
creating a project from template fails since not all required fields are filled in.

Resolution: Corrected the code to retain user inputs instead of refreshing to default 
values.

9330_304
Bug ID 21672414: NOT ABLE TO SET THE DEFAULT VALUE IN RFQ DESCRIPTION

Root Cause: Some attributes do not have default values set.

Resolution: Set default value on these attributes when creating RFQ.

9330_311
Bug ID 22022371: ROOT CAUSE OF AND SOLUTION FOR POOR PERFORMING 
SQL STATEMENTS

Root Cause: There are performance issues with 3 queries due to the lack of indices.

Resolution: Created 3 new indices which helps avoiding full table scans and improve 
performance a lot.

9330_316
Bug ID 19915061: USER.HASPRIVILEGE(USERCONSTANTS.PRIV_DISCOVER, 
OBJECT) PROVIDES WR

Root Cause: Currently, we get the user context of PX role by default, even if the login 
user role is wanted.

Resolution: Added a new API to get the correct user context of specific role for both PX 
role and login user role. Also added a method in SDK to check user privilege.

PLM Release 9.3.4
This section includes Hot Fixes included in Agile PLM 9.4.0.
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9340_2
Bug ID 20427868: PATCH FOR PLMMOBILE 3.0 934 CERTIFICATION 

Root Cause: This is caused by a code defect introduced by the fix of 934 bug 17802515. 
When the admin side checks the criteria with "create use in &user" the Item's Cover 
Page is loaded and some rev related attributes are specially handled. Thumbnail ID is 
one of them, but the get thumbnail ID method itself does the privilege check, which 
calls the admin criteria check again. This is an endless loop.

Resolution: Added a flag in user context to indicate whether the current call is from 
admin criteria check, if yes there is no need to check privilege for thumbnail.

9340_3
Bug ID 20425134: AGL93 CREATE HOT FIX FOR AGILE 9.3.4 TO FIX.CALENDAR 
ISSUES

Root Cause: As the requirement changed, we now need to remove the calendar change 
restriction on parent.

Resolution: Removed the calendar change restriction on parent.

9340_4
Bug ID 20723499: BOM REDLINE FROM EC MCAD REMOVE COMPONENT(S) 
FROM WRONG REV 

Root Cause: Publish BOM function is not correct for redline BOM under a pending 
change.

Resolution: Correct the related functions.

9340_5
Bug ID 20681573: SMART RULE DUPLICATE ITEM NUMBERS DOES NOT WORK 
DURING SAVE-AS FUNCTION

Root Cause: Duplicate BOM check is not implemented for the Item Save As case.

Resolution: Per the PM's request, added the check for Smart Rule "duplicate Item 
Number" when saving as BOM table. In Disallow mode the message will pop up 
notifying the user that duplicates are removed. In Warning mode, the message will 
pop up letting the user choose to save as the BOM keeping/removing duplicates.

9340_6
Bug ID 20772122: CAN'T UPDATE AND SAVE EXISTING ASM WITH PARTS AFTER 
LOAD

Root Cause: 1. When the user maps a MultiList in EC client and sets its value as empty, 
the EJB layer does not handle (MultiList with empty string, directly transfer empty 
string to List ID, then got NumberFormatException).

2. Get NullPointerException error when publishing BOM for that there is a non-CAD 
BOM existed in an assembly.

Resolution: Added the handler for the MultiLists with empty value.Added the handle 
for the non-CAD BOM publish.
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9340_8
Bug ID 20818047: PORT 933.104 AND 933.121 TO 9.3.4

Root Cause: Port 933.104 and 933.121 to 934.

Resolution: Port 933.104 and 933.121 to 934.

9340_9
Bug ID 20582717: MOVING THE TASK BY DRAG AND DROP ON GANTT CHART 
CHANGES SCHEDULE DURATION TO 0

Root Cause: This is caused by the lack of working day check for drag and drop task.

Resolution: Added the working day check when the user drags and drops a task.

9340_12
Bug ID 21139896: TO DO PERSONALIZE IN DISCUSSION OBJECT LOST PAGETWO 
INFORMATION

Root Cause: General Objects show P2 and P3 in the Cover Page if they are set to 
visible, but for Discussion as its Cover Page, we need to show the Discussion 
Messages, so Discussion shows P2 and P3 in separate tabs. The Personalize window is 
for public use, so "Page Two" is not shown in th eDisplayed Tabs/Hidden Tabs.

Resolution: Add a special handler for Discussion object to show "Page Two".

9340_14
Bug ID 21067265: ACP IMPORT ERROR: UNABLE TO RESOLVE THE VALUE

Root Cause: When migrating the default value of the list attribute, we must handle it 
specially.

Resolution: Added special handler for default value of list attribute via ACP.

9340_18
Bug ID 21147812: HYPERLINK MISSING IN PX PUBLISH HTML

Root Cause: The 934 CCB 15 did a security enhancement which filters HTML 
hyperlink markups.

Resolution: Loosen the security restriction to allow HTML hyperlink like <a href='' 
target='_blank'/> on protocols: HTTP, HTTPS and mailto.

9340_20
Bug ID 21179498: ACP IMPORT ERROR - (MSGID = 20092)

Root Cause: In the server side, an exception is thrown when inserting records to 
langtable with a non-English user.

Resolution: Need to handle this special exception when importing attributes for 
non-English user.

9340_22
Bug ID 21343461: CAN NOT REDLINE BOM FROM SOLIDWORKS EC
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Root Cause: When trying to redline a BOM and/or transfer find numbers from CAD to 
PLM, the wrong Item table (BOM vs. Redline BOM) was used in certain cases, 
especially if the Item is on a pending change. 

Resolution: The correct Item table (BOM or Redline BOM) is used when redlining or 
transferring find numbers. 

9340_23
Bug ID 21298454: MFR PARTS CANNOT BE CREATED DUE TO HARDCODED ID 
1488

Root Cause: The hard-coded id 1488 in the fix of 14506225 introduced the issue. If the 
customer removes the default subclass and uses the newly created Manufacturer Part 
subclass, the error shows up when getting the subclass node (1488).

Resolution: Get the attribute name via class id instead of subclass id.

9340_24
Bug ID 21330270: REDLINE DATA SHOULD NOT BE LOST UPON RELEASING A 
CHANGE

Root Cause: The instruction in #16868125 is in conflict with the FDD DOC006747.

Resolution: Roll back the behavior change introduced by #16868125 and return to the 
original design.

9340_25
Bug ID 21419626: OOB [PRE-SALES]STREAMING FILES GET CORRUPTED AFTER 
VIEW COMAPRE

Root Cause: 934 WS implement changes from Axis to JRX-WS, and code changes lead 
xRef array from null value to empty array, but the Where Used xRef array still acts as 
if it is null value.

Resolution: Also judge xRef array as if it's empty.

9340_26
Bug ID 21433664: FORMAT OF VALUE FOR DATE ATTRIBUTES CAUSES TROUBLE 
ON THE CLIENT SIDE

Root Cause: The Date attribute value is not formatted correctly.

Resolution: Format the Date attribute value into string as 
yyyy-MM-dd'T'HH:mm:ss.SSS'Z' in GMT timezone.

9340_27
Bug ID 21443752: PGC DECIMALS WRONG

Root Cause: The BOM Quantity is rounded in external rollup.

Resolution: Change the type definition of the staging table used during external rollup 
so the actual Quantity will be used.

Related Bug: 21443796: INVALID CALCULATIONS DUE TO MULTIPLICATION 
AND/OR ROUNDING RESULTS
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9340_29
Bug ID 21418555: UNABLE TO ADD MULTIPLE VALUES IN AFFECTED ITEMS TAB 
OF ECO ON WEB 

Root Cause: The manually-entered value and Copy & paste value is not handled 
properly.

Resolution: Refix bug 17161067. Combine manually-entered value and pasted value.

9340_31
Bug ID 21459641 EC CORRUPTS BOM OF EARLIER RELEASED REV 

Root Cause: The BOM batch redline logic serving the MCAD tool in A934 has a defect 
and leads to the current issues.

Resolution: Add the missing logic.

9340_33
Bug ID 21187466: LOAD DRAWINGS OPTION IN AGILE LOAD PREVIEW IS NOT 
WORKING

Root Cause: After 934 performance improvements for EC services, it does not load the 
drawing for all child part and sub assemblies.

Resolution: Add the load logic for all child part and sub assemblies.

9340_34
Bug ID 21486539: ATTRIBUTE 'FILE TYPE' IN ATTACHMENTS TAB IS EMPTY FOR 
FILENAMES WITH PARENTHESIS

Root Cause: The manually-entered value and copy & paste values are not handled 
properly.

Resolution: Refix bug 17161067. Combine the manually-entered value and pasted 
value.

9340_35
Bug ID 21563788: HTML HEX ENTITY CHARACTERS IN THE IMPORT LOG FILE

Root Cause: The encodeForHTML method causes the coding problem.

Resolution: Remove the code of encodeForHTML method.

9340_36
Bug ID 21538347: 9.3.4 IS LOOKING AT THE CHANGE AS A WHOLE AND NOT 
LIKE PLM 9.3.3

Root Cause: A code change in 934 mistake the criteria check for all AI instead of for the 
current AI for each one.

Resolution: Correct the logic.

9340_37
Bug ID 21602668: UNABLE TO GO BACK TO FILE LIST AFTER OPENING THE FILE 
IN ZIP FILE 
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Root Cause: When opening one file in ZIP, the system creates a CMF file and maps it to 
the ZIP file.

Resolution: Do not create the CMF for the ZIP file.

9340_38
Bug ID 21659926: ITEM WITHOUT THE SPECIFIC SITE IS NOT ADDED TO SCO'S 
AFFECTED ITEM

Root Cause: When adding Affected Items to an SCO from audit release warning the 
site id is missing in the request. It is an invalid operation to add common site object to 
SCO so from Web Client the user finds that no object is added. 

Resolution: When auditing release, set the side id and pass it to the request when 
clicking the audit link.

9340_39
Bug ID 21696588: ACP IS NOT ABLE TO MIGRATE THE WORKFLOW 
CONFIGURATIONS PROPERLY

Root Cause: New attributes are missing in ACP.

Resolution: Added password required attribute in ACP.

9340_40
Bug ID 21697331: OBJECT NUMBER CONVERTS TO UPPER CASE WHEN USING 
IMPORT

Root Cause: To support upper/lower/mixed case, the method 
createRealObjNumberCollection of super class BatchHandler.java should be 
overwritten, but Item/Manufacturer/Manufacturer Part handler does not overwrite it

Resolution: Overwrite the method createRealObjNumberCollection to support 
upper/lower/mixed case for creating Item/Manufacturer/Manufacturer Part.

9340_41
Bug ID 21762536: AGILE LDAP USER SYNC NOT WORKING FOR GENERIC LDAP 
CONFIGURATION

Root Cause: For a generic LDAP server, it needs to map objectGUID atribute to 
entryGUID in groovy script, but the map value is not saved into the Agile user.

Resolution: Added code to save the values.

9340_42
Bug ID 21636998: AUDIT STATUS SHOWS FALSE MESSAGE IN AGILE 934 FOR 
ITEMS WITH NO SITE

Root Cause: An API created a wrong answer. This made an invisible attribute go 
through the required fields check.

Resolution: Use another API to find the visible attributes, and if the target attribute is 
not in these attributes, the required fields check will not occur for this attribute.
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9340_43
Bug ID 21799700: GETOBJECT WEBSERVICE NOT WORKING FOR PROJECT 
OBJECTS

Root Cause: The admin metadata is incorrect. The data type of attribute 2000000100 is 
integer.

Resolution: Run the SQL script to correct the data type to be double for attribute 
2000000100.

9340_44
Bug ID 21758012: CURSOR FOCUS NOT IN FIRST EDITABLE FIELD

Root Cause: 934 ME-001 project (Two Columns project), fields have new CSS classes 
assigned.

Resolution: Code to set focus on fields honors the Two Column mode.

9340_45
Bug ID 21769583: NUMERIC ATTRIBUTES CONFIGURED WITH A SCALE DOES 
NOT SHOW CORRECTLY

Root Cause: Numeric attributes keep the trailing zeros.

Resolution: Remove the trailing zeros for numeric attributes.

9340_46
Bug ID 21699540: BOM SHOULD BE PUBLISHED TO SPECIFIC SITE DEFINED IN

Root Cause: EC web service implementation does not send the specified site to PC 
server and the PC side handles the site information even if it tries to get it.

Resolution: Make sure the specified site is sent to the PC side and the PC side can 
publish the structure to the site correctly.

9340_47
Bug ID 21841460: SCALE CANNOT BE CHANGED ON SOME PART COMPLIANCE 
ATTRIBUTES 

Root Cause: Scale, Min Value and Max Value properties of the following 15 attributes 
are disabled and not to be editable: 
Parts.Compliance.Substances.Numeric01~Numeric10 
Specifications.Substances.Numeric01~Numeric05

Resolution: Scale, Min Value and Max Value properties of the above 15 attributes are 
enabled and editable.

9340_51
Bug ID 21897832: AGILE IMPORT SCREEN REFRESHING FOR EVERY ATTRIBUTE 
MAPPING USING CHROME

Root Cause: We disable the cache of some HTTP requests for a security fix, but this 
leads to load images used by the import functionality every time.

Resolution: Enable the cache of the static resources, for example, images.
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9340_53
Bug ID 21896804: IMPORTANT CONTENT WIDGET OF THE SUMMARY DISPLAYS: 
APPLICATION ERROR

Root Cause: This is a code defect. Values of some variables are not cleared up in a loop, 
which leads to disproportionate parameters while compiling SQL

Resolution: Added code to clear values of the variables at the end of the loop

9340_54
Bug ID 21802941: AUTOVUE FOR AGILE TAKES MUCH LONGER TO OPEN FILES 
COMPARED TO STAN

Root Cause: Two factors - 1. Pinging DFM costs a lot of time. 2. When replicating, 
checking file exists WS call also costs a lot of time.

Resolution: 1. The ping action was corrected to have a normal ping servlet approach.

2. Removed file exists WS call, and used getfile size WS call instead.

9340_55
Bug ID 21873266: EXTERNAL ROLLUP RETURNING INCONSISTENT & 
INCORRECT CALCULATED CONC RESULTS ON SP

Root Cause: 1. External rollup by default use "g" as standard UOM, but the system 
UOM can be customized in Java Client.

2. External rollup does not handle a threshold of 0 PPM correctly when calculating the 
rollup result.

3. There are duplicated rows in SPECIFICATION_SUBSTANCES table, which is 
generated during external rollup. The duplicated rows look like bad data resulted 
from multiple threads of external rollup.

Resolution: 1. In the external rollup procedure, when putting data into the result table 
the UOM field should be determined by Java Client configuration.

2. Updated the logic to take 0 in consideration in such a scenario.

3. DISTINCT keyword can be used to resolve the problem.

Related Bug 21874436: PART OF PATCH 9.3.2.167 NEEDS APPLYING TO EXTERNAL 
ROLLUP BATCH JOB

9340_63
Bug ID 22092496: 9.3.4 WEB SERVICES ARE NOT RETURNING CORRECT 
RESPONSES ON LINUX SYSTEM

Root Cause: Oracle JAXP document builder instance which does not support reset 
feature, is loaded and created.

Resolution: Specify to use apache xerces JAXP document builder implementation. 

9340_74
Bug ID 22092496: AXML EXPORTED BY AGILE CONTENT SERVICE HAVE NO 
REDLINES WHEN BOMNO

Root Cause: Empty tag was removed when fixing bug 14835608.
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Resolution: Populate empty tag to reflect the redline delete action, if the new value is 
empty and old value is not empty.
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3Resolved Issues

This chapter lists issues that were resolved during this release.

For each resolved issue:

■ On the first line, the number is the internal Defect number.

■ On the second line, numbers in bold (for example, 3-123456789) are Customer 
Support ID numbers from customer-reported issues. If there is not a number in the 
second line of an issue, its origin was not customer-reported.

Product Collaboration

17662095

Searches

Issue: SORT BY ATTACHMENT COLUMN UP/DOWN IN SEARCH RESULTS DOES 
NOT GET SORTED RESULTS

Root Cause: Since Java 7, it throws "comparison method violates its general contract" 
exception on the sorting attachment column. 
https://docs.oracle.com/javase/7/docs/api/java/util/Comparator.html

Resolution: Define a comparison that observes the general contract.

Verification:

1. Log in to Web Client as admin.

2. Do a basic search: Item-->p0*, run the search.

3. Sort search results by the Has Attachments column in Ascending order: Click the 
Has Attachments column, changes Icon to Show the Up Arrow.

Result: Search results are sorted by Has Attachments column in Ascending order: 
for Icons, display should be treated as 1, empty as 0.

4. Sort search results by Has Attachments column in Descending order: click Has 
Attachments column, changes Icon to Show a Down Arrow.

Result: Search results are sorted by Has Attachments column in Descending order: 
for Icons, display should be treated as 1, empty as 0 

18044246
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Administration/Configuration

Issue: CANNOT BUILD CRITERIA USING CHANGE ORDER | AFFECTED ITEM | 
ITEM P2 MULTILIST01

Root Cause: $USERGROUP is not handled specially in the save criteria.

Resolution: Handle $USERGROUP in a special manner in the save criteria.

Verification:

1. Log in to Java Client as admin.

2. Go to Classes > Parts > Page Two, enable Multilist01, and set it point to dynamic 
list:User Groups.

3. Go to Classes > Change Orders > Affected Items, enable Item.P2.Multilist01.

4. Go to Admin > Criteria, create a new criteria C1: Change orders > Affected 
item.Item.P2Multilist01 > Contains any > $User Group, and save.

Result: The new criteria:C1 is created successfully.

18058522

Searches

Issue: EMAIL: SEARCH CRITERIA IS NOT RETAINED/DISPLAYED CORRECTLY 
IN INPUT SCREEN

Root Cause: When mapping selected values for the multi-selection list, the matching 
conditions is mistakenly joined with an OR logic operand, ||.

Resolution: Replace the operand with AND, &&.

Verification:

1. Log in to Java Client as admin.

2. Go to Admin > Classes > Parts > Page Two, and enable p2.list10. Set it point to a 
simple list:product line.

3. Go to Admin > Classes > Documents >Page Two, enable p2.list10, sand et it point 
to the same simple list:product line.

4.  Go to Classes > Change Orders > Affected Items, enable attribute: Item.P2.List10

5. Log in to Web Client as admin.

6. Create a part:P001, sand elect LEO for p001.P2.List10.

7. Create a change order:ECO001, add P001 to its Affected item table

8. Do an Advanced Search: Changes > Change orders > Affected Item.Item P2 List10 
> In > [Parts]LEO, and click outside the text input widget.

Result: Selected value:[Parts]LEO can be retained correctly.

18073073

Web Client

Issue: NEW MANUFACTURER DOUG'S HOUSE OF PIES - 005157M IS NOT A 
VALID MFR NAME

Root Cause: It no longer escapes single quote and back slash character.
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Resolution: N/A

Verification:

1. Log in to Web Client as admin.

2. Create a Manufacturer with an apostrophe in its name: mf'1.

3. Create a Manufacturer part. In the Create New window, input mf'1 in the 
Manufacturer field, then input the Manufacturer Part number and save it.

Result: The new Manufacturer Part is created successfully.

4.  Create a Manufacturer Part, in the Create New window. Click the Search button 
besides the Manufacturer field, input m, and run the search.

Result: The Manufacturer with apostrophe, mf'1, is returned.

5. Select mf'1, then input the manufacturer part number, and save it.

Result: The new Manufacturer Part is created successfully.

18174566

Java Client

Issue: UNABLE TO COPY BOM ITEMS BETWEEN BOMS WITHIN AN ECO

Root Cause: The shared redlined image attribute is incorrectly set by Change/AI as 
editable, thus the content copy/paste in Java Client tries to update the redlined image 
attribute of the Redline BOM with the hard-coded attribute id "600005" and fails with 
the error that the customer reported.

Resolution: Correct the editable property of image attributes.

Verification:

1.  In Admin, reorder the AI attributes and move the Item Number (usually 
modifiable) attribute to the top.

2. In Java Client, copy some Redline BOM rows from one Affected Item to another.

Result: The user is able to copy BOM Items between BOMs within an ECO.

18252178

Web Client

Issue: EDIT ATTRIBUTES OF A SUPPLIER RESULTS IN "SUCCESSFULLY SAVED" 
BUT DID NOT SAVE

Root Cause: Do not handle the case, if popup window "Add Contact Users" is empty, 
and grey Save button can not be clicked.

Resolution: Make the grey Save button to be non-clickable.

Verification:

1. Open a non-web supplier.

2. In the General Info tab of the non-web supplier, set the Web Supplier to Yes, and 
edit the Description, Address, and so on, then click Save.

3. On the Add Contact Users page, click Finish.



Product Collaboration

3-4 Agile Product Lifecycle Management Readme

Result: The Finish button is greyed out and disabled when there is no contact user. 
Nothing happens when the user clicks it.

4. Add a contact user to this supplier.

5. Click Finish.

Result: The Add Contact User window is closed. The non-web supplier is changed 
to web supplier. The Updated attributes like Description, Address, etc. are saved 
successfully.

18356374

Administration/Configuration

Issue: THE VALUE APINAME OF CASCADING LIST AUTOMATICALLY CHANGE

Root Cause: There is a code defect of not setting APINAME of listentry for different 
languages.

Resolution: Set APINAME of listentry for all languages to be identical.

Verification:

1. Log in to Java Client as admin.

2. Create a new cascade list, CS, with the following structure:

17

--- 1701

--170101

Set its API Name as 170101_NVS.

3. Log in to Java Client as Chinese user CN1.

4. Search for List CS and change its value:170101 API Name to 170101_CN.

5. Restart the Agile server.

6. Log in to Java Client as admin/Chinese user:CN1, check API Name of cascade list 
value:170101.

Result: The API Name of the cascade list value, 170101, has been updated to the 
latest version, 170101_CN.

18367296

Web Client

Issue: IN EDIT MODE, THE SUPPLIER TYPE FIELD IS SHORT AND CUTS OFF THE 
VALUE IN THE FIELD

Root Cause: We ignore the input width for UG:UG Type.

Resolution: Added code to set the input width.

Verification:

1. Log in to Web Client as admin, and create suppliers with any supplier type.

2. Open the General Info tab of the supplier, and click Edit.

3. Check the Supplier Type field.
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4. Drag the border to scale-down the window, check the value of Supplier Type field.

Result: The Supplier Type field does not cut off the value, for any supplier type. It 
displays the complete value such as Component Manufacturer.

18390305

Item & BOM

Issue: ABLE TO ADD BOM COMPONENT WITHOUT HAVING DISCOVERY 
PRIVILEGES ON COMPONENT ITEM

Root Cause: Allow a user to add BOM components without having Discovery 
privilege.

Resolution: Do not allow a user to add BOM components without having Discovery 
privilege

Verification:

1.  In Admin, create a user, User01, with Create Items and Modify Items privilege 
(make sure the user has no Discover Items privilege).

2. Log in to Web Client as User01.

3. Create Part01.

4. Go to the BOM table and search for Items.

Result: No item (except the Part that this user created) can be searched out.

5. Type in an existing Item.

Result: "Insufficient privilege" message appears.

18472594

Standard Reports

Issue: LEGACY BOM COMPARISON REPORT SHOWS INCORRECT RESULT

Root Cause: It uses a wrong data type to compare Find Numbers when run Legacy 
BOM Comparison Report.

Resolution: Correct to use correct data type.

Verification:

1. Create two Parts with the same attributes, for example, YO0911-1 YO0911-2.

2. Create an ECO and add the two Parts to Affected Items.

3. On the ECO > Affected Items page, redline the two Parts, adding same part to the 
two parts, the only difference is the Find Num. For example:

Item Number

yo0911-1     <----

yo0911-2     

BOM Redline(T)

Item Number     Qty   Find Num
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907252600A      1     C001

Item Number

yo0911-1

yo0911-2       <----

BOM Redline(T)

Item Number     Qty   Find Num

907252600A          1     C002

4. Run the Legacy BOM Comparison Report as follows: 

1. On page 1, select Default Layout.

2. On page 2, select the two Parts for the Report. Change revisions to 
non-introductory, like (?) C00017.

3. On page 3, select the proper type.

4. On Page 4, Compare By: Find Number (Or Compare By: Item Number, Then 
By: Find Number.

5. Click Finish to get the report.

Result: The report results are correct.

18809392

Administration/Configuration

Issue: PAGE TWO TABS ARE NOT DISPLAYED FOR DISCUSSION OBJECT IN TAB 
DISPLAY CONFIGURATION

Root Cause: General Objects show P2 and P3 in the Cover Page if they are set to 
visible, but for Discussion, its Cover Page needs to show the Discussion Messages, so 
Discussion shows P2 and P3 in separate tabs. The Personalize window is for public 
use, so "Page Two" is not shown in Displayed Tabs/Hidden Tabs.

Resolution: Add a special handler for the Discussion object to show Page Two.

Verification:

Prerequisites: 1. User should have Manage Tab Display privilege. 2. Go to Admin > 
Data Settings > Classes Open Discussion subclass, Open Page Two in User Interface 
Tabs and set visible=yes.

1. Log in to Java Client.

Result: The user is able to log in to Java Client and has the Manage Tab Display 
privilege.

User is able to set the visibility of Page Two to YES.

2. Log in to Web Client. Create New > Discussions Create new Discussion Test. 
Validate that Discussion, Page Two, Action Items, Attachments, History tabs are 
shown.

Result: The user is able to log in to Web Client and create a new Discussion and 
validate the Discussion, Page Two, Action Items, Attachments, History tabs.

3.  Click the right icon for tab personalization and open Personalize. Validate that 
Page Two is shown in Displayed Tabs/Hidden Tabs.
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Result: The user is able to click the right icon for tab personalization and open 
Personalize. User is able to view Page Two in Displayed Tabs/Hidden Tabs.

4. Save the Personalize and return to the Discussion object, and validate the Page 
Two tab.

Result: The user is able to click on Save and return to the Discussion object. If Page 
Two is in Displayed Tabs of Personalize window, then it is displayed in the 
Discussion object after saving. If Page Two is in Hidden Tabs of the Personalize 
window, then it is not displayed in Discussion object after saving.

5. Validate the Order Change of the Page Two tab in the Personalize window.

Result: The user is able to change the order of display of the Page Two tab in the 
Personalize window.

18914857

Roles & Privileges

Issue: CREATE FILE FOLDER IS VISIBLE THOUGH NO PRIVILEGE IS ASSIGNED 
TO THE USER

Root Cause: Markup is special, this functionality is only

available in EC, so if user does not have other

'Create File folder(class level)' privilege except

'Create Markup', we should not shown 'File

folders' menu item in WebClient.

Resolution: If user does not have other 'Create File

folder(class level)' privilege except 'Create

Markup', we should not shown 'File folders' menu

item in WebClient.

Verification:

1. Create a new user and give the user only 2 roles - My User Profile and Creator can 
read and discover objects he or she created.

2. Log in as the user

Result: User cannot create any objects.

3. Use Save As on the Create Markup privilege and create a new one test Markup.

4. Assign it to a new Role, Test Role, and add the user created in Step 2.

5. Log back in as the user.

Result: The user can see a Create New || File Folders || File folders.

6. Click on it.

Result: The Create New file folders window displays without Type values in the 
dropdown.

18954093

Import
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Issue: IMPORT IS GIVING AN INCORRECT ERROR MESSAGE FOR INCORRECT 
FILE TYPE

Root Cause: The logic of parsing Excel is wrong, it mishandles the following format:

<sst

xmlns="http://schemas.openxmlformats.org/spreadshe

etml/2006/main" count="4"

uniqueCount="4"><si><t>b</t></si><si><t>a</t></si>

<si><t>12d</t></si><si><r><t

xml:space="preserve">I'm ok </t></r><r><rPr><sz

val="11"/><color theme="1"/><rFont val="Arial

Black"/><family

val="2"/></rPr><t>with</t></r><r><rPr><sz

val="11"/><color theme="1"/><rFont

val="Calibri"/><family val="2"/><scheme

val="minor"/></rPr><t xml:space="preserve">

it</t></r></si></sst>

An <si> tag may have multiple <t> tags.

Resolution: Changed the parsing logic to consider the multiple <t> tags situation.

Verification:

1. Log in to Web Client.

2. Click Tools and Settings > Import menu.

3. Select an XLSX file with bold text as source, click the Next button.

4. Validate the Design which is a component of another Design.

Result: The XLSX file is imported successfully.

19456954

Searches

Issue: AGILE 933 - WHERE USED REPORT FAILS WITH MESSAGE: AN 
UNEXPECTED ERROR HAS OCCURED

Root Cause: The attribute, Parts.Title Block.Base Model (2000009494), is not supported 
by search.

Resolution: Remove the attribute, Main Header Attributes.Parts.Title Block.Base 
Model, from Where Used Report (report id="7").

Verification:

1. Create an Item, p0001, and P0002, as its BOM.

2. Go to the Products Reports folder > Where used report and open it.

3. Choose the Layout tab.
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4. Select DEFAULT LAYOUT > Format.

5. Unfold the Main Header Attributes in the hidden fields.

Result: Parts.Title Block.Base Model are removed from the attributes list.

6. Add other title block attributes to the display field.

7. Click Save.

8. Run the execute button and put the P0002.

9. Click the Next and Finish buttons.

Result: The Where Used report can runs successfully.

19458214

Notifications & Subscriptions

Issue: EVENT-BASED NOTIFICATION DISPLAYS ** UNKNOWN CUSTOM 
ATTRIBUTE **IN THE SUBJECT/BODY OF THE NOTIFICATION RECEIVED

Root Cause: The From Status and To Status custom fields are not handled for PPM 
objects in Notification.

Resolution: The PPM server side needs to set the previous and next status ID into an 
object before sending out the Notification. The Notification framework then gets the 
status ID out and transfers them to the displayed status names in subject/body.

Verification:

1. Configure a Change Status event for Activities.

2. Create a Notification for Activities From: $SENDER To: $NOTIFY Subject&Body: 
Status for [General Info.Name][General Info.Number] has been changed from 
[From Status] to [To Status] by [User Name].

3. Event Subscriber: Based on above event and event Handler.

4. Log in to Web Client.

5. Create a Program and Change Status, set admin as notify user.

6. Check the inbox of Admin.

Result: The attribute value in the notification subject and body showed correctly 
(Status for PROGRAM-002 has been changed from Not Started to Complete by 
Administrator, a (admin)).

19596787

Searches

Issue: SAVED SEARCH NOT ALLOWING INPUT FOR PROMPT

Root Cause: Saved search prompt dialog is not handled correctly

Resolution: Fixed code for saved search prompt dialog opening.

Verification:

1. Log in to Web Client.
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2. Create an Advanced Search > File Folders/Designs - Where Used in Structure One 
Level All Checked-in Versions - Design Number contains Prompt, Search then 
Save to Personal Search folders.

3. Click on the link in Folders to Saved Search.

Result: Prompts the user to enter the search value for respective attribute once the 
Saved Search link is clicked from personal searches.

19620107

Standard Reports

Issue: ATTRIBUTE HISTORY REPORT DOES NOT GENERATE THE ATTRIBUTE 
CHANGE HISTORY

Root Cause: Selected attributes length exceeds report layout specific length[REPORT_
LAYOUT(VALUE(4000)+VALUE2(4000))].

Resolution: Extend table column length.

Verification:

1. Log in to Java Client and enable Read and Modify all attributes for Items.

2. Enable P2 of class Part and make all P2 attributes visible.

3. Log in to Web Client, go to find Item Attribute History Report, Layout tab, open 
Default Layout, on Format tab, add all Main Header Attributes and Page Two 
attributes to Displayed Fields, save.

4. Use SQL Developer to connect to the Agile DB, run SQL 'select * from report_
layout where last_upd like '%-15';' to get the updated layout by step 3. Note the 
length of Value2 column.

5. Create a subclass under Part. Enable P3 and make all P3 attributes visible.

6. In Web Client, open the default layout, add all page3 attributes of the subclass 
created in step 5 to Displayed Fields, and save.

7. On SQL Developer, run that command again to get new length of Value2. If the 
length is larger that before, repeat step 5 & 6, until the length of Value2 reaches 
4000 or not increases.

8. Open the default layout again. Check the Format tab.

Result: All the fields are in displayed fields.

9. In Java Client, enable P3 of subclass Part. Make all P3 attributes visible.

10. In Web Client. create a Part. Create an ECO against this Part.

11. Actions > Item Attributes History Report. On the first page of the wizard, edit 
default layout and add all P3 attributes of the subclass part. Save.

12. Execute the report, check the result. 

Result: All P3 attributes are shown.

19729216

Web Client

Issue: UNABLE TO LOAD CASCADED MULTILIST IN FIREFOX/CHROME
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Root Cause: Attribute names that contain special characters like '#' are included in the 
query URL without proper encoding, which causes the query to fail on the server side.

Resolution: The attribute name is unnecessary, so remove it from the query.

Verification:

1. In Admin, create a Cascade list CascadeList01, and add some values into it.

2. Enable Parts.Page2.MultiList01 and rename it to MultiList#01, and point 
MultiList#01 to CascadeList01.

3.  In Web Client, create Part01.

4. In Edit mode, click "Launch the Palette" icon of MultiList#01.

5.  On the pop-up palette, check the values of the cascade list.

Result: The user is able to load the values of the cascade list.

19763413

Web Client

Issue: CHANGE JAPANESE TRANSLATION "MY BOOKMARK"

Root Cause: Translation issue for My Bookmark.

Resolution: Get new translation for My Bookmark in Japanese translation library.

Verification:

1. Log in to Web Client as a Japanese language user.

2. Go to the My BookMark area.

3. Check the new translation for My Bookmark.

Result: My bookmarKs is translated with the correct Japanese character string.

19774891

Changes

Issue: HAS APPROVED MANUFACTUERS ICON LINK TO THE WRONG 
REVISION

Root Cause: A UI framework change at 9.3 introduced this issue.

Resolution: Has Approved Manufacturers icon should adopt the same logic as Has 
Attachment icon, and link to Item's current revision.

Verification:

Preconditions: Enabled Has approved.

1. Log in to Web Client as admin.

2. Create a Part, P001.

3. Go to the Manufacturer tab of P001 and add any existing Manufacturer object.

4. Create a new Change, C0001, for Part P001.

5. Release the changes with Revision 1.

6.  Create a new Change for Part P001 as C0002.
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7. Do not release this C0002.

8. Go to C0002 > Affected Item tab > Click Has approved Manufacturers dot icon for 
the P001 Item in the Row.

Result: P0001 is opened with pending changes version.

19776512

Item & BOM

Issue: ON SCO, CLICKING ON AUDIT RELEASE RESULTS DOES NOT ADD 
UNRELEASED CHILDREN

Root Cause: When adding Affected Items to SCO from the audit release warning, the 
site id is missed in request. It is an invalid operation to add common site object to 
SCO, so from Web Client, the customer will find that no object is added.

Resolution: Auditing release sets the side id and passes it to the request when clicking 
the audit link.

Verification: 

1. Log in to Web Client. 

2. Create Part01 with a Site and release it.

3. Create Part02 without a Site and release it. 

4. Create an SCO and add Part01 to the Affected Items table. 

5. Go to the redline BOM tab, and redline add Part02. A warning message appears to 
tell the user that the part doesn't have a Site and default to a Site.

6. Click OK to continue. 

7. Click More > Click Audit Release. An error is returned: Unreleased child 
Part02(site).

8. Click the error message 

Result: The child part Part02 is added to the Affected Items tab of the SCO.

19832973

Web Client

Issue: LIST VALUE "LENGTH" CANNOT BE STORED IN MULTILIST FIELD

Root Cause: Our implementation of the hashmap js library is backed by native Array, 
so put a map entry into hashmap is equal to <Array Ojbect>[<key>], and length is a 
property of Array to indicate its length. It should be an integer.

Resolution: Add the prefix, hashmapkey_, to the head of the keys.

Verification:

1. In Admin, create a simple list SimpleList01 (type: SIMPLE), and add the following 
values: Color, Length, Width.

2. Enable Parts.Page2.MultiList02, and point it to SimpleList01.

3. In Web Client, create Part02.
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4. In edit mode, click the Launch the Palette icon of MultiList02 and select the value 
Length.

5.  Click Save, and check the result.

Result: The value for Length can be saved.

19849958

Searches

Issue: ERROR QUERYING QUALITY EVENT WITH CUSTOMER

Root Cause: When a workflow column is in the search condition, the Customer 
column is not handled correctly in the where clause.

Resolution: Added missing operators, IN and NOT IN, and added a special handler 
for SIMPLE_RELATION_CUSTOMER table name when generating the where clause.

Verification:

1. Log in to Web Client as admin.

2. Do an Advanced Search: Quality Change Requests > CAPA > Cover 
page.Customer > In > JohnCo (CUST00001) AND Workflow.Approver > Does not 
Contain > Analyst, Change (ca), and run the search.

3. Log in to Web Client as ldapdemo1/Oracle2011 at 10:30.

Result: CAPA that meets the search criteria is returned in results.

20046950

Changes

Issue: VALIDATE BUTTON IN CHANGE ORDERS REMOVES VALUES OF THE 
ATTRIBUTES

Root Cause: There is a code defect when retrieving the Cascade List value from the 
request.

Resolution: Correct the retrieve function.

Verification:

1. In Admin, create a cascade list, and add some values into it.

2. Point Change Orders.Cover Page.Reason Code to this new created cascade list.

3. In Web Client, create ECO01.

4. In edit mode, select a value for Reason Code, and click the Validate button.

5. Check the value selected for Reason Code.

Result: The selected value for Reason Code remains after validation.

20065865

Web Client

Issue: EDITING A USER OBJECT CAUSES COUNTRY/AREA FIELD TO DEFAULT 
TO AFGHANISTAN
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Root Cause: When creating an HTML element for this attribute in edit mode, the 
addBlank flag is set to false by default.

Resolution: This attribute is allowed to be blank, so we should set the addBlank flag to 
True.

Verification:

1. Log in to Java Client as admin.

2. Go to Classes > Users > User > General Info tab, visible attribute: Country/Area.

3. Go to Lists > Open Country, set its Display Type as List.

4. Log in to Web Client as admin.

5. Open any user without a Country/Area value, then click the Edit button, check 
Country/Area attribute value.

Result: The default value for the Country/Area attribute is blank.

6. Select a value for the Country/Area attribute

Result: The value can be set successfully.

20190756

Folders, Files, & Attachments

Issue: FILE UPLOAD SELECTOR DOES NOT OPEN FOR ONE USER ADD 
ATTACHMENT IMPOSSIBLE

Root Cause: Bug in code.

Resolution: Eliminated the parameter of styleFileURL passing from Agile 9 to File 
server to avoid potential security risk.

Verification:

1. Log in to Web Client as admin.

2. Create new Item > Documents > Document: DOC01-18"-PLATE.

3. Activate the Attachments tab.

4. Click Add > File. The File Upload Selector window opens,

5. Click Browse for files.

6. Select a file from disk, for example, C:\tmp\file01.pdf.

7. Click Upload (if Start Upload immediately is not check marked). The File Upload 
Manager window opens, showing progress and upload result.

8. Log out of Web Client.

9. Log in to Web Client as admin.

10. Load Document DOC01-18"-PLATE.

11. Activate the Attachments tab.

12. Click Add > File

Result: The File Upload Selector window pops up and the user is able to upload 
the file successfully.
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20200797

Administration/Configuration

Issue: CHANGE WORKFLOW CRITERIA USING AN ITEM PAGE TWO 
READ-THRU LIST FIELD WITH A USERS 

Root Cause: We do not specially handle dynamic list for Affected Item attributes.

Resolution: Specially handle dynamic list for affected item attributes.

Verification:

1. In Admin, enable Parts.PageTwo.MultiList01, and point it to Users dynamic list.

2. Enable Change Orders.Affected Items.Item P2 MultiList01.

3. Try to create a Criteria with condition: Change Orders.Affected Items.Item P2 
MultiList01 Contains Any admin.

4. Check whether user can create the criteria.

Result: The user is able to create the criteria.

20205831

Web Client

Issue: THE DATE PICKER DOESN'T WORK PROPERLY IN FIREFOX

Root Cause: N/A

Resolution: N/A

Verification:

1. Log in to Web Client using Firefox.

2. Create a Change.

3. Select the Affected Items tab and add a Part.

4. Change the Effective Date and time value (include hour, minute and AM/PM).

Result: The user is able to change the date and time (include hour, minute and 
AM/PM).

20224215

Folders, Files, & Attachments

Issue: AGILE 933 - DRAG AND DROP FILE ATTACHMENTS TO UPLOAD FAILS IN 
IE 10 AND FIREFOX

Root Cause: Drag and drop is not supported well in IE10 and Firefox in Agile.

Resolution: Fixed code to handle for IE10 and Firefox.

Verification:

1. Log in to A9 on IE 10, IE 11, Mozilla browser.

2. Create or access an ECO or MCO.

3. Go to the Attachments tab and click on Add > Files.
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4. Drag and drop a file to the file upload selector screen.

Result: The user is able to drag and drop a file to the file upload selector screen and 
upload the file successfully.

20271472

Web Client

Issue: HISTORY TAB SHOWS FIELD MODIFIED EVEN THOUGH IT HAS NOT 
BEEN UPDATED

Root Cause: This is a browser-related issue. For a multi-text attribute, if the value is 
more than one line, the wrap character is "\n" in Firefox; while is "\r\n" in Internet 
Explorer, which leads to this issue.

Resolution: Ignore the wrap character's difference between IE and FF when sending 
cell value for a multi-text attribute during a redline.

Verification:

1. Log in to Java Client Admin > Data Settings > Classes, open ECO subclass, 
activate the multi-text attribute, for example, yo-longtext, in P3. Set the value 
which contains the wrap character to default value, for example, yolong text.

2. Log in to Web Client using Firefox, create an ECO, assign the workflow, set the 
change analyst, and submit the ECO.

3. Log in to Web Client using IE, open an ECO, click the Edit button on the Cover 
Page, update any field, for example, the Description of Change: from null to 'test') 
and save it.

4. Click the History tab, check whether the multi-text attribute is shown as modified.

Result: The multi-text attribute is not shown as modified.

20283032

Item & BOM

Issue: UNABLE TO SEE ATTACHMENT UNDER MCO REVISIONS

Root Cause: When the system got attachments info by clicking an Item from a pending 
MCO, if the Item had been released by 2 or more MCOs and there was no released 
revision (REV released by ECO) on this Item, the system returns the current pending 
MCO as the released change, but actually, the current pending MCO was not a real 
released change.

Resolution: Return the change with introductory.

Verification:

1. Log in to Agile Web Client.

2. Create a Part, Part01, and add file attachments to the introductory revision.

3. Create MCO01 against Part01 and release it.

4. Create MCO02 against Part01 and release it.

5. Create MCO03 against Part01.

6. Check Part01's Attachments of the rev MCO03.
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Result: File attachments are shown in the Part of the pending MCO03.

20381471

Web Client

Issue: DUPLICATE TEAM MEMBERS IN PROGRAM SEARCH RESULTS

Root Cause: Missing join condition between table 'TEAM' and 'OBJECTACL'.

Resolution: Adding the join clause 'TEAM.USER_ID = OBJECTACL.USERID' when 
generating SQL

Verification:

1. Create an active Program with some child objects.

2. Navigate to the Team tab and add different users with different roles.

3. Add one of the object names from Step 1 in Advanced Search and format the 
Output to display Team.Name and Role attribute.

4. Click on the search button.

5. Validate the Search results such that Team Member Name and Role are correctly 
displayed.

Result: The search results do not display any duplicate records. Search result 
displays one record for one user (team member) with all his roles assigned.

20384197

Item & BOM

Issue: EDITING A USER OBJECT CAUSES COUNTRY/AREA FIELD TO DEFAULT 
TO AFGHANISTAN

Root Cause: Post redline no object version gets updated for an Affected Items object in 
the table model. A duplicate warning has generated an Affected Items object version 
in the database. The next time when the redline save happens again, the version 
mismatch is exposed.

Resolution: Refresh the AI object version after the redline edit save.

Verification:

1. Log in to Java Client as admin.

2. Go to Classes > Users > User > General Info tab, visible attribute: Country/Area.

3. Go to Lists > Open Country, set its Display Type as List.

4. Log in to Web Client as admin.

5. Open any user without a Country/Area value, then click the Edit button, check 
Country/Area attribute value.

Result: The default value for the Country/Area attribute is blank.

6. Select a value for the Country/Area attribute

Result: The value can be set successfully.
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20438192

Administration/Configuration

Issue: CANNOT REMOVE LOCK FROM COLUMN

Root Cause: When unlocking attribute in Java Client, it does not set the flag to 
Unlocked in database.

Resolution: Set the flag to Unlocked in the database when unlocking attribute in Java 
Client.

Verification:

1. Log in to Java Client as admin.

2. Go to Admin > Classes > Parts > BOM tab > Attributes:BOM, click the Order 
button.

3. Select the Item Number, lock it, save.

4. Modify multiple Find Numbers with the same value and click Save. A warning tip 
appears.

5. Open the Order, check again.

Result: The lock is removed successfully.

20466281

Standard Reports

Issue: PRIVILEGE NAME IS NOT SORTED ON PRIVILEGE MASK DETAIL REPORT

Root Cause: Privilege name is not sorted on Privilege Mask Detail Report.

Resolution: Add the sort as Privilege Name.

Verification:

1.  Log in to Web Client, go to run Privilege Mask Detail Report.

2. Open the saved report, check data in the Applied To columns of each row.

Result: Data in the Applied To column is sorted.

20492867

Export

Issue: CASCADE LIST ATTRIBUTE DOES NOT EXPORT TO XLS

Root Cause: The XLS file does not export Item detail.

Resolution: Add loadDetailsForItems code for it.

Verification:

1. Log in to Java Client.

2. Associate Item Category attribute on Parts Title Block with a cascade list.

3. Enable Item Category attribute on Parts Title Block.

4. Enable Item Category read through attribute on Changes Affected Items tab.
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5. Create a Part and select value for Item Category.

6. Create a Change against the Part.

7. Export the change to Excel(xls) format.

Result: Item Category on Changes Affected Items tab is exported and displayed 
correctly in the Excel file.

20495823

Import

Issue: CHANGED AUTO NUMBER SOURCE DOES NOT TAKE EFFECT ON 
SECOND IMPORT OF PARTS

Root Cause: This is a cache synchronization issue.

Resolution: Add a flag to indicate whether the AutoNumber source has been changed. 
When it has changed, then load a new autoNumberGenerator.

Verification:

Preconditions: Create a general user that does not have any special administrator-type 
privileges.

Admin User:

1. Log in to Java Client as admin.

2. Create a new subclass, Service, under the Parts class.

3. Create the following two new Autonumbers for this new subclass "Service":

1. Name: PartServ321   Prefix: ORASRV-321-P Number of Characters:4

2. Name: PartServ123   Prefix: ORASRV-123-P Number of Characters:4

4. Create a import file as below:

"Number","Part Type","Lifecycle Phase"

,"Service","Preliminary"

,"Service","Preliminary"

,"Service","Preliminary"

,"Service","Preliminary"

5. Log in to Web Client.

6. Launch the Import wizard.

7. Click the Preferences button on the Import wizard.

8. Select the AutoNumber sources tab, choose Base Class Items.

9. Find subclass Service, choose AutoNumber PartServ123.

10. Select the file created in Step 4, following the Import wizard and click Import.

11. Launch the Import Wizard again.

12. Click the Preferences button in the Import Wizard.

13. Select AutoNumber sources tab, choose Base Class Items.

14. Find subclass Service, choose AutoNumber PartServ321.
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15. Select the file created in Step 4,following the Import wizard and click Import.

16. Check the Import Log and objects imported.

Result: The AutoNumber PartServ321 is used on the second import.

20658334

Administration/Configuration

Issue: SMART RULES CONFIGURATION REPORT SHOWS SMARTRULE: 
DEMOTIONACKNOWLEDGERSREMOVAL

Root Cause: The Smart Rule, DEMOTIONACKNOWLEDGERSREMOVAL, does NOT 
exist in Java Client, but it appears in the report.

Resolution: Remove this SmartRule from report.

Verification:

1. Log in to Java Client.

2. Admin > System Settings > SmartRules The following SmartRules are shown: 
DemotionReviewersRemoval  Remove/Retain DemotionSignoffRemoval  
Remove/Retain.

3. Log in to Web Client.

4. Report > Standard Report > Administrator Report Run Smart Rules Configuration 
Report.

Result: The report output does not show 
SmartRule:DemotionAcknowledgersRemoval. 

20668264

SDK

Issue: HISTORY TAB IS TAKING LONG TIME TO SHOW PX ERROR MESSAGE

Root Cause: Change History cache doesn't refresh

when the user clicked force-refresh button in web

client.

Resolution: Correct the functionality.

Verification:

1. Create a new ECO.

2. Go to the Affected Items Tab.

3. Drag and drop an existing Item that has pending changes into this change.

Result: The PX shows a custom message on screen "Cannot add[Item Number01]as 
affected item onto this change since a pending change already exists."

4. Click on the History Tab. No information is logged about the PX that got executed.

Result: The History tab should get updated with the error message from the PX: 
"Cannot add[Item Number01]as affected item onto this change since a pending 
change already exists"
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20674212

Item & BOM

Issue: TREE NAVIGATION FAILS FOR DOCUMENT BOM EXPAND 

Root Cause: If there is a different column enabled/disabled in the BOM table for Part 
& Document classes the getCellValue from code throws an Out of Bounds exception.

Resolution: If the column index is -1, which means the attribute is disabled for the 
current class, we do not get the cell value from table.

Verification:

1. In Admin, enable Parts.Page2.Multilist01 and point to a dynamic list, and enable 
Parts.BOM.Item P2 Multilist01.

2. Enable Documents.Page2.Multilist01 and enable Documents.BOM.Item P2 
Multilist01.

3. Log in to Web Client.

4. Create Part01 with the following structure:

Part01

- Doc01

- - Doc02

5. Click the Navigator button on Part01.

6. From the left pane, expand the BOM of Doc01.

Result: The BOM of Doc01 is expanded.

20776859

Changes

Issue: CHANGE IS NOT GETTING CREATED IF THE ITEM NUMBER HAVING = 
SYMBOL

Root Cause: The warning string and code are parsed with "=" as delimiter. If the 
subject name contains "=" the problem occurs.

Resolution: For the warning string which contains more than one "=" we take the last 
"=" occurring as delimiter.

Verification:

1. Log in to Web Client.

2. Create a new Part named 15600-SA=.

3. Create a new Change from Part 15600-SA= as change C00222.

4. Go to15600-SA= > Actions menu > create new changes again.

Result: A warning message window appears saying Part 15600-SA= is already on 
pending changes: C00222.

5. Click Finish in the warning window.

Result: It works fine now without duplicated message windows popping up.
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20786892

Searches

Issue: HF298 IS CAUSING SAVED  PARAMETRIC SEARCHES TO FAIL WITH 
ERROR "0"

Root Cause: Caused by the fix of bug 19645466.

Resolution: If it cannot get class id, use base class id instead.

Verification:

1. Log in to Web Client as admin.

2. Do an Advanced Search: Items > Title Block.Name/Number/Description > 
Contains any phrase, click Prompt check box, run the search.

Result: Enter search value window displayed.

3. Enter Search Values: P001 in Prompt search window, then run the search.

Result: Parts that meet the search criteria are returned as results.

4. Save the search as s1, and input it under Global searches folder.

5. Run the saved search: s1.

Result: The saved search can be executed successfully without any errors.

20807051

Web Client

Issue: RENAMING MFR NAME ON GENERAL INFO PAGE CORRUPTS PART 
FAMILY

Root Cause: When changing the Manufacturer Name, the Manufacturer Name in the 
Parts tab of Part family does not get updated. When loading the Manufacturer Parts 
and searching the Manufacturer by the old Manufacturer Name, it throws an Object 
Does Not Exist error.

Resolution: If the user can not search the Manufacturer by the old Manufacturer 
Name when loading the Parts, set the same value from the Manufacturer Name of the 
Manufacturer Part object.

Verification:

1. Log in to Web Client as admin.

2. Create a Manufacturer, MF1.

3. Create a Manufacturer Part, MFP1, with MF1.

4. Create a Part Family, PF1, add Manufacturer Part, MFP1, to its Parts table.

5. Open MF1, change its name to be MF1-new name.

Result: MF1-new name is displayed in MFP1.GI.Manufacturer Name field

6. Return to the PF1.parts table.

Result: MFP1 with its related manufacture:MF1-new name is displayed correctly in 
the Parts table.

7. Use Save As to save PF1 to a new Part Family, then go back to open PF1.
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Result: PF1 can be opened successfully and its Parts table can be accessed 
successfully.

20809503

Folders, Files & Attachments

Issue: GET OF A FILE DOES NOT SHOW A PROGRESS

Root Cause: When downloading, there is no apparent message to indicate that the 
downloading action is in process.

Resolution: Added a  "Downloading file." message.

Verification:

1. Log in to Web Client.

2. Access a business object, navigate to the Attachments tab.

3. Add a single file, multiple files, and multiple files in a single file folder.

4. Select the single file or multiple files or multiple files in a single file folder and do 
the Get, Checkout, Open actions and verify the display of Downloading File 
message.

Result: The message Downloading file is displayed for Get, Checkout , Open 
actions on Attachments or Files tab of File Folder /Design.

20971437

Folders, Files & Attachments

Issue: MISSING FILE UTILITY FAILS WITH JAVA.SQL EXCEPTION

Root Cause: The missing file existed on more than one iFS which causes this issue. The 
location id is a string and cannot be converted to integer directly.

Resolution: Fixed the code considering case of location is more than one.

Verification:

1. Log in to Web Client or Java Client.

2. Access a BO, and navigate to the Attachments tab.

3. Add 10 files.

4. Delete the 3 files from the Agile Vault

5. Run MissingFilesLocator tool.

Result: The MissingFilesLocator tool report lists the missing files in the vault.

21051857

SDK

Issue: RUNNING SAVED SEARCH MANUALLY ON INACTIVE LIST VALUE 
RETURNS INCORRECT DATA.

Root Cause: SDK fails to get the correct multilist value from the server if the value is 
inactive.
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Resolution: Changed code to get the correct multilist value.

Verification:

1.  Log in to Web Client and create a search: Parts Object Search for Product Lines 
promote.

2. Save this search as MySearch.

3.  Create several parts (part1, part2, part3, part4, part5) and set product lines value 
as Pisces.

4. Log in to Java Client, open the list for Product Lines and set Pisces as inactive.

5. Execute the attached SDK code to run MySearch.

Result: The parts' product lines set as Pisces (part1, part2, part3, part4, part5) 
appeared in search results.

21142843

Standard Reports

Issue: CHANGE CYCLE TIME REPORT HAS DATE GAP OF 4 HOURS

Root Cause: Transfer of the status date 2 times caused the timing to be off.

Resolution: Correct the transfer.

Verification:

1. Log in to Web Client.

2. Go to the current user's preference, set Timezone to GMT+8, Preferred Date 
Format to "yyyy-MM-dd".

3. Create a new Change Order, change status to Released. Notice the Local Client 
Time is like  "2015-05-25 09:38:11 PM CST".

4. Run the Change Cycle Time Report against the new Change Order, status: from 
Pending to Released. Execute the report, check the result.

Result: There is no 4 hour gap. End Status Date is almost the same as local client 
time in Step 3.

21227091

Administration/Configuration

Issue: AGILE EVENT SCHEDULED TO RUN ONCE EVERY DAY AT 6AM DOES 
NOT GET TRIGGERED

Root Cause: When the Enable/Disable button is clicked, it does not update the extra 
column, Active, in the scheduled_event table for scheduled event type.

Resolution: Update this column when a scheduled event is enabled/disabled.

Verification:

1. Create a new Scheduled event (or update an existing) in Java Client, to run at a 
specific time.

2. Make sure to save the configuration for Event/Event Handler/Event Subscriber.
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3. Select the Event created (or modified) abnove, and Enable the evet by clicking on 
the "Enable" toggle button in the Events node.Please refer the screenshot, "01 
Enable Event.png".

4. Run the below SQL query in the database to observe the status of the Event.

Result: Select ID, Name, Owner, Description, active, action, to_char(created - 7/24, 
'dd-mon-yyyy hh24:mi:ss') "Created", to_char(last_upd - 7/24, 'dd-mon-yyyy 
hh24:mi:ss') "Last Updated" from scheduled_event where name = 'Schedule Event 
Task';

21239825

Item & BOM

Issue: UNABLE TO CREATE A NEW BOM ITEM ON WEB CLIENT WHEN 
ADDLIFECYCLEPH

Root Cause: There is a code defect if AddtoLifecyclePhaseOnBOMRule warning 
occurs when adding a newly created obj to BOM table. The system fails to delete the 
newly created obj if user does not have privilege.

Resolution: Corrected the code to avoid the delete action and retain the newly created 
object in the request to avoid the duplication error.

Verification: 

1. Log in to Java Client as admin.

2. Create Role CreateItem.

3. Assign the following privileges to this role.

Create Items

Discover Items

Modify Preliminary Items

Read Items

4. Create a User, user1, and assign role "CreateItem".

5. Make sure that user, user1, does not have Recycle Bin Search.

6. Go to Data Settings > Classes.

7. Set AddLifeCyclePhaseOnBOMRule to Warning for Items base class lifecycle 
phase Preliminary.

8. Log in to Web Client as user1.

9. Create new Part P1.

10. Go to the BOM tab.

11. Add > Create to Add, and create new Part. Message "Part <Part Number> 
Lifecycle Phase is Preliminary" pops up.

12. Click OK.

Result: The newly created Part is added to the BOM table. This also works for the 
RedlineBOM table. 

21304850
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Import

Issue: EXCEL IMPORT FORMAT DOES NOT SUPPORT FORMULAS

Root Cause: This issue was introduced when upgrading POI-3.0.1-Final to 
POI-3.5-Final in the Agile 9.3.1 release. The way to check whether a FormulaRecord 
has cached string value in the following StringRecord was changed in POI-3.5-Final.

Resolution: Use the new method FormulaRecord.hasCachedResultString() in 
POI-3.5-Final.

Verification:

1. Create an Excel file with formulas.

2. Log in to Web Client.

3. Launch Import wizard and select the Excel file with formulas.

4. Define the mapping for the attributes on Items Page Two, Page Three and BOM 
tables.

5. Open the Items imported and check the attributes' value.

Result: The Excel file with formulas is imported correctly.

21415410

Item & BOM

Issue: HISTORY TAB SHOWS NUMERIC ATTRIBUTE MODIFIED WHEN IT IS NOT 
ACTUALLY MODIFIED

Root Cause: Number has Scale, so the number in database may be different than the 
one shown in the UI, for example, scale a numeric field is 2, we enter a value 1.1256, 
1.1256 is stored in database, but in UI it is shown as 1.13, obviously if we compare 
1.1256 to 1.13, they are different, so before we compare the numbers with scale setting, 
we need to format them first.

Resolution: Format the numbers before comparing them.

Verification:

Precondition: enable Page2.Numeric attributes

1. Log in to Web Client.

2. Create Part1 and edit Part1.Page2.Numeric01 = 1.08368293.

3. Create ECO01 against Part1 and release it.

4. Open Part1 on the released rev and edit TitleBlock.Description and Save.

5. Check History information for the Modify action.

Result: Only the modified attribute is recorded in the History table (the numeric 
attributes that are not modified will not appear as modified).

21525295

Standard Reports

Issue: CANNOT RUN AGILE CLASSES REPORT IN FRENCH

Root Cause: Single quotes needs to be specially handled classes report selection page.
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Resolution: Specially handle single quotes in this page.

Verification:

1. Log in to Java Client, go to Admin > Preference > Language, enable French. 
Restart Agile Server.

2. Log in to Web Client with admin, go to My Settings > Preference, set Language to 
French.

3. Log off and log in as admin, go to find Agile Class Report(Spécifier un paramètre 
de classe Agile). Click Execute to run the report.

Result: The lower half of the page shows a multilist for class selection.

21661620

Changes

Issue: NOT GETTING POP UP WHEN FORGOT TO SAVE REDLINE CHANGES IN 
FULL DISPLAY MODE.

Root Cause: Missed unsaved change check while navigating via backward/forward 
arrow in full display mode.

Resolution: Added unsaved change check.

Verification:

1. Open an unrealeased Change Order with multiple Affected Items. 

2. Click on the Affected Items Tab, select an Affected Item row. 

3. In the Redline Table, click on the BOM Tab. 

4. Select a row in the BOM Table. 

5. Click on the Full Display Mode button. 

6. Try to modify any attribute, e.g. Qty. 

7. Without saving the changes, click on the Backward/Forward arrow button. 

Result: The following message is displayed: You did not save your changes. Are 
you sure you want to discard the changes on this page? 

21673303

Web Client

Issue: CANNOT CHANGE SCHEDULED START DATE TIME USING FIREFOX VIA 
CALENDER OPTION

Root Cause: N/A

Resolution: N/A

Verification:

1. Log in to Web Client using Firefox.

2. Create a new project, P1, and try to change the time in Schedule Start / Schedule 
End date fields by invoking that date field's calendar.

Result: The user is able to change the time in the calendar of Schedule Start/End 
date.
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22019877

Changes

Issue: AGILE 9.3.4 AUDIT STATUS REPORTS MORE WARNINGS/ERRORS THAN 
AGILE 9.3.2

Root Cause: There is a For loop defect in checking whether criteria is matched. When 
one or more rows match the criteria, it returns true for all rows.

Resolution: Fix the defect in related functions to correctly check whether criteria is 
matched.

Verification: 

1. Log in to Java Client as admin.

2. In Admin, enable Change Orders.Affected Items.Dispositions06.

3. Create criteria:

AllChangeOrdersAffectedItemsLifecyclePhaseInObsolete:

Affected Items.Lifecycle Phase In Items.Obsolete

4. Add the criteria to Pending status of Default Change Orders workflow, and set its 
Exit Required Fields = Change Orders.Affected Items.Disposition06.

5. Save.

6. Log in to WebClient as admin.

7.  Create ECO01 and set workflow: Default Change Orders.

8. Add two Affected Items, Part01 and Part02. Set Part01.Lifecycle Phase = Obsolete, 
and set another to Production.

9. Click Actions > Audit Status and check the audit result.

Result: On the Audit Status Results dialog, there is only missing required field for 
Part01 for ECO01.Affected Items.Disposition06.

Product Cost Management
19602316

Export

Issue: RFQ EXPORTS TO EXCEL FORMAT SEVEN DIGIT NUMBERS IN EXPONENT 
REPRESENTATION

Root Cause: We do not correctly handle integral numbers with 7 or more digits, and 
the last digit is zero, such as 10000000 or 20000000.

Resolution: Use a new approach to avoid this issue.

Verification:

1. Open an RFQ and go to Response Status tab.

2. In the Supplier Response Status section, select the row(s) of the non-Web supplier 
to whom the RFQ should be sent.

3. Make sure the response contains the data of an integral number with 7 digits or 
more than 7 digits and last digit is zero, such as 10000000 or 20000000.
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4. Click Export > Export (csv) or Export > Export (xls), depending on the file type 
you want to export (Microsoft Excel Workbook or CSV). 

5. Click the Save button to download the file.

6. Open the exported file and check the value.

Result: The value shows the correct format, such as 10000000 or 20000000.

20382822

Sourcing Project

Issue: VIEW LATEST CURRENCY RATE THROWS ERROR UNABLE TO SAVE 
YOUR CHANGES ON UPDATE

Root Cause: An error is thrown as one of the RFQs is in status closed if update 
currency rate in sp.

Resolution: The user is able to do updates even if a closed RFQs exists in a related 
sourcing project.

Verification:

1. Create a Sourcing Project, and add an Item.

2. Change the project to open, create an RFQ, and add a supplier.

3. Open an RFQ to a supplier, and get response from supplier.

4. Close the RFQ.

5. Go to the Analysis tab of the sourcing project, click More >View Latest Currency 
Rates

6.  Click the Update on View Conversion Rates window.

Result: The View Conversion Rates window is closed after the update. The prices 
in the Analysis tab are updated with the latest currency rate.

21203114

PCM/SDK

Issue: SDK RETRIEVE SOURCE PROJECT ITEMS BOM FIELD GIVES 
CLASSCASTEXCEPTION

Root Cause: The BOMTable cell is not set correctly if the 2nd (or more) root item is a 
component.

Resolution: Corrected the code to ensure a sampleChildTable is set to each root Item 
no matter if it is an assembly or component.

Verification:

1. Create a Sourcing Project and add one Item to the Item list. Run the attached 
program against that Sourcing Project and it works.

2. Add a second Item to the Item list, then run the attached program.

Result: The code also executed without error.

21475638
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Administration/Configuration

Issue: VISIBLE PROPERTY IS NOT SHOWN IN ATTR:RESPNUMBER6 OF 
SOURCING PROJECTS ANALYSIS

Root Cause: Meta data for this attribute is wrong.

Resolution: Correct the meta data.

Verification:

1. Log in to Java Client.

2. Admin > Data Settings > Classes.

3. Open Sourcing Projects class.

4. User Interface Tabs > Analysis > Attributes: Analysis.

5. Open resp Number 6, select the Visible property.

Result: The property, Visible, is shown next to the Description property. The 
default value is No. The user can modify it to Yes.

21686769

PCM SDK

Issue: UNABLE TO INVOKE "PRICE.SAVEAS" WITHOUT PROGRAM PARAMETER 
USING SDK

Root Cause: Code defect of not handling null value of program attribute of Price 
object while doing Save As via SDK.

Resolution: Handled null value of Program attribute of Price object while doing Save 
As via SDK.

Verification:

1. Create a price object by following code:

IPrice price = (IPrice)sc.session.getObject(IPrice.OBJECT_TYPE,

"CONTRACT00001");

IAgileClass subclass = price.getAgileClass();

IAutoNumber[] numSources = subclass.getAutoNumberSources();

String nextNumber = numSources[0].getNextNumber();

ISupplier supplier = (ISupplier)sc.session.getObject(ISupplier.OBJECT_TYPE, 
"SUP-00003");

Map params = new HashMap();

params.put(PriceConstants.ATT_GENERAL_INFORMATION_NUMBER, 
nextNumber);

params.put(PriceConstants.ATT_GENERAL_INFORMATION_SUPPLIER, 
supplier);

params.put(PriceConstants.ATT_GENERAL_INFORMATION_ITEM_NUMBER, 
"2075700");

params.put(PriceConstants.ATT_GENERAL_INFORMATION_ITEM_REV, 
"CO-00035");
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price.saveAs(price.getAgileClass(), params);

Result: New price object is created successfully.

Product Governance & Compliance
19309406

Administration/Configuration

Issue: NEW SPECIFICATION SUBCLASS EXEMPTIONS COVER PAGE DYNAMIC 
LIST NOT WORKING

Root Cause: The business logic of active exempt checking has a defect if the 
exemptions list is a dynamic list.

Resolution: Improved the logic to support exempt checking for dynamic list.

Verification:

1. Log in to Java Client as admin.

2. Create a subclass: Exemption under Specifications.

3. Create a criteria, CR1, based on subclass Exemption.

4. Create a dynamic list, DL001, with criteria, CR1.

5. Go to Classes > Specifications > General Info tab, open attribute, Exemption, set it 
point to DL001.

6. Go to Classes > Substance Declarations > Manufacturer Parts, open attribute 
Exemption, set it point to DL001.

7. Log in to Web Client as admin.

8. Create several specifications with Exemption type: ex1,ex2 and ex3.

9. Create a specification, sp001, and select ex1 and ex2 for sp001.GI.Exemption.

10. Create a substance declaration, MD001, with sp001, then add a Manufacturer Part, 
mfp001, to its MPN table. Try to select a value, ex1 for mfp001.exemption, and 
Save.

Result: The user can select value successfully.

Product Portfolio Management
17662656

Administration/Configuration

Issue: DISCUSSIONS - REPLY CREATE NOTIFICATION DOES NOT HAVE [ALL 
RECIPIENTS] DATA TAG

Root Cause: This issue is because NotificationInitiator.java code does not handle the 
recipients for creation event. The recipients cannot receive the notification, even if the 
event has executed successfully.

Resolution: Add the recipients handle code for creation event in 
NotificationInitiator.java.

Verification:

1. Log in to Java Client.

2. Enable discussion - discussion Create.
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3. Notification - Disable default "Discussions - Reply Create Notification".

4. Create a new discussion from the default by using Save As. The TO field is 
$NOTIFY.

5. Create Event - Create an object with Discussion subclass root level.

6. Configure Event Subscribers by using the custom notification from Step 1 and the 
new Event in step 2.

7. Log in to Web Client as admin (or a user).

8. Create a discussion and add 2 users (A & B) in the Notify List and save it. Note: 
The newly created discussion history does not show that users have been notified.

9. Log in as user A and B to check the Home page Notification tab.

Result: Both users received the newly created Discussion in step 1.

19633882

Web Client

Issue: UNABLE TO REMOVE CANCELLED CHANGE FROM CONTENT TAB OF 
THE TASK

Root Cause: The check status list should specially handle the PPM object when there is 
an update content.

Resolution: Add special handler for PPM content when updating content.

Verification:

1. Log in to Web Client.

2. Create a Program with a Task and Gate as a child activity.

3. In the Content tab of Task, add a Change.

4. Change the status of the Change to cancelled.

5. Remove the cancelled Change from the Content tab of the task.

Result: The user is able to remove the cancelled Change from the Content tab of the 
task.

20084674

Web Client

Issue: SCHEDULE END DATE IS NOT EDITABLE ON OBJECT PROPERTIES 
WINDOW WHEN PROJECT IS OPENED IN GANTT CHART

Root Cause: When disable the Attribute-ACTIVITY.DURATION_TYPE, it will null 
point exception, as cannot get the value of ACTIVITY.DURATION_TYPE.

Resolution: Handle the null point exception.

Verification:

1. Disable ACTIVITY.DURATION_TYPE and ACTIVITY.DAYS_EFFORT for 
Activities in Java Client.

2. Launch Gantt chart for a Project having child objects.
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3. Open a Project's child, for example, Task2, in Gantt chart and edit the Scheduled 
End date field in the fProject Information window.

Result: The user can successfully edit and save changes in Schedule End date and 
any other attributes in General Info tab of Task/Phase/Program (with no errors).

20578829

Java Client

Issue: AGILE 9.3.0.2 JAVA CLIENT UNABLE TO LAUNCH THE APPLICATION 
ERROR SINCE JAVA 7 UP

Root Cause: JRE new security enhancement

Resolution: Add all-permissions attribute in META-INFO

Verification: N/A

20922228

Folders, Files & Attachments

Issue: 'ADD TO TABLE' PRIVILEGE NOT WORKING WITH ACTIVITY AND FILE 
FOLDER OBJECTS

Root Cause: This is caused by a code defect. The Project object is not taken into 
consideration for this case.

Resolution: Include the Project object in this case.

Verification:

1. Log in to Java Client.

2. Go to Add to Table privilege - Add to Table Items and Add to Table Changes.

3. Create 2 more privileges. Add to Table File Folders and Add to Table Activity with 
criteria as "All File Folders" and "All Activities".

4. Create Modify privilege for Item, Change Order, Activity and File Folder with the 
Applied To field empty.

5. Assign the Add to Table privilege and the Modify Privilege to user User12.

6. User12 has only Discover/Read privilege on Changes, Items, File Folders and 
Activity - no other privileges.

7. Log in as user12.

8. Search and open an Item and navigate to the Attachments tab.

9. Enable the Add button.

10. Add Text file.

11.  Try the same with a Change Order and Project.

Result: The user is able to add files in the Attachments table of all the objects.

Product Quality Management
21079203
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Web Client

Issue: JAVA CLIENT DOES NOT SHOW HAS QUALITY ISSUES INDICATOR WHEN 
QCR IS ATTACHED

Root Cause: Java Client honors the PSR, but does not honor QCR case, so QCR case 
does work fine.

Resolution: Improved the logic to support exempt checking for dynamic list.

Verification:

1. Log in to Java Client as admin.

2. Create a subclass: Exemption under Specifications.

3. Create a criteria, CR1, based on subclass Exemption.

4. Create a dynamic list, DL001, with criteria, CR1.

5. Go to Classes > Specifications > General Info tab, open attribute, Exemption, set it 
point to DL001.

6. Go to Classes > Substance Declarations > Manufacturer Parts, open attribute 
Exemption, set it point to DL001.

7. Log in to Web Client as admin.

8. Create several specifications with Exemption type: ex1,ex2 and ex3.

9. Create a specification, sp001, and select ex1 and ex2 for sp001.GI.Exemption.

10. Create a substance declaration, MD001, with sp001, then add a Manufacturer Part, 
mfp001, to its MPN table. Try to select a value, ex1 for mfp001.exemption, and 
Save.

Result: The user can select value successfully.

Agile PLM Framework
13071753

Software Development Kit

Issue: THE SYNTAX FOR IPRICE.SAVEAS() DOES NOT WORKAS DESCRIBED IN 
SDK GUIDE

Root Cause: code defect of not handling null value of program attribute of Price object 
while doing Save As via SDK.

Resolution: Handled null value of program attribute of Price object while doing save 
as via SDK.

Verification: Create a price object by following code:

IPrice price = (IPrice)sc.session.getObject(IPrice.OBJECT_TYPE, "CONTRACT00001");

IAgileClass subclass = price.getAgileClass();

IAutoNumber[] numSources = subclass.getAutoNumberSources();

String nextNumber = numSources[0].getNextNumber();

ISupplier supplier = (ISupplier)sc.session.getObject(ISupplier.OBJECT_
TYPE,"SUP-00003");

Map params = new HashMap();
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params.put(PriceConstants.ATT_GENERAL_INFORMATION_NUMBER, 
nextNumber);

params.put(PriceConstants.ATT_GENERAL_INFORMATION_SUPPLIER, supplier);

params.put(PriceConstants.ATT_GENERAL_INFORMATION_ITEM_NUMBER, 
"2075700");

params.put(PriceConstants.ATT_GENERAL_INFORMATION_ITEM_REV, 
"CO-00035");

price.saveAs(price.getAgileClass(), params);

Result: The new Price object is created successfully.

13617191

Folders, Files, & Attachments

Issue: OPENED ZIP FILE ATTACHMENT DOES NOT SHOW LIST OF FILES AFTER 
FIRST TIME

Root Cause: When the user opens one file in ZIP, the system creates a CMF file and 
maps to the ZIP file.

Resolution: Skip the creation of the CMF for the ZIP file.

Verification:

1. Log in to Web Client.

2. Upload the zip file to admin's user record Attachments tab.

3. Select the zip file and click on View, or click on File Name link so that the AutoVue 
Main Window displays the File list contained in the zip file.

4. Click on a filename in the list of zip files in AutoVue, so that the secondary 
AutoVue window displays.

5. Close all of the AutoVue windows and log out and log in.

6. Select the zip file and click on View or click on File Name link.

Results: The AutoVue main window displays the zip file containing the file list.

17446509

Web Client

Issue: UNABLE TO SAVE AS PERSONAL SEARCH ONCE SEARCH DEFENITION IS 
MODIFIED

Root Cause: N/A

Resolution: N/A

Verification:

1. Log in to Web Client as admin.

2. Do an Advanced Search: Items > Parts > Title Block.Description > Is Not Null, 
save it as s1 and put it into Personal Searches.

3. Run the saved search, S1, then edit the search criteria to: Items > Parts > Title 
Block.Description > start with > test, run the search.
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Result: Parts that have a description that starts with "test" are returned in search 
results.

4. Try to save as updated search.

Result: The Save As button is enabled and the updated search can be saved to a 
new one successfully.

17777333

Event Java PX

Issue: SEARCH RETURNS INCONSISTENT RESULTS AND FILTERING BY 
SUBCLASS DOES NOT WORK

Root Cause: Bug in code: The code does not take the current rev and Site object 
information when opening files in Object Attachment tab, QuickView, Affected Item, 
and Redline Attachment tabs.

Resolution: Code fixed by taking the current rev and site information while 
performing the Open action.

Verification: 

1. Set up the custom PX in Java Client and drop the custom jar to /sdk/extensions/ 
setup Event Handler for the PX.

2. Create a new Event - Get File for Items.

3. Create Event Subscriber for new Event Handler and Get File event.

4. Set Event Subscriber to Pre trigger type and Execution Mode = Synchronous.

5. Log in to Web Client to create a Part with an attachment and release on a Change.

6. Navigate to the Part to get file from the Attachments tab Part's history log correct 
PX info: item xxx has associated iChange object Cxxx.

7. Click the change again.

8. Highlight the Part from the Recently Visited section and click the Quick view to 
the Part to Get file again.

9. Refresh the UI and check the Part's History tab.

Result: item xxx has associated iChange object Cxxx.

17876092

Admin Config Propagation

Issue: REQUIRED SET BACK TO ALLOWED IN CHANGE ORDER WF COMMENTS 
ATTRIBUTE

Root Cause: We do not support this attributes in 932.

Resolution: Update attribute commentForApprove and commentForReject when 
doing import workflow.

Verification:

1. Log in to Java Client of source instance.

2. Create a new workflow, Test-WF, with status CCB.
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3. Go to the Status tab.

4. Open the property of CCB status. Ensure that the Comments for Approval 
attribute and Comments for Rejection attributes are set to Required.

5. Configure config.xml to include the following workflow:

<copy>

<workflow>

<include>

<pattern>Test-WF</pattern>

</include>

</workflow>

</copy>

6. Run acp export source.

7. Run acp import source target.

8. Log in to Java Client of the target instance.

9. Ensure that the Test-WF workflow is imported.

10. Open the CCB status property.

Result: The value for attributes Comments for Approval and Comments for 
Rejection is set to Required.

18045943

User/User Group

Issue: UNABLE TO ADD USERS IN USER GROUPS WHICH HAVE PARENTHESES 

Root Cause: N/A

Resolution: N/A

Verification:

1. Log in to Web Client as admin.

2. Create a new user: testsri(sr).

3. Open any User Groups, such as ug001, and go to its Users table.

4. Click Add, and try to add testsri(sr) to the Users table.

Results: A user with parentheses in the name, testsri(sr), can be added to the Users 
table successfully.

18087905

Searches

Issue: WEB CLIENT SHOWS INCORRECT SORT ORDER FOR OBJECT TYPE 
COLUMN IN QUICK SEARCH

Root Cause: The column, Object Type, was not sorted by dictionary order of its text 
display. 
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Resolution: Sort it by dictionary order.

Verification:

1. Log in to Web Client as admin.

2. Do a quick search: All > *.

Result: All objects can be searched out.

3. Click the column header of the Object Type to sort search results.

Result: All objects are sorted by object type in Ascending order.

4. Click the column header of the Object Type again

Result: All objects are sorted by object type in Descending order.

18145784

Web Client

Issue: ERROR IN THE FRENCH TRANSLATION

Root Cause: Translation issue.

Resolution: Provide new translations.

Verification:

1.  Log in to Web Client with user in French.

2. Create a Part, P00022, and add mfrs with MFR_001.

3. Create an ECO, C00017, for P00022.

4. Go to the Affected items of C00017. Select P00022.

5. Go to the Manufactures tab and Select Manufacturer Item from the row MFR_001.

6.  Select Undo redline.

Result: The user gets a popup message to confirm Undo Redlines. The undo button 
value is translated into the Défaire.

18146283

Java Client

Issue: $USER IS NOT AVAILABLE AS LIST VALUE FOR ADVANCED SEARCH FO 
CHANGES JAVA CLIENT 

Root Cause: This is an enhancement.

Resolution: N/A

Verification:

1. Log in to Java Client and navigate to Admin ; System Settings ; Dashboard 
Management.

2. Create a New Tab and add a Table with advance search having criteria "Change 
with Cover Page.Change Analyst In $USER"

Result: $USER value should display in MultiList attributes while configuring 
Dashboard tabs.
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18366643

Admin Config Propagation

Issue: OLD CONFIGURATION IS PROPAGATED INSTEAD OF CHANGED ONE 

Root Cause: This is a specific AI tab attribute issue. For this case, when the object id is 
the same and the class id is different, it picks up the incorrect criteria value.

Resolution: Compare the class id when exporting criteria with AI attributes.

Verification:

1. Log in to Java Client as admin.

2. Open the criteria Commodity Prelim_Proto(CUP).

3. Make sure that the criteria has Affected Items.Source System In [Parts]AGILE as 
one of the criterias.

4. ACP export this criteria.

5. Check the .agl file that is created.

Result: The .agl file contains the [Parts]AGILE attributes.

18491062

Folders, Files, & Attachments

Issue: 'INFORMATION ONLY' DISPLAYED AS 'AWAITING APPROVAL' ON HOME 
SCREEN

Root Cause: The Workflow Routing tab did not cover this case

Resolution:  Special handle for "All File Folders That I Am An Approver Of"

Verification:

1. Log in to Web Client.

2. Create a File Folder object.

3. Add a file attachment and check in the file attachment.

4. Select a Routing Slip tab.

5. Add Approver "user1" and Observer "admin" The Routing Slip tab shows 
Reviewer: Admin with Action "Information Only" Reviewer: user1 with Action 
"Awaiting Approval".

6. Log in as Observer "admin".

Result: The Workflow Routing tab of the Observer shows "Information Only".

18597947

Averify Issues

Issue: AGIL-00025060 CHECK ON AGILE 933 VERSION OR ABOVE

Root Cause: Test case does NOT cover all the situations.

Resolution: Modify test cases to cover all the situations.
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Verification:

Case 1: 

1. Import 935 demo DB.

2. Run "select change_history_id_seq.nextval from dual;" to check the next sequence 
id.

3. Insert data into the change_history table. The data's id is smaller than the next 
sequence id from step 2.

4. Run Averify on this user.

Result: There is no AGIL-00025060 related issues reported in oracle_averify_
report.log.

Case 2: 

1. Import 935 demo DB. 

2. Run "select change_history_id_seq.nextval from dual;" to check the next sequence 
id.

3. Insert data into change_history table. The data's id is larger than the next sequence 
id from step 2.

4. Run Averify on this user.

Result: AGIL-00025060 related issue such as "AGIL-00025060 : C : CHANGE_
HISTORY table has bad data (Table ID:-2099999000 is greater than the Sequence ID 
-2099999960)" reported in oracle_averify_report.log

18676633

Export

Issue: UNABLE TO EXPORT AN ITEM

Root Cause: We need a special handler for BOM Items without object IDs.

Resolution: Added special handler for Items without object IDs.

Verification:

1. Create Parts P00001, P00002.

2. Add a non-existent Part number, P00003, to the BOM tab of P00001.

3. Add P00002 to the BOM tab of P00001.

4. Add a blank row to the BOM of P00001.

5. Create an ECO, C00001, on P00001.

6. Release the ECO at rev A.

7. Export the Part at 'A C00001' revision to all the formats (aXML,PDX,csv,xls).

Result: The export functions properly without any null pointer exceptions. The 
blank row is exported with default data (Qty, Find Num...) as well.

18842149

Software Development Kit
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Issue: HOW TO USE SDK TO GET DATA BY 

Root Cause: The SDK query criteria "[CoverPage.Status] In 
('$STATUSTYPE.RELEASED'" is not properly built into SQL condition 9224 release.

Resolution: This issue has been fixed by Search Server side code change in latest 
release.

In 9224, the generated SQL for the SDK query condition is: ((CHANGE_P2P3.STATUS 
= '-17')))). In 934 or latest 935, the generate SQL for the SDK query condition is: 
((((CHANGE_P2P3.STATUSTYPE) IN ('3'))))))

Verification: 

1. Create an Advanced Search for ECO.

2. Set Search Criteria "Change Type" and "Status" as promote .

3. Execute the following SDK code:

String strFolderPath = "/Personal Searches";

String strCriteriaName = "testWS_forAllChange";

ArrayList arrList = new ArrayList();

arrList.add("ECO");

arrList.add("$STATUSTYPE.RELEASED");

IFolder searchFolder = (IFolder)session.getObject(IFolder.OBJECT_
TYPE,strFolderPath);

IAgileObject agileObject = searchFolder.getChild(strCriteriaName);

IQuery query = (IQuery)agileObject;

Object[] objParams = new Object[arrList.size()];

for(int i=0; i<arrList.size(); i++)

objParams[i] = arrList.get(i);

query.setParams(objParams);

ITable queryTable =  query.execute();

4. Check the Search results.

Result: The search result is correct.

18999047

SDK Import & Export

Issue: PLM ERROR 60086 - CREATING ORF SUB REQUEST FOR ORF THAT 
CONTAINS HYPERLINKS

Root Cause: When creating a user, the application does not use the selected currency 
as the default valURL file is not a real file stored in File Server. When the File Server 
WS API is called to replicate a non-real file it encounters an exception.

Resolution: If the attachment file type is a URL, then do not call the File Server WS 
API to replicate attachment.

Verification: 

1. Create a Part named Part1.
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2. Attach URL address to Part1's attachment.

3. Create a Part named Part2.

4. Execute the SDK code:

IItem sourceItem = (IItem) session.getObject(ItemConstants.CLASS_PART, 
"Part1");

IItem destItem = (IItem) session.getObject(ItemConstants.CLASS_PART, "Part2");

ITable oldBTAttachmentsTab = sourceItem.getTable(ItemConstants.TABLE_
ATTACHMENTS);

ITable attachmentsTab = destItem.getTable(ItemConstants.TABLE_
ATTACHMENTS);

Iterator oldBTAttachmentsItr = oldBTAttachmentsTab.iterator();

Map params = new HashMap();

while (oldBTAttachmentsItr.hasNext()) {

IRow attachment1 = (IRow)

oldBTAttachmentsItr.next();

params.clear();

params.put(CommonConstants.ATT_ATTACHMENTS_CONTENT, attachment1);

params.put(CommonConstants.MAKE_DEEP_COPY,Boolean.TRUE);

IRow attachment2 = (IRow)attachmentsTab.createRow(params);

}

19064118

Administration/Configuration

Issue: SDK QUERY ORA-01722 DUE TO INCORRECT CREATE FROM TEMPLATE 
ATTRIBUTE TYPE

Root Cause: Need to resolve String To Ids for the attribute Created From Template.

Resolution: Resolve String To Ids for attribute Created From Template.

Verification: Execute query with [General Info.Created From Template] successfully:

For example:

IQuery query = (IQuery)session.createObject(IQuery.OBJECT_TYPE,

"SELECT " +"[General Info.Division],[General Info.Root Parent], "

+"[General Info.Owner],[General Info.Name], "

+"[General Info.Description],[General Info.Status], "

+"[General Info.Schedule Status],[General Info.Workflow], "

+"[General Info.Type] "

+"FROM " +"[Projects] "

+"WHERE " + "( [General Info.Created From Template] == 'HOT - Phase II NPD 
Template - CORE 2013' ) "
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+"AND " +"( [General Info.Division] == 'Belson') "

+"ORDER BY " +"1, 4, 3" );

19080100

Averify Issues

Issue: DUPLICATE AFFECTED ITEMS ADDED TO A CHANGE

Root Cause: AGIL-00075102.sql is added, you could use delete from rev where id not 
in (select min(id) from rev group by item, change, site).

Resolution: The fix script has been included in AGIL-00075102.sql changed file 
AGIL-00075102.sql.

Verification:

1. Create a Part and add several sites to this Part.

2. Create an MCO, add this Part into the Affected Items tab of the MCO.

3. Log in to sqlplus as an agile db user, insert bad data with the following SQL 
statement: insert into rev(id, item, change, site) values($ID,$item_id,$change_id, 
$site_id); make $site_id is duplicated with existed one in the part.Define Query > 
Advanced Search Items > Parts Attribute >Title Block Number, equal to P001 
>Finish.

4. Run Averify against the database.

Result: The Averify Report logs the following error message. AGIL-00075102 : E : 
REV table has bad data (find duplicate site $site_id in table rev for item $item_id 
in change. )

19263708

Admin Config Propagation

Issue: ACP RESULTS IN ERRORS WHEN TRANSFERRING XSLT TEMPLATE FOR 
ACS FORMAT LIBRARY SAP CHANGECAST 

Root Cause: This is an ACS Format Library import issue. We do not clean the template 
data before processing the next object. It causes a null pointer error.

Resolution: Clean the template data before processing th enext library object.

Verification:

1. Configure the config.xml file as follows: 

<copy> 

<acs_format_library/> 

</copy>

2. Execute acp export:acp export golden.

3. ACP import source to target: acp import golden dev

Result: ACP propagates the ACS Format Library successfully.

19597534



Agile PLM Framework

3-44 Agile Product Lifecycle Management Readme

Folders, Files & Attachments

Issue: FILE ADD - DRAG AND DROP OF XML FILE DOES NOT WORK

Root Cause: Drag & Drop is not supported well in IE10 and Firefox in Agile.

Resolution: Fixed code to handle for IE10 and Firefox.

Verification:

1. Log in to Web Client.

2. Access an ECO.

3. Navigate to the Attachments tab.

4. Click on Add > File so that file upload selector is displayed.

5. Drag and drop an XML file to the file upload selector.

Result: The user is able to drag and drop an XML file to the file upload selector and 
upload the file successfully.

19641654

Software Development

Issue: IPROPERTY.GETVALUE DOESN'T RETRIEVE BASE CLASS OBJECT TYPE

Root Cause: The base class object type of filter is not returned from the server Admin 
interface.

Resolution: Added special handling code for the Base class object type at SDK level.

Verification:

1. Log in to Java Client, Admin > System Settings > Agile Content Service > Filters.

2. Create yo-test-filter1 with object Changes (Base Class).

3. Compile testmain.java and run it.

4. Check output of SDK.

Result: If the object type for filter is base class, the object type gets correctly.

19651886

Web Services

Issue: ADMINMETADATA.GETTABLEMETADATA WS INCORRECTLY REPORTS 
FIELD AS INTEGER

Root Cause: This is a metadata issue.

Resolution: Run the script to correct the type. Update propertytable set value=3 where 
parentid=2000000100 and PROPERTYID = 2; Commit;

Verification:

1. Create a Project. Perform an AdminMetaData WS operation.

2. Verify that Actual Time (In Days) data type is double.

Result: Actual Time (In Days) data type is double.
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19724751

Standard Reports

Issue: NO SPACE BETWEEN REV AND CHANGE NUMBER IN WHERE USED 
REPORT WITH MS EXCEL 2010

Root Cause: MS Excel 2010 can not parse space symbol '&nbsp;' but '&#160;'.

Resolution: Special handler for type .xls.

Verification:

1. Log in to Web Client, run the Where Used Report.

2. Specify Excel format.

3. Specify an Item, which is in an assembly's BOM and released by an ECO.

4. Run the Where Used Report for Level 1 BOM items.

5.  Check outputted Excel file with Microsoft Office Excel 2010 and Notepad++.

Result: In Excel, there are spaces between Revision and ECO number, like C 24433. 
In Notepad++, the spaces are shown as &#160.

19819184

Searches

Issue: ITEM SEARCH RESULTS ARE NOT SORTED BY ITEM TYPE

Root Cause: Currently, we only support sorting in the database by the sqlorder clause. 
Some attributes are stored in the DB with id, and for these attributes, it does not make 
sense to sort by id. They should be sorted by their values.

Resolution: Added sorting process in memory for list and multi-list type data.

Verification:

1. Log in to Web Client as admin.

2. Do an Advanced Search: Items > ClickFormat > Sort result by Attribute: Item 
Type(Title Block) in  Ascending Sort Order, run the search.

Result: Search results are sorted by Item Type in ascending order correctly.

19842717

Averify Issues

Issue: INCLUDE 18603331 INTO AVERIFYL

Root Cause: No case to handle the situation.

Resolution: Add a new case AGIL-00075103 to handle the situation.

Verification:

1. On Agile 935 database, create bad data by below SQLs.

select id from page_two where class in (6159,6367);

insert into attachment(id, attachment_number, class) values (112,'AverifyP2Test2', 
6367);
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--Make sure the id not exist in page_two.

select id from page_three where class in (6159,6367);

insert into attachment(id, attachment_number, class) values (113,'AverifyP3Test1', 
6159);

--Make sure the id not exist in page_three commit.

2. Run Averify 1.7.7 against this db user with the following options.

i. averify.runOption=all

ii. averify.runOption=modules averify.modules=pcpqm

iii. averify.runOption=testcases averify.testcases=AGIL-00075103

3. Check Averify log and report.

Result: It shows BUILD SUCCESSFUL in Averify.log. There are no errors in the log. 
The following error messages are reported in oracle_averify_report.log.

AGIL-00075103 : E : PAGE_TWO table has bad data (Missing Default row for class 
(6159,6367).)

AGIL-00075103 : E : PAGE_THREE table has bad data (Missing Default row for 
class (6159,6367).)

19866821

Web Client

Issue: LABELS OVERLAPPING WHEN TWO COLUMNS DISPLAY ENABLED

Root Cause: Long words are not wrapped, so content is overlapped.

Resolution: Break the long words with CSS:

word-break: break-all;

word-wrap: break-word;

Verification:

1. Log in to Java Client. Go to the Preferences and set MultiColumn Display = Two 
Columns.

2.  Click Save.

3. Go to Classes > Change Orders > User Interface Tabs > Cover page.

4. Edit the attribute name with long words: Change Orders.Cover Page.Description 
of Change to "Description of Changeeeeeeeeeeeeeeeeeeeeeeee"

5. Click Save. 

6. Log in to Web Client.

7. Create an ECO.

8. In Edit mode, check the labels displaying of Description of 
Changeeeeeeeeeeeeeeeeeeeeeeee.

Result: The names are automatically shifted different rows ahead of the name 
fields.
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19893735

Web Services

Issue: HOW TO CHANGE STATUS OF DECLARATION VIA WEB SERVICE

Root Cause: In the PG&C module, a Declaration is a routable object that has a 
workflow. Since Web Services do not consider it as routable object, the error like 
"MDXXX is not routable" is thrown when GetStatus is invoked.

Resolution: A Declaration should be also a routable object. Need to implement 
routable interface.

Verification:

1. Create a Declaration.

2. Add Workflow to the Declaration object.

3. Execute Change Status WS method.

4. Verify that Status should be changed for Declaration successfully through WS.

Result: Status for Declaration is changed successfully through WS.

19907103

Searches

Issue: ERROR WHEN TRYING TO INCLUDE VERSION LABEL IN RELATIONSHIPS 
SEARCH FORMAT

Root Cause: File folders attributes with VERSION.*attributes (base id 20000####) were 
not handled when building select and from list

Resolution: Handle additional VERSION.* attributes

Verification:

1. Grant read/modify privilege on File Folders.Title Block.Label in Java Client.

2. Log in to Web Client as admin.

3. Create a Part, P001, and add a file folder (with label values of 123) into the p001 
Relationships tab.

4. Go to the Advance Search field and do the following search: Items > Parts > 
Relationships Search >> File folders.

5. Open Format, Move File folders.TitleBlock.Label to Displayed Fields.

6. Click the Apply button.

Result: P001 is returned successfully and the label value shows 123.

19908850

Process Extension

Issue: USER.HASPRIVILEGE(USERCONSTANTS.PRIV_DISCOVER, OBJECT) 
PROVIDES WRONG RESULT WHE

Root Cause: Currently, the system gets the user context of PX role by default, even if 
the login user role is wanted.
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Resolution: Added a new API to get the correct user context of a specific role for both 
PX role and login user role.

Verification: 

Process Extension:

1. Make sure the login user has Modify Part Privilege.

2. Create a Custom PX: 

Internal Custom Action = <check the user privilege using the IUser.hasPrivilege() 
method>;

Initiate From = Action Menu;

Roles = Role_CCB37 (this role does not have Modify Part privilege);

3. Trigger the custom PX from Action Menu of Part object.

Expected Result: Since the original user has Modify Part privilege and the assigned 
PX role does not have Modify Part privilege, it should return the following:

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part) = false;

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part, true) = true;

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part, false) = false;

Event:

1. Make sure the login user dones't have Modify Part Privilege.

2. Create a Event handler:

Event Action = <check the user privilege using the IUser.hasPrivilege() method>;

Roles = Role_CCB37 (this role has Modify Part privilege);

3. Configure Event:

Event Type = Create Object;

Object Type = Item;

Event Handler = <Event handler in step 2>;

Trigger Type = Post;

Execution Mode = Synchronous;

Error Handing Rule = Continue;

4. Create a Part to trigger the Event.

5. Check the Event Monitor.

Expected Result: Since the original user does not have Modify Part privilege and the 
assigned PX role has Modify Part privilege, it should return:

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part) = true;

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part, true) = false;

user.hasPrivilege(UserConstants.PRIV_PRIV_MODIFY, part, false) = true;

19915218

Import
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Issue: IMPORT WITH NO DISCOVERY PRIVILEGE, GIVES A SUCCESS UPDATE 
MESSAGE

Root Cause: The issue is caused by a privilege error.

Resolution: Use && instead of || between Discovery privilege and Read privilege. 
affect area: import;

Verification:

1. Create a source file as follows: 

Number    Desc             P2.Text02

KP00001    Part Desc     Test0234

2. Log in to Java Client as admin.

3. Create a criteria, cri001: Items.Title Block.Number Starts With KP.

4. Create a role with modify and read Privilege for Items using above criteria.

5. Assign this Role along with Import Privilege to a user intg001.

6. Create an Item KP00001, set Text02 = test.

7. Log in to Web Client as the user intg001.

8. Import the source file to update the attribute Parts.Page Two.Text02.

Result: It displays the result "Items 0(1 rejected,0 ignored)" and the message 
"Insufficient privilege" in the import log.

20002799

Web Client

Issue: UPDATED/NEWLY ENTERED VALUES ARE NOT SAVED WHEN 
CREATING AN ECO USING SAVE AS OF

Root Cause: This is caused by Bug 8996384 - FIELD ON CHANGE UPDATED FROM 
POST JAVA EVENT HANDLER RESET WHEN USING VALIDATE.

Resolution: 9951460: ALL CREATE NEW REQUIRED FIELDS DELETED IF YOU 
MISS JUST ONE.

Verification:

Precondition: ECO description and reason for change attributes are required

Steps: 

1.  Create a Part, p01, and add an attachment.

2. Create an ECO, c001, against p01 with new values and/or update values of the 
ECO’s Description, Reason for Change and other attributes.

Example: The ECO’s Description value is ECO on the Part with attachment 
V0Reason for change value is ECO on the Part with attachment V0.

3. Go to the C001’s Action menu > click Save As.

4. Create a new change and input the new value in the ECO’s description and 
Reason for change like" ECO on the part with attachment V1.0".

Result: A pop-up window appears that asks if you want to proceed with 
attachments or proceed without attachments.
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5. Select Proceed with attachments.

6. Click Save.

7. ECO created successfully: C002.

Result: C0002 was saved with Description and Reason for change with "ECO on 
the part with attachment V1.0".

8. Open c001, and re-save as  c001 to c0003.

9. Input the new value on ECO description and Reason for change as in "ECO on the 
part with attachment V2.0".

Result: The same pop-up window appears with the attachment message: select 
proceed without attachments.

10. Click Save.

Result: Check C003 with Description and Reason for change with "ECO on the part 
with attachment V2.0""

20046518

Searches

Issue: AGILE 9.3.3 EXPORT DOES NOT CREATE NEW WORKSHEET IN EXCEL 
FOR ROWS > 65536

Root Cause: Microsoft Excel 2003 can not support more than 65,536 rows. When the 
customer export file includes more than 65536 rows, Web Client shows an error 
message.

Resolution: If a customer exports a file that includes more than 65,536 rows, the server 
creates more sheets in one Excel file, the remainder of records are written in the next 
sheet.

Verification:

1. Log in to Web Client as admin.

2. Import more than 65536 new Parts into the system.

3. Do a basic search: Item > Parts, run the search.

Result: All Parts are returned in the search results.

4. Export search results into an Excel 2010 file by clicking More > Export(xls).

5. Check search results in the exported file.

Result: All Parts are displayed in the Excel 2010 file, rows greater than 65536 spill 
over to new sheets in the same file.

20141781

Standard Reports

Issue: BOM COMPARISON REPORT IS EMPTY AFTER APPLYING 
HF9.3.2.0.81/9.3.2.0.130

Root Cause: There is still an encoding issue in attribute values of BOM Comparison 
Report.

Resolution: Read the input stream as UTF-8 encoding.
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Verification:

Prerequisites: 1. Ensure that you are running Agile on Windows with locale set to 
Japanese. 2. Ensure that 933HF90 is patched if you are using 933

1. Log in to Web Client, create a Manufacturer in Japanese.

2. Create a Part on the Manufacturer Tab, add a Manufacturer Part, with the 
Manufacturer from Step 1.

3. Go to the BOM Comparison Report: 

1. On page 1, select the PDF, select Description on LAYOUT > Format. 

2. On page 2, check AML.

3. On page 3, select the Part from Step 2. 

4. Run the report.

Result: a). The file is not 0 byte.

b). The file can be opened correctly.

c). In the file, Traditional Chinese Manufacturer Name can be shown correctly, 
instead of garbled characters like "??".

20169521

Administration/Configuration

Issue: WRONG PREFERRED START PAGE IS PRINTED IN USERS 
CONFIGURATION REPORT

Root Cause: When displaying the value of User.Preference.PreferredStartPage 
attribute in Java and Web Client, we handle the attribute specially, but do not for user 
configuration report.

Resolution: Special handle this attribute on the user configuration report.

Verification:

1. Log in to Web Client.

2. Open user:administrator and set Notification to Preferred Start Page field and save 
it.

3. Execute Users Configuration Report.

4. Check the report.

Results: The notification is shown in the Preferred Start Page for user: 
administrator in Users Configuration Report.

20175093

Application Server

Issue: 9.3.3: USERS ARE UNABLE TO SAVE WORK IN AGILE PLM

Root Cause: common.js function submitFormForMultipleWindows(args, xtraArgs)

If SSO is enabled, when Agile times out, the user is not able to extend the session and 
there is no prompt to notify the user that Agile has timed out, so if user is trying to 
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save the object which is in edit mode, the server will serve a login page. There is 
syntax error caused by the following JS:

responseObject = eval('(' + response.text +')');

Resolution: try{...}catch(e){...} to handle unexpected response.text

Verification:

1. Log into Web Client in an SSO environment.

2. Open any object.

3. Do not execute any actions on Web Client. Wait for 30 minutes, since 25 minutes is 
the default session timeout for Web Client.

4. Navigate to Web Client after 30 minutes. Check the console to see if any errors are 
showing.

Results: No errors are displaying in the console.

20179869

Web Client

Issue: THE FIELDS OF WHERE USED TAB AND PART NUMBER FIELDS ARE 
INCONSISTENT

Root Cause: String matching error.

Resolution: Changed the code.

Verification:

1. Find an assembly Item which is not Preliminary.

2. Save As a new Item from this assembly Item.

3. Click the original assembly from Recently Visited.

4. Click the BOM tab, choose any item and click it.

5. Go to the child Item’s Where Used tab.

6. Check the columns Item Rev and Item Lifecycle Phase for new assembly.

Results: Item Rev is empty and Item Lifecycle Phase is Preliminary for the new 
assembly.

20196326

Software Development Kit

Issue: ISSUE WITH IQUERY EXECUTION FOR ATTRIBUTES CONTAINING DOT

Root Cause: String matching error.

Resolution: Changed the code.

Verification: Execute following Query successfully and correctly:

IQuery query = (IQuery)agileSession.createObject(IQuery.OBJECT_TYPE,"Parts");

query.setCaseSensitive(false);

query.setCriteria("[Manufacturers.Mfr. Name] contains 'm'");
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ITable results = query.execute();

System.out.println("Size: " + results.size());

20306808

Web Client

Issue: LAST ROW NOT EDITABLE ON 1080P DISPLAY WHEN THE LIST IS SAME 
AS WINDOW HEIGHT

Root Cause: If the Y coordinate of the bottom of the edit box exceeds the bottom of the 
grid table, the edit box is hidden.

Resolution: Do not hide the edit box.

Verification:

1. Log in to Web Client.

2. Create a ECO C0001.

3. Add 9 or more Affected Items in C0001.

4. On the Affected Items tab, reduce the width of all visible columns in the Affected 
Item panel, such as Item Number, Item Description, and so on.

5. Reduce each column until the horizontal scroll bar is not visible.

6. Ensure that the change has 9 or more Items on it.

7. Scroll down using the vertical scroll bar until the last Item of Affected Items of 
C001.

8. Edit the New Rev Column for the LAST ITEM IN THE LIST.

Result: The value is editable.

20405743

Web Services Security

Issue: VARMGMT FLOW FAILED DUE TO WEB.XML IN VMSERVICE.WAR IS 
BROKEN AFTER ENABLE WSS

Root Cause: Linux script did not disable basic authorization when enabling PIP web 
service security.

Resolution: Modify the Linux script file to copy the correct WSS protected web and 
WebLogic XML when enabling PIP web-service security.

Verification: 

1. Follow the relevant documentation to run wssconfigurator.sh to enable Agile Web 
Service Security.

2. Go to check application.ear/VMService.war/WEB-INF/web.xml and 
weblogic.xml.

Result: No <security-constraint> <login-config> <security-role> sections in 
web.xml, no <security-role-assignment> in weblogic.xml.

20427923
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Web Client

Issue: HEADING LINK DOES NOT JUMP TO THE CORRECT POSITION IN 
FIREFOX

Root Cause: In Firefox and Chrome, <a> tag in <fieldset> share the same space with 
<fieldset>.

Resolution: Put the <a> in a separate <dl>.

Verification:

1. Log in to Java Client. 

2. Define multiple heading attributes and text attributes for P2 & P3 For example, 
Subclass Part:

Page2 attributes:

Page2Heading01

text1

text2

Page2Heading02

text3

text4

text5

Page2Heading03

text6

text7

Page3 attributes:

Page3Heading01

text1

text2

Page3Heading02

text3

text4

..

3. Log in to Web Client with Firefox.

4. Create a Part: P00001 with Part subclass.

5. Click Page2Heading02 link on Title Block page.

Result: Jump to the position of Page2Heading02.

6. Click Page3Heading01 link on Title Block page

Result: Jump to the position of Page3Heading01.

20456840

Web Services
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Issue: WEBSERVICE REQUEST TO GET TABLE META-DATA FAILS WITH 
EXCEPTION ID 60086

Root Cause: This error is caused by BOM.SITE attribute or other site attribute from 
different table. The customer did not license Site object and does not use the Site class. 

Resolution: Will not return possible values if site is disabled.

Verification:

1. Create an Item, add a BOM item which has Site.

2. Disable the Site in Licneses in JAVA Client.

3. Run the getTableMetadata WS.

4. Verify that no error was displayed.

Result: No error was displayed.

20544031

Java Client

Issue: REPACKJAVACLIENTFILES.CMD CANNOT REPACK ALL FILES RELATED 
OF JAVA CLIENT

Root Cause: Dot not use the jar command correctly.

Resolution: "@JAVA-HOME@\bin\jar" uvfM ..\JavaClient.war *.* corrected to be:

"@JAVA-HOME@\bin\jar" uvfM ..\JavaClient.war *

Verification:

1. Run <Agile_HOME>\Install\bin\ExtractJavaClientFiles.cmd to extract Java 
Client.

2. And hotfixes folder with some jar files under the extracted Java Client.

3. Run <Agile_HOME>\Install\bin\RepackJavaClientFiles.cmd to repack Java 
Client.

Results: Can repack all files related of Java Client.

20548073

Averify Issues

Issue: AUT 1.7.6 EXITS DUE TO FALSE CRITICAL ERRORS AGIL-00025060 AND 
AGIL-00025066

Root Cause: The test case does not cover all the situations.

Resolution: Modify test cases to cover all the situations.

Verification:

AGIL-00025060 Case 1:

1. Import 935 demo DB.

2. Run "select change_history_id_seq.nextval from dual;" to check next sequence id.

3. Insert data into change_history table, data's id is smaller than the next sequence id 
from step 2.
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4. Run Averify on this user.

Result: There is no AGIL-00025060 related issues reported in oracle_averify_
report.log.

AGIL-00025060 Case 2:

1. Import 935 demo DB.

2. Run "select change_history_id_seq.nextval from dual;" to check next sequence id.

3. Insert data into change_history table, data's id is smaller than the next sequence id 
from step 2.

4. Run Averify on this user.

Result: AGIL-00025060 related issue such as "AGIL-00025060 : C : CHANGE_
HISTORY table has bad data (Table ID:-2099999000 is greater than the Sequence ID 
-2099999960)" reported in oracle_averify_report.log

AGIL-00025066 Case 1:

1. Import 935 demo DB.

2. Run "select change_history_id_seq.nextval from dual;" to check next sequence id.

3. Insert data into change_history table, data's id is smaller than the next sequence id 
from step 2.

4. Run Averify on this user.

Result: There is no AGIL-00025066 related issues reported in oracle_averify_
report.log.

AGIL-00025066 Case 2:

1. Import 935 demo DB.

2. Run "select change_history_id_seq.nextval from dual;" to check next sequence id.

3. Insert data into change_history table, data's id is smaller than the next sequence id 
from step 2.

4. Run Averify on this user.

Result: AGIL-00025066 related issue such as "AGIL-00025066 : C : ITEM_HISTORY 
table has bad data (Table ID:-2099999000 is greater than the Sequence ID 
-2099999500)" reported in oracle_averify_report.log.

20617259

Admin Config Propagation

Issue: UNABLE TO COPY THE SERVER FILE MANAGER CONFIGURATION TYPE 
VIA ACP

Root Cause: Miss new jars in class path script.

Resolution: Added new jars to class path script.

Verification:

1. Configure in ACP as follows

<copy>

<server_file_manager>
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<include>

<pattern>iFS</pattern>

</include>

</server_file_manager>

</copy>

2. ACP export the property: acp export golden

Result: ACP Export is successful.

20632630

Software Development Kit

Issue: PXS FAILING AFTER INSTALLING HF 9312.306

Root Cause: A class was missed while rebasing on 9312HF94.

Resolution: Added the class to HF306.

Verification:

1. In MultiItemCostedBOMReport.war, change config.properties and log4j.properties 
to point to your local Agile and local tomcat logs folder. Update AgileAPI.jar & 
pxapi.jar to your Agile version. Put this WAR file under $AGILE_
HOME/FileManager/webapps.

2. Log in to Java Client, configure the email server, create two new users and update 
their user profiles to have two separate email IDs for which you can view emails.

3. Configure URL PX to be invoked from the Action menu of Parts class by setting 
URL format as: http://<tomcat_
host:port>/MultiItemCostedBOMReport/Process.

4. Log in to two separate browsers (pick two different brands, for example, Internet 
Explorer & Firefox) as two separate users (madaraju, testbhanu respectively).

5. In both browsers, search for Part 53-000210 and invoke Multi-Item Costed BOM 
from the Actions menu.

6. In the pop-up window with the "Multi Item Costed BOM" screen where 53-000210 
is shown as default, click Submit in both browsers simultaneously (couple of 
seconds difference is ok).

Result: The user receives two emails with the correct report results.

20633730

Admin Config Propagation

Issue: ACP IMPORT ERROR:PRIVILEGE NOT IMPORTED DUE TO ERROR

Root Cause: Root Cause:Similar to 20633655, when migrating default value of list 
attribute of privilege, need handle specially.

Resolution: Handle specially for default value of list attribute via ACP.

Verification:

1. Login Java Client of source.
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2. Open List05 on Parts Page Two, set a default value for it.

3. Create read/modify privilege with List05 in the criteria.

4. ACP export read/modify privilege in source.

5. ACP propagates source to target.

6. Check the privilege in the target.

Result: The privilege is propagated to target without error message.

20635031

Java Client

Issue: UNABLE TO OPEN ONLINE HELP MANUAL VIA JAVA CLIENT USING JRE 
7U71

Root Cause: BasicService bs = (BasicService) 
ServiceManager.lookup("javax.jnlp.BasicService"); bs.showDocument(new 
URL(helpURL));

We use this code to show the help URL, but in new JREs, for example, JRE7u79 
JRE7u71 JRE8, it does not work.

Resolution: String helpUrlEncoded = new URI(helpUrl).toASCIIString();

Used thiscode to encode the non ASCII characters in the help URL.

Verification:

Precondition: Java Version:1.8.0_45

1. Log in to Java Client.

2. Go to Admin > Setting > Server Setting > Locations Online Help Manual URL:

3. Input http://www.oracle.com/technology/??/ agile.html.

4.  Save.

5. Click Help->Manual Results:IE can lunch the link: 
https://www.oracle.com/technology/%E6%96%87%E 6%9B%B8/agile.html

6. Go to the product index.

Result: The user can find related document.

20649007

Import

Issue: ERROR WHILE IMPORTING THE SMALL NUMERIC VALUES

Root Cause: Numbers like 0.0005, 0.00001, and so on are formatted as 0.00050 or 
0.000010 by the BigDecimal tool class. This adds one more zero and the scale length is 
not as expected.

Resolution: Use # of NumberFormat to remove the last zero of the decimal.

Verification:

1. Log in to Java Client.

2. Open Numeric01 on Items Page Two, change the Scale to 4.
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3. Create a source file and enter a value between 0.0001 and 0.0009 for the numeric 
attribute.

4. Click Import under Tools & Settings and select the source file.

5. Specify file content Items > Item only.

6. Select Content options:

1. Data Mapping > Use Currently defined mapping definition.

2. Data Transformation > No transformations are necessary.

3. Redline Options > Updates do not require redlining.

7. Do required mapping.

8. Click Validate button.

Result: There is no message for scale violation.

20712219

Averify Issues

Issue: AGIL-00025154 FOR VERSIONS LOWER THAN A932 

Root Cause: Prior to 932, there is no criteria for the Create from Template privilege. 
Since 932, the related criteria is added into system.

Resolution: Modify the AGIL-00025154 case to exclude the error message before 932.

Verification:

Case 1:

1. Import Agile 9312 dbsetup or lower version dump file.

2. Run Averify 1.7.7 against this database.

3. Check if th following two AGIL-00025154 errors were reported in the oracle_
averify_report.log. AGIL-00025154 : E : ADMINMSATT table has bad data 
(Missing adminmsatt data reference at nodetable id 32705.Java Client may show 
blank screen.) AGIL-00025154 : E : ADMINMSATT table has bad data (Missing 
adminmsatt data reference at nodetable id 2000007917.Java Client may show blank 
screen.)

Result: The specific two AGIL-00025154 errors were not reported on the Agile 
database versions lower than 932.

Case 2:

1. Create a DB user and import a Agile 9312 or prior version dump file.

2. Log in to sqlplus as this user, get aprivilege's id from nodetable asfollows:

select id from nodetable where parentid=12075;

3. Delete reference data in ADMINMSATT table using the following SQL:

delete from adminmsatt where parentid=xxxx  (xxx is the ID selected from step 2) 
commit;

4. Run Averify 1.7.7 with run.Option=all against this db user.
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Result: The following error is reported in oracle_averify_report.log AGIL-00025154 
: E : ADMINMSATT table has bad data (Missing adminmsatt data reference at 
nodetable id xxxx. Java Client may show blank screen.)

20753351

Import

Issue: THE USER'S PASSWORD CHANGE IS NOT SUPPORTED APPEARS ON 
IMPORT EVEN THOUGH NOT ATTEMPTED

Root Cause: When the pwd attribute is not mapped, it should not throw an exception.

Resolution: Check whether the pwd attribute is mapped before throwing an 
exception.

Verification:

1. Log in to Java Client as admin user.

2. Create a user ImpUser1.

3. Click Tools > Import.

4. Click Import Preferences, and confirm that Blank Data Action is set to Overwrite 
Data.

5. Select a file with the user ImpUser1, and click Next.

6. Specify file content User > User only, and click Next.

7. Select Define attribute mapping in the next step, and click Next.

8. Define the mapping for the attributes except Login Password and Approval 
Password.

9. Click the Import button.

Results: The user is imported without the message "For security, the user's 
password change is not supported by import functionality." in the Import Log.

20759560

Import

Issue: ITEM NUMBER WITH LOWER CASE IS NOT IMPORTED THROUGH 
IMPORT

Root Cause: To support upper/lower/mixed case, the method, 
createRealObjNumberCollection, of super class BatchHandler.java should be 
overwritten, but item/mfr/mfr part handler does not overwrite it.

Resolution: Overwrite the method, createRealObjNumberCollection, to support 
upper/lower/mixed case for creating item/mfr/mfr part.

Verification:

1. Prepare a data source file to import. Input the value for Manufacturer Part 
Number using both lowercase and uppercase.

2. Log in to Web Client, and run Import.

3. Select the file created in Step 1 for Import File.
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4.  On the Specify File Content screen, select Manufacturer Part | Manufacturer Part 
only.

5. Define the attribute mapping.

6. Run Import. Check the imported Manufacturer Part.

Results: The Manufacturer Part Number is created in its original case, instead of all 
upper case.

20760803

Web Client

Issue: TABLE WITH MERGED CELL COPIED FROM MS WORD GETS CORRUPTED 
IN LARGE TEXT FIELD

Root Cause: The HTML attribute 'colspan' on 'td' of table is not allowed.

Resolution: Allow attribute 'colspan' on 'td' of table.

Verification:

1. Create a Microsoft Document with a table with merged cells.

2. Copy and paste to a large text field in Web Client.

3. Check the copied table.

Results: The borders are copied properly.

20776093

Software Development Kit

Issue: API  "AGILESESSIONFACTORY.REFRESHINSTANCE(URL)" THROWS OUT 
OF MEMORY ERROR

Root Cause: The SDK client always creates a new NetworkClassLoader instance even 
for the same cluster node when calling AgileSessionFactory.refreshSessionEx. The class 
loader instance is held by a WebLogic thread, and cannot  be released. After many 
calls, too many class loader instanced eat all the PermSpace memory. That cause OOM.

Resolution: Only create one class loader instance for each cluster node and cache it. 
Next time when we try to get class loader for the same cluster node, try to get it from 
cache first.

Verification:

1.  Set up the Cluster server.

2. Create Agile session more than 50 times via 
AgileSessionFactory.refreshInstance(?). >>> 

AgileSessionFactory factory =

AgileSessionFactory.refreshInstance(URL);

HashMap params = new HashMap();

params.put(AgileSessionFactory.USERNAME, USERNAME);

params.put(AgileSessionFactory.PASSWORD, PASSWORD);

IAgileSession session =
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factory.createSession(params);

3. Create Agile session more than 50 times 
viaAgileSessionFactory.refreshInstanceEx(?). >>>

HashMap params = new HashMap();

params.put(AgileSessionFactory.URL, URL);

params.put(AgileSessionFactory.USERNAME,USERNAME);

params.put(AgileSessionFactory.PASSWORD,PASSWORD);

AgileSessionFactory factory =

AgileSessionFactory.refreshInstanceEx(params);

session = factory.createSession(params);

4. Create Agile session more than 50 times via 
AgileSessionFactory.refreshSessionEx(?). >>>

HashMap params = new HashMap();

params.put(AgileSessionFactory.URL, URL);

params.put(AgileSessionFactory.USERNAME,USERNAME);

params.put(AgileSessionFactory.PASSWORD,PASSWORD);

AgileSessionFactory factory =

AgileSessionFactory.getInstanceEx(params);

session = factory.refreshSessionEx(params);

Result: There is no Perm Gen out of memory issue and the Agile session is created 
successfully.

20801980

Import

Issue: FATAL EXCEPTION ON IMPORTING USER GROUP IF BLANK DATA 
ACTION IS SET TO OVERRIDE

Root Cause: null point exception

Resolution: When the attribute, Max Num of Named Users, is mapped and the Blank 
Data Action is set to Overwrite Data, but the source file does not provide a value for it, 
throw a warning message.

Verification:

1. Log in to Web Client.

2. Create a User Group, UG0001.

3. Prepare a source file with the following data:

User Group Name    Global/Personal    User Name    Max Num of Named Users

UG0001             Global             User0001

4. Click Tools and Settings > Import, select the file created above.

5. Go to Preferences, and make sure that Blank Data Action is set to "Overwrite 
Data".
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6. In the Specify File Content step, select User Group > Users.

7. Define mapping for the required fields and Max Num of Named Users.

8. Click Import button, and check the Import Log.

Result: The user is imported to the user group with a warning message in the 
Import Log.

20810775

Averify Issues

Issue: AVERIFY FIX: AFTER RUNNING AUT FROM 9.2.1.4 TO 9.3.3 API NAME HAS 
DUPLICATES

Root Cause: There should be a unique api name for node with objtype 
(13,21,111,24,22,106,205). In the customer's env, there are duplicate api names.

Resolution: Change the test case in latest 9.3.4 to handle it differently to avoid the 
error.

Verification:

1. Create a new listentry on Country List in Java Client.

2. Edit data on nodetable. Make two node(objtype in 13,21,111,24,22,106,205) have 
duplicate apinames.

3. Run Averify1770 on the DB user.

4. In oracle_averify_report.log, we should see logs below:

AGIL-000155026 : E : NODETABLE table has bad data (Duplicate API name xxxx 
in same parent node 3642 with same objtype xxx.)

20824408

Folders, Files, and Attachments

Issue: INTERNET EXPLORER 10 DOES NOT ALLOW MULTIPLE FILES 
DOWNLOAD ON AGILE 9.3.3

Root Cause: Code-side issue.

Resolution: Fixed code.

Verification:

1. Log in to Web Client on IE10.

2. Access a BO Attachments tab.

3. Add multiple files or multiple files in a single folder.

4. Select multiple files or multiple files in a single folder and click on Get or Quick 
View the BO, select multiple files or multiple files in a single folder and click on 
Get.

Result: The file is downloaded successfully as download.zip.

20860504
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Web Services

Issue: EC CONNECTION LOGIN WAS NOT SUCCESSFUL

Root Cause: Oracle JAXP document builder instance which doesn't support the reset 
feature, is loaded and created.

Resolution: Specify to use apache xerces JAXP document builder implementation.

Verification:

1. Create an object.

2. Add an Attachment to the new object through AddAttachment WS.

3. Download the attachment through Get Attachment WS.

4. Verify that there was no connection failure when attachment was added and 
downloaded.

Result: There was no connection failure when attachment was added and 
downloaded.

20894125

Internationalization

Issue: [JP TRANSLATION]NOTIFICATION MAIL TITLE URGENT INCLUDED IN 
JAPANESE ENVIRONMENT

Root Cause: All cap words like "URGENT" are reserved for technical use (for example, 
variable names) and are therefore not processed by our translation tools. 

Resolution: Modified "URGENT" in the property file to lowercase, and moved to I18N 
team to translate the Urgent string.

Verification:

1. Log in to Agile with a Japanese user.

2. Create Change Order, C00269. 

3. Press Next Statu.

4. To : Japanese user .

5. Check Send notification as urgent.

6. Click Finish.

7. Check if the user received 2 mails with the title "URGENT" included in Japanese 
mail. 

Result: The word urgent is translated into Japanese.

20985409

Searches

Issue: RESOURCE UTILIZATION REPORT, CHANGE FIELD DOES NOT WORK

Root Cause: This is caused by a lack of the Days Effort process method.

Resolution: Added the Days Effort process method.

Verification:
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1. Log in to Web Client.

2. Go to any Program.

3. Go to the Team tab.

4. Click Add.

5. In the Add resource window, add a member, then from Actions menu, select the 
Project Resource Utilization option from Reports and Analytics.

6. In the field Display Values by the default is Percent Utilization.

7. Change value from Percent Utilization to Days Effort, click Refresh.

Result: The Days Effort Chart gets loaded in the Project Resource Utilization 
Report.

21105883

DB Upgrade/AUT

Issue: AUT UPGRADE TOOL CAUSED DATA LOSS

Root Cause: When upgrading from one schema to another, the index named FILES_
CONTENT_IDX on the files table is rebuilt - backup files table, delete the original files 
table and copy the backup table to files table, when delete action is executed, FILES_
DEL_TRIGGER is triggered, which deletes related records corresponding to the files 
table.

Resolution: Disable the trigger FILES_DEL_TRIGGER when deleting the original files 
table, and enable it after copying the backup table to the files table.

Verification:

1. Import the 934 presales DB dump to schema demofrom.

2. Check the number of records in table file_info.

Result: There are 5583 records, no records had data loss.

3. Use AUT1770 to upgrade from 934 to 935 (schema demofrom to schema demoto).

4. Check the number of records in the table file_info in schema demoto.

Result: There are 5583 records, no records had data loss.

21117940

Searches

Issue: WILDCARD SEARCH WITH "LIKE" OPERATER DOES NOT WORK IN 
MULTIBYTE CHARACTERS

Root Cause: A fix to a previous bug removes trailing asterisk from user input.

Resolution: Skip the removal of trailing asterisk when the operator is Like.

Verification:

1. Log in to Web Client as admin.

2. Create a Part: P001 with a description using Chinese characters.
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3. Do an Advanced Search: Items > Parts > Title Block.Description > Like > 
[Description from Step 2]*, and run the search. (Append a trailing asterisk to the 
description.)

Result: P001 can be searched out.

21118625

Internationalization

Issue: WPTG_TSN:T9N:LOC-MSG:3:AGILE:4-292677:NON STANDARD LEGAL 
TEXT:PLM-AGILE-9.3.5-D1

Root Cause: Copyright information does not comply with Oracle’s latest guidelines.

Resolution: Revised related copyright information.

Verification:

Case 1: 

1. Log in to Web Client as admin.

2. Go to Help > About.

3. Check copyright information on the About and Login pages.

Result: It shows: "Copyright © 1995, 2015, Oracle and/or its affiliates. All rights 
reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. 
Other names may be trademarks of their respective owners. "

Case 2: 

1. Log in to Java Client.

2. Go to Help > About.

3. Check the copyright information.

Result: It shows: "Copyright © 1995, 2015, Oracle and/or its affiliates. All rights 
reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. 
Other names may be trademarks of their respective owners."

Case 3: 

1. Log in to Web Client as admin.

2. Create Program object.

3. Open Gantt > Help > About.

4. Check the copyright information.

Result:  It shows: "Copyright © 1995, 2015, Oracle and/or its affiliates. All rights 
reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. 
Other names may be trademarks of their respective owners."

21248768

Administration/Configuration

Issue: RFQ NUMBER FIELD DOES NOT CHECK CHARSET VALUES

Root Cause: This is a code defect. When creating RFQ object, we do not check charset.

Resolution: Check charset when creating an RFQ object.
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Verification:

1. Log in to Java Client. Go to Admin > Data Settings > Character Sets, create a 
Character set as follows: Name: Special, All Characters with Space Valid Character 
Set: ^s^p^^ABCDEFGHIJKLMNOPQRSTUVWXYZ_-?/1234567890

2. Go to Classes > Requests for Quote > Cover Page attribute, change the RFQ 
Number to use the new character set.

3. Log in to Web Client, create a Sourcing Project.

4. Add Items to the Sourcing Project and change the Status to open.

5. Create RFQ with Number: RFQ00942 @#$*.

Result: The system should not accept that RFQ Number by throwing the following 
message. Only "Special, All Characters with Space" values are allowed for RFQ 
Number.

6.  Create RFQ with Number: AZ^ _-?/1234567890.

Result: The RFQ is created successfully.

21389523

Admin Config Propagation

Issue: ACP IMPORT ON GLOBAL SEARCH ENDS IN ERROR: STRING INDEX OUT 
OF RANGE: -1

Root Cause:  $USER is not handled.

Resolution: Need to handle $USER specially.

Verification:

1. Log in to source instance.

2. Create searches with $USER in criteria.

3. Use Save As to save the searches to Global Searches folder.

4. Configure the config.xml file as below:

<copy>

<searches/>

</copy>

5. ACP export source instance.

6. ACP import source to target instance.

Result: Global searches are imported to the target instance successfully without the 
error message "ERROR: String index out of range: -1"

21617418

DB Upgrade/AUT

Issue: UNABLE TO SORT/ORDER LARGETEXT ATTRIBUTES AFTER THE 
UPGRADE

Root Cause: When there are newly created subclasses prior to 934, there will be no 
records in tableinfo table for large text attributes after upgrading to 934.
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Resolution: Add records in tableinfo table for large text attributes when upgrading 
from 933 to 934.

Verification:

1. On Agile 933 environment, create a new subclass for Parts/Changes. 

2. Use AUT1770 to upgrade the DB user.

3. Connect the DB user to Agile 935 application and sort these LargeText attributes.

Result: LargeText attributes can be sorted.

21876123

Application Server

Issue: CLUSTER INSTALL MODE NOT DISPLAYING PANEL APPLICATION 
SERVER INFORMATION

Root Cause: The application installer uses the hostname and domainname commands 
to create the default hostname/domainname for the configuration. The panel 
'Application Server Information' allows this to be overridden at install time before the 
configuration is generated, but the Panel Application Server Information' is being 
displayed in the Standalone case, but not in the 'Cluster' case. 

Resolution: Updated the installer condition to display the Application Server 
Information panel whenever the Application Server and/or File Manager component 
is selected.

Verification:

1. Launch Agile935 Installer.

2. Choose Cluster Install Mode.

3. Check Application Server Information Panel.

Result: Display after this panel.

21920836

Administration/Configuration

Issue: CAN NOT REFRESH THE VISIBILITY OF THE ATTRIBUTE RIGHT NOW 
AFTER CHANGING THE PART

Root Cause: Attributes of Title Block, Page Two did not change with the Part type 
change when edited in the Item. The old cache has not been invalidated.

Resolution: When Part type is changed, save the new subclass and return back to view 
model with attributes refreshed. Old cache is invalidated.

Verification:

1. Log in to Java Client as admin.

2. Go to Admin > Classes > Parts, create two subclasses, SUBPART01 and 
SUBPART02.

3. Go to SUBPART01 > Title block, make sure Size is visible. Go to its Page Two, 
enable P2.Text01, and make sure P2.Text02 is invisible. Go to its Page Three, enable 
Multilist01, and make sure P3.Multilist02 is invisible.
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4. Go to SUBPART02 > Title block, disable attribute Size. Go to its Page Two, enable 
P2.Text02, and make sure P2.Text01 is invisible. Go to its Page three, enable 
Multilist02, and make sure P3.Multilist01 is invisible.

5. Log in to Web Client as admin.

6. Create a Part, sp01_01 with SUBPART01 type, check its attributes.

Result: Title block.Size, P2.Text01 and P3.Multilist01 are all displayed for sp01_01.

7. Change sp01_01 type to SUBPART02, save it. Refresh the page.

Result: Title block.size, P2.Text01 and P3.Multilist01 are not visible. P2.Text02 and 
P3.Multilist02 are displayed.

Autovue for PLM 
20326877

Electro-Mechanical Pro Int

Issue: AUTOVUE AND CLICK ANALYSIS-->COMPARE THE DOCUMENT 
VERSIONS DROPDOWN LIST SHOWS

Root Cause: N/A

Resolution: N/A

Verification: 

1. Log in to A9 Web Client.

2. Create an Item and navigate to the Attachments tab to add a file.

3. Create an ECO, ECO1, for the Item with Rev as A.

4. Bump up the folder version to 3 for Item with Rev A and release ECO1.

5. Create another ECO, ECO2, for Item with rev as B.

6. Bump up the folder version to 5 for Item with Rev B and release the ECO2.

7. View the file of version 5 in Item rev B Attachments tab, so that the AutoVue 
window is displayed.

8. Click on Analysis > Compare.

9. Make sure that the Document versions box is checked.

10. Click on the dropdown list for document versions and versions.

Result: The dropdown list the version 3 Rev B, version 4 Rev B.

20456036

2D Pro Integration

Issue: SAVE MARKUP NOT WORKING, MISSING NAME AND DESCRIPTION IN 
SAVE DIALOG

Root Cause: Code defect.

Resolution: Fixed code.

Verification: 

1. Log in to A9 Web Client.
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2. Create an Item.

3. Navigate to the Attachments tab and add a file.

4. Create an ECO from the Actions menu of Item.

5. Navigate to the Affected Items tab of ECO.

6. Select the Item in Affected Items tab and switch to the Attachments table.

7. Select the file and click on Redline, so that the file is loaded in viewer in markup 
mode.

8. Click on Markup > New and then create a markup entity and click on Save.

Result: The Name and Description fields are displayed on the Save Markup File As 
window. When the user enters the Name and Description and clicks on OK, the 
changes are saved. This is also verified for File Folder, Design and ECR objects.

20456184

2D Pro Integration

Issue: AGILE SEARCH,AGILE BROWSE,NOT WORKING FOR COMPARE

Root Cause: Code defect.

Resolution: Fixed code.

Verification: 

Scenario 1:

1. Log in to Web Client or Java Client.

2. Create an Item, P1, and add attachments and Bookmark the object.

3. Create an Item, P2, and add attachments and Bookmark the object.

4. Select the file in P1’s Attachments tab and click on View.

5. In Auto Vue, click on Analysis > Compare.

6. In the File Open window, click on "Agile"

Result: All the bookmarked objects are listed in File Open window and double 
click on the Bookmarked object displays the files list and on selecting the similar 
file type the files are compared.

Scenario 2:

1. Log in to Web Client or Java Client.

2. Create an Item, P1, and add attachments and-Bookmark the object.

3. Create an Item, P2, and add attachments and Bookmark the object.

4. Select the file in P1’s Attachments tab and click on View.

5. In Auto Vue, click on Analysis > Compare.

6. In the File Open window, click on Search Agile with the search parameter <Item 
2> and click on Search.

Result: The BOs are displayed based on search criteria. Click on the object so that 
all the files added to that object are listed in the File Open window and on 
selecting the similar file type the files are compared.
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Agile Engineering Collaboration
20379361

EC Services

Issue: DRAWING DESIGN OBJECT STRUCTURE IS NOT CORRECT FOR 
INCREMENT SAVE

Root Cause: We can not reproduce the issue. All previous versions were copied to 
structure table, not latest version when server side does checkout.

Resolution: Only the latest structure is copied to the structure table and make sure 
that there is no version 1 design in this case.

Verification: 

1. Create a Part model and save it locally.

2. Create a drawing model against the Part model and save it to Agile.

3. In Agile > Preference tab, set "Save Option for Modified" with value "Check In" 
and save preference setting.

4. Click Agile > Save preview and save the drawing with Part to Agile.

5. Go to Agile > Preference tab, set "Save Option for Modified" with value 
"Increment" and save preference setting.

6. Click Agile > Save preview again. Check out both components and click Continue 
button to save them to Agile. 

Result: In save result, the version for drawing and part should be 3.

7. Log in to Agile Web Client and check the design object for part and drawing.

Result: There should be one row for the part design, the version should be version 
2.

20628818

EC Services

Issue: PUBLISH ERRORS - "EJB EXCEPTION"

Root Cause: The version number was shared among threads.

Resolution: Implement version number with a thread local variable.

Verification: QA can not reproduce it due to lack of specific settings.

20838691

EC Services

Issue: LOAD PREVIEW SLOW USING LOAD DRAWING OPTION

Root Cause: The load preview step performance issue is caused by redundant calls 
between MCAD client & Agile server and due to chattiness between Agile Server and 
the database in resolving multi-level recursive design structure data.

Resolution: The following steps have been taken to improve the Load To CAD 
performance:
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1. Client Server call sequence has been optimized to load the design efficiently 
without preview and with Load Preview (configurable in MCAD client).

2. Removed chattiness by moving structure resolution into DB process and also load 
objects in bulk.

Verification: Overall ~45% performance improvement reported for Load to CAD use 
case without the Load Preview window. Tested with several different size assemblies 
and confirmed this improvement. 

21368122

EC Services

Issue: PART FAMILY INSTANCE LINKED ITEMS ARE REMOVED FROM BOM TAB 
BY TRANSFER

Root Cause: There are NullPointException and IndexOutofArrayBound errors.

Resolution: Before using the Java object reference, check if it is null or not.

Verification: 

1. Launch Solidworks, download and open below test drawing or create a drawing 
with balloons using the following instructions.

Test drawing: ftp://agile@slc03syl.us.oracle.com/QA/Rico/ballooning.zip

Instructions how to create this feature:

https://beehiveonline.oracle.com/teamcollab/wiki/Agile+Integration+Develop
ment+Partner+xPLM:kb_solidworks_ballooning

2. Save the Drawing to Agile by clicking Agile > Save Preview.

3. In Agile Save Preview, create and assign Items for each component.

4. Click Continue and save successfully.

5. Check the BOM rows of the assembly design linked Item > BOM published 
correctly including part family instance linked Items.

6. Back to MCAD Connector and click Agile > Transfer BOM find numbers.

7. Go to Agile Web Client and refresh it (refresh button).

8. In the Web Client, check the BOM structure.

Result: Transfer BOM find numbers does not remove the BOM Items linked with 
part family instance.

21604386

EC Services

Issue: NPE EXCEPTION AFTER REDLINE BOM BY MANUALLY ADD

Root Cause: The object is null when it is referenced.

Resolution: Add a null check before using the reference to an object.

Verification:

1. Launch CAD Tool and connect to Agile.

2. Create one assembly file, assem1, and save locally.
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3. Save to Agile with assigned Design1 version 1, Item1 and ECO1.

4. Open Affected Items tab of ECO1 from Agile Web Client.

5. Redline BOM table of Item1, manually create and add one new BOM Item, Item2, 
from the Web Client.

6. Go back to the CAD Tool and click Save Preview again.

7. Highlight the row and click Publish to Item from the right-click menu.

Result: Publish Success without error.

8. Highlight the row and check out.

9.  Click Continue to save to Agile.

Result: Save Success without error.

21663392

EC Services

Issue: REDLINE FLAG DOES NOT DISPLAY IN CHANGE AI TABLE WHEN 
DELETING MODEL FROM ASSEMBLY

Root Cause: The logic to check BOM redline data for flag updates has a defect and is 
missing some scenarios.

Resolution: Improved the logic.

Verification:

1. Create an Assembly, ASM001, with one child Part, PART001, as follows:

ASM001 - v1

|--PART001(QTY = 1)

2. Save the ASM and all its components into PLM with design and Item assigned.

3. Update the ASM structure as below:

ASM001 - v2

|--PART001(QTY = 0)

4. Click Save Preview, assign an ECO1 for the assembly and save to Agile.

5. Check the redline BOM table of ECO1.

Result: In the ECO1.AI table, the Item of ASM001 displays as "Has been redlined".

21689441

EC Services

Issue: DIFFERENT REDLINE INFO WHEN NO UPDATE ON BOM ITEM QTY WITH 
MULTI ECOS

Root Cause: The logic of prepareDataForPublishBOM() has a defect if the same item is 
redlined via multiple changes.

Resolution: Adopt the same behavior as 933. Delete the repetitive items if they do not 
exist in the current redline.

Verification: 
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1. Launch CAD Tool and connect to Agile.

2. Create ASSM001.SLDASM as follows and click Save Preview:

ASSM001 - v1

|-- PART001(qty=1)

3. Click Save As to assign design numbers and Item numbers on them.

4. Assign new Change, ECO1, on ASSM001 row.

5. Click Continue to save to Agile.

6. No Update on ASSM001.

7. Click Save Preview.

8. Highlight the ASSM001 row and check out.

9. Assign another new change ECO2 on ASSM001 row.

10. Click Continue to save to Agile.

11. Release ECO1 from Agile Web Client.

12. Check the Redline BOM table of ECO2. Now there are 2 rows for PART001, one is 
shown as without redline with qty 1.0, another one is shown as redline added with 
qty 1.0. There is NO warning message for conflicting with a released change when 
switch to AI tab of ECO2.

13. Go back to the CAD Tool.

14. Click Save Preview.

15. Highlight the ASSM001 row and check out.

16. Click Continue to save to Agile.

17. Check the Redline BOM table of ECO2.

Result: There are two rows for PART001. One row is shown as redline deleted with 
qty 1.0, another row is shown as redline added with qty 1.0.

21689497

EC Services

Issue: DIFFERENT REDLINE INFO WHEN UPDATING BOM QTY ON ECO2 AFTER 
RELEASE ECO1

Root Cause: The logic of prepareDataForPublishBOM() has a defect if the same item is 
redlined via multiple changes.

Resolution: Adopt the same behavior as 933. Delete the repetitive items if they do not 
exist in the current redline.

Verification: 

1. Launch CAD Tool and connect to Agile.

2. Create ASSM001.SLDASM as below and click Save Preview

ASSM001 - v1

|-- PART003(qty=1)

3. Click Save As to assign design numbers and Item numbers on them.
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4. Assign new Change, ECO1, on ASSM001 row.

5. Click Continue to save to Agile.

6. No Update on ASSM001.

7. Click Save Preview.

8. Highlight the ASSM001 row and check out.

9. Assign another new Change, ECO2, on ASSM001 row.

10. Click Continue to save to Agile.

11. Release ECO1 from Agile Web Client.

12. Check the Redline BOM table of ECO2 - now there are 2 rows for PART001, one is 
shown as without redline with qty 1.0, another one is shown as redline added with 
qty 1.0. There is NO warning message for conflicting with a released change when 
switch to AI tab of ECO2.

13. Go back to CAD Tool and update ASSM001 as below

ASSM001 - v3

|-- PART003(qty=2)

14. Click Save Preview.

15. Highlight the ASSM001 row and check out.

16. Click Continue to save to Agile.

17. Check the Redline BOM table of ECO2.

Result:  There are totally two rows for PART003, one row is shown as redline 
deleted with qty 1.0, another row is shown as redline added with qty 2.0.

21695618

EC Services

Issue: THE REDLINE BOM FLAG IS MISSING WHEN DELETING THE 
COMPONENT IN SAME ECO

Root Cause: The logic to check the BOM redline data for a flag update has a defect and 
is missing some scenarios.

Resolution: Improved the logic.

Verification: 

1. . Create one assembly assm1.sldasm as below

assm1 - v1

|-- part1(qty=1)

|-- part2(qty=1)

2. Click Agile save preview, highlight all components and click save as button to 
generate design and item numbers.

3. Highlight the row of the assembly, assign a change ECO1 for the assembly then 
click continue button to save to Agile.

4. Check design structure, BOM structure and ECO redline bom table from Agile 
web client.
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Result: Design structure, BOM Structure and ECO Redline BOM table should 
display correctly, the item for part1.sldprt and part2.sldprt should display with 
Qty 1 (redline added).

5. In CAD system, update assembly as follows:

assm1 - v2

|-- part1(qty=0)

|-- part2(qty=1)

6. Click Agile save preview, check out the assembly and then click Continue button.

7. Check design structure, BOM structure and eco redline bom table from Agile web 
client.

Result: It displays the redline BOM flag for the Item of the assembly; Design 
structure, BOM Structure and ECO Redline BOM table are displayed correctly, the 
Item for part1.sldprt is not displayed. The Item for part2.sldprt is displayed with 
Qty 1 (redline added).

21744374

EC Services

Issue: REDLINE FOR BOM IS NOT CORRECT WHEN REDUCING AND ADDING 
BACK AGAIN

Root Cause: The BOM redline delete via MCAD tool in A934 has a defect and leads to 
the  current issue.

Resolution: Correct the logic of BOM redline delete.

Verification: 

1. Create one assembly with two components.

2. Save the assembly to Agile with Item assigned.

3. In CAD system, remove one of the components, for example, part1.sldprt.

4. Click Agile Save Preview again, assign a change for the assembly and save it to 
Agile with version 2.

5. In CAD system, add the component to the assembly again.

6. Click Agile Save Preview, check out all files and click continue to save them to 
Agile with version 3.

7. Log in to Agile Web Client, check the design and BOM structure.

Result: Check the Redline BOM table for the change.

8. Check the Redline BOM table for the change.

Result: Check the Redline BOM table for the change.

21744382

EC Services

Issue: NO REDLINE ON BOM QTY ALTHOUGH ASSEMBLY HAS THE 'HAS BEEN 
REDLINED' FLAG
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Root Cause: The BOM batch redline logic serving for MCAD tool in A934 has a defect 
and leads to the current issues.

Resolution: Add the missing logic.

Verification: 

1. Launch the CAD Tool and connect to Agile.

2. Create Assem2.SLDASM with the following structure:

 Assem2.SLDASM

 |-Assem1.SLDASM(qty=1)

   |- Part1.SLDPRT(qty=2)

3. Save them to Agile with linked Items.

4. Add Part1.SLDPRT into Assem2.SLDASM - now Assem2.SLDASM has one 
Part1.SLDPRT.

5. Open Assem1.SLDASM.

6. Delete one Part1.SLDPRT from Assem1.SLDASM - now Assem1.SLDASM has one 
Part1.SLDPRT.

7. Now the updated structure is as follows:

 Assem2.SLDASM

 |-Assem1.SLDASM(qty=1)

   |-Part1.SLDPRT (qty=1)

 |-Part1.SLDPRT (qty=1)

8. Save above all locally.

9. Click Save Preview.

10. Highlight 2 rows, Assem2.SLDASM and Assem1.SLDASM.

11. Create one new change ECO1 and assign to Assem2.SLDASM and 
Assem1.SLDASM.

12. Click Continue to save to Agile.

13. Open the ECO1 from Agile Web Client.

14. Check the redline BOM table on Assem6.SLDASM.

Result: QTY of Part1.SLDPRT under Assem1.SLDASM redline BOM table is shown 
as redlined from 2.0 to 1.0. 

21744416

EC Services

Issue: OPEN BOM TABLE HAS WARNING - CHANGE WITH CONFICTING 
REDLINES IN BOM

Root Cause: The BOM batch redline logic serving for MCAD tool in A934 has a defect 
and leads to the current issues.

Resolution: Add the missing logic.

Verification: 
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1. Launch the CAD system and log in to Agile via workspace manager.

2. Create one Assembly, assm01.sldasm, with two Part models part1.sldprt and 
part2.sldprt.

3. Click Agile > Save preview for assm01.sldasm.

4. Highlight all components, click Save As button to generate design and Item 
numbers.

5. Click the Create Change button and assign the change for the assembly file.

6. Click Continue to save it to Agile.

7. In the CAD system, remove part1.sldprt from assembly, insert part2.sldprt to the 
assembly again, create a new part part3.sldprt and add to the assembly.

8. Click Agile > Save preview, highlight the row of part3.sldprt and click the Save As 
button.

9. Highlight the row of the assembly and check it out.

10. Click the Continue button.

11.  Log in to Agile Web Client, open the Item object of the assembly file.

12. Go to the BOM table and select the pending rev.

Result: It displays the BOM Structure correctly without such warning message.

21807147

EC Services

Issue: WILL HAVE TWO ITEM OBJECTS IN RELATIONSHIP WHEN ASSIGNING A 
DIFFRENT SUBCLASS

Root Cause: The logic of ecBulkRelationships() has a defect for the case.

Resolution: Correct the logic.

Verification: 

Prerequisites: Preference Settings:

Save As: Item and Design

Publish to Item: BOM and Attachment

Class Default Settings: Item Subclass-Part

1. Create one Object Design001 in CAD tool.

2. Click Save Preview.

3. Select the Object and then click Save As to assign Design and Item to the object > 
Click Continue in the Save Preview window.

4. Go to Agile Web client to check the Design Relationship Tab. There will be one 
Item object linked to the Design.

5. Go back to the CAD tool and click Save Preview again,

6. Check Out the Object and then right click > Edit Properties.

7. Change Item Subclass in the opened Detail window, for example, Change Item 
subclass from "Part" to "Model").
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8. Click "Autonumber Source for Selected Subclass" to generate one new Item 
number

9. Click Save in Details window.

10. Click Continue in the Save Preview window.

11.  Go to Agile Web client to check the Design Relationship Tab.

 Result: The old Item is be deleted from the Design Relationship and only the 
newly assigned one is linked to the Design.
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4Known Issues Introduction

This chapter contains a list of known issues for this release. These were deferred from 
this release, but may be fixed in a future release. Numbers in this section are for Oracle 
Agile internal use only.

Known Issue Disclaimer
This list of Known Issues consists of those found at the time of the initial release. The 
product may have additional issues found after the initial release and therefore this list 
is subject to change and is not always comprehensive. Oracle support will continue to 
track known issues of this product release found on My Oracle Support. Please check 
for updates at https://support.oracle.com.

20978717

Folders, Files, and Attachments

Issue: UNABLE TO ADD OR GET OR DELETE FILES IN WEB DAV ON LINUX 7 OS

Steps to Reproduce: 

1. Configure Web Dav on Linux 7.

2. Go to Web Dav and any of the folders Searches or Recently Visited or Bookmarks.

3. Navigate to BO folder.

4. Copy a file from local system and paste it to BO folder.

Result: Unable to add file to BO folder on Web Dav.

5. Copy a file from BO folder of Web Dav and paste it to local system.

Result: Unable to add file to BO folder on Web Dav.

6. Delete a file from BO folder of Web Dav

Result: Unable to delete file from BO folder on Web Dav.

Workaround: N/A

21117934

Software Development Kit

Issue: CAN ENABLE AF AND AI TABLE IN THE SAME TIME VIA SDK

Steps to Reproduce:
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1. Enable the Affected Files table in the Subclass ECO.

INode afTab = session.getAdminInstance().getNode("DFCO.Affecte dFi les");

IProperty visibleAF = afTab.getProperty(PropertyConstants.PROP_VISIBLE);

visibleAF.setValue("Yes");

Actual Result: The Affected Files table is enabled, but the Affected Items table is not 
disabled.

Expected Result: The Affected Files table is enabled, meanwhile, the Affected Items 
table is disabled.

Workaround: In 935, when a user tries to enable Affected files table of DFCO via SDK, 
the user needs to disable the Affected Items table of DFCO in the same time.

>>>

//enable DFCO AF table

INode afTab = session.getAdminInstance().getNode("DFCO.AffectedFiles");

IProperty visibleAF =afTab.getProperty(PropertyConstants.PROP_VISIBLE);

visibleAF.setValue("Yes");

//disable DFCO AI table

INode aiTab = session.getAdminInstance().getNode("DFCO.AffectedItems");

IProperty visibleAI = aiTab.getProperty(PropertyConstants.PROP_VISIBLE);

visibleAI.setValue("No");

21154032

Folders, Files, and Attachments

Issue: ERROR MESSAGE `AFFECTED FILE FOLDER <FOLDERNAME> IS 
ALREADY IN THE TAB

Steps to Reproduce: 

1. Access DFCO.

2. Add > By Search add design1.

3. Add > By Search with Include Files on Active Changes selected.

4. From search result select design1

Actual Result: Error message is not shown.

Expected Result: The error message,"Affected File Folder <Foldername> is already 
in the table" should show for duplicate row.

Workaround: N/A

21796320

Folders, Files, and Attachments

Issue: ASSOCIATE REDLINE SEARCH RESULTS DOES NOT REFLECT ECR FOR 
MARKUP CREATED 

Steps to Reproduce:
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1. Log in to Web Client.

2. Create an ECR, and add a file of File Folder to the Attachments tab.

3. Redline the attachment.

4. Create a DFCO, navigate to Affected Files tab.

5. Add the same file of File Folder in the Affected Files tab as added in the ECR 
Attachments.

6. Select the added file and click on Redline /Markup Files tab.

7. Click on Add > Associate Redlines.

8. Verify the search results.

Actual Result: The search results do not show the ECR number in the Number 
column. Instead it shows a File Folder Number in the Number.column in the 
Search Results window.

Expected Result: The Search Results should display the ECR number in the Number 
column of the Search Results window.

Workaround: N/A

21880382

Folders, Files, and Attachments

Issue: ASSOCIATE REDLINES DOES NOT PULL THE REMOVED REDLINES IN 
MARKUP TABLE

Steps to Reproduce:

1. Log in to Web Client.

2. Create a Design/File Folder and add a file.

3. Create DFCO and add the new Design/File Folder.

4. Navigate to the Affected Files tab.

5. Select the row and click on View/Redlines.

6. Redline the file and validate the markup table.

7. Select the markup row in the redlines/markup tables and click on the Remove 
button.

8. Select the same affected files and click on Associate Redlines.

9. Click on the checkbox for Include Markup from the affected files.

Actual Result: Observe that the newly created markup for the affected file is not 
pulled in.

Expected Result: Should allow to Associate the removed markup file.

Workaround: N/A

22076419

Notifications and Subscriptions
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Issue: APPROVE NOTIFICATION OF INBOX SHOWS BLANK WHEN ECO 
NUMBER HAS SINGLE QUOTES

Steps to Reproduce:

1. Log in to Agile as admin.

2. Create an ECO with name 15600-SA='3.

3. Submit the ECO to CCB status.

4. Add admin as approver.

5. Go to the home page and go to the Notification tab.

6. Open the approver notification

Actual Result: The body is blank.

Expected Result: The message should be showed in the notification box.

Workaround: N/A

22201789

Web Client

Issue: THE NUMERIC VALUE CAN NOT REMOVED AFTER USER SAVED NEW 
VALUE AND DELETE IT AGAIN

Steps to Reproduce:

1. Log in to the Web Client as admin.

2. Create a Part.

3. Modify p2.Numeric06 with 5.

4. Save.

5. Click the Edit button.

6. Remove 5 and click the Save button.

Actual Result: The Numeric06 values are still with 5.

Expected Result: It should have removed 5 and saved blank.

Workaround: N/A

22215804

Folders, Files, and Attachments

Issue: USER IS ABLE TO GET MARKUPFILE WHEN THERE IS NO GET PRIV ON 
AFS ROW

Steps to Reproduce:

1. Log into Java Client.

2. Create a  user with the role assigned,where the user has the following URL:

Display No Privilege Fields

dm-AddtoTableDesignChanges

dm-checkinallDFCO
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dm-CheckinAllFiles

dm-CheckoutAllFile

dm-checkoutAllFilesforDFCO

dm-Create-All-FileFolders

dm-Create_DFCO

dm-Discover-All-FileFolders

dm-Discover_All_DFCO

dm-Modify-All-FileFolders

dm-Modify_All_DFCO

dm-GETFILE for All DFCOs  with Criteria "Change

Affected Files.Folder Owner Equal to "$USER"

dm-Read-All-FileFolders

dm-Read_All_DFCO

Enforce Field Level Read

3. Log in as admin user and create DFCO.

4. Navigate to Affected files tab and add files such as prt,doc, txt etc. and assign the 
above created user as folder owner for some of the files.

5. Add Markup/Redlines for all the affected files.

6. Log in as the user, and search for the above DFCO.

7. Navigate to Affected files tab and select the row where the folder owner is not the 
logged in user.

8. Go to Markup/Redlines table and select the redlines/markups and click on GET.

Actual Result: User is able to Get/Open the file, though there is no Get/Open 
privilege on Affected files row.

Expected Result: User should not be able to get/open redlines/markup where the 
folder owner is not the current user.

NOTE: 1. User is also able to view file in redline/markup files table if the folder 
owner is not the logged in user in Affected files tab of DFCO.

2. Add/Remove is also not working with OOB available criteria - All Design File 
Changes Created by Me and Pending Design File Changes. Only works for All 
Design File Changes.

Workaround: N/A

22228969

Export

Issue: READ THROUGH FILE FOLDER VERSION ATTRIBUTES ON AF TAB ARE 
NOT EXPORTED 

Steps to Reproduce:

1. Log in to Java Client as admin.
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2. Enable the following version attributes on File Folder:

File Folder.P2.MultiList20

File Folder.P2.List30

File Folder.P2.Text30

File Folder.P2.Date20

File Folder.P2.Money15

File Folder.P2.Numeric15

File Folder.P2.MultiText60

3. Enable the following read through attributes on DFCO:

DFCO.Affected Files.File Folder P2 MultiList20

DFCO.Affected Files.File Folder P2 List30

DFCO.Affected Files.File Folder P2 Text30

DFCO.Affected Files.File Folder P2 Date20

DFCO.Affected Files.File Folder P2 Money15

DFCO.Affected Files.File Folder P2 Numeric15

DFCO.Affected Files.File Folder P2 MultiText60

DFCO.Affected Files.File Folder P2 Numeric15

4. Apply the previous attributes to Read/Modify privilege.

5. Log in to Web Client.

6. Create a DFCO, DFCO0001.

7. Add a file to the Affected Files tab.

8. Click the File Folder on the Affected Files tab, and edit the attributes on Page Two.

9. Open DFCO0001 and export it to EXCEL/CSV/AXML.

Actual Result: The data for the read through File Folder P2 version attributes are 
not exported.

Expected Result: The data for the read through File Folder P2 version attributes 
should be exported.

Workaround: N/A

22253627

Workflow

Issue: GOT "INDEX: 2, SIZE: 2" ERROR WHEN TRYING TO RELEASE DEVIATION 
WITH SPECIAL WF

Steps to Reproduce:

1. Log in to Java Client as admin.

2. Go to Data Settings > Criteria, and create a criteria with name: 
CriteriaForDeviationWithAttachment, set Object Type = Deviations, Condition = 
Attachments.File Type Is Not Null.
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3. Go to Workflow Settings > Workflows, save as Default Deviations workflow to a 
new Deviations workflow with name: Deviations Workflow with Attachments.

4. Go to CCB Status, add the newly created criteria into CCB status' Criteria table, set 
Exit Required Fields with Deviations.CoverPage.Description and 
Parts.Attachments.FileDescription.

5. Create Pre-Release status of Review status type under CCB status with All 
Deviations criteria.

6. Enable the new workflow.

7. Create change status privileges for the new workflow and assign to administrator 
role.

8. Log in to Web Client as admin.

9. Create a change Deviation01, set workflow as: Deviations Workflow with 
Attachments.

10. Go to Attachments table, and add 2 attachments.

11. Go to the Affected Items (AI) table, add 3 Parts into the AI table, and for each part 
add one attachment.

12. Set values for the required attributes.

13. Route CCB to Pre-Release.

Actual Result: See the attached snapshot. And error "Index: 2, Size: 2" got. Status 
stays at CCB.

Expected Result: Status is changed to Pre-Release without any error message.

Workaround: N/A

22262065

Folders, Files, and Attachments

Issue: PRIV USER IS UNABLE TO DO REDLINE FOR OTHERS IN DFCO->AFS TAB

Steps to Reproduce: 

1. Create a user with a role with the following privileges:

Add to Table All Design Changes

Delete From Table All Design Changes

Attachment Redlines for Change Order Affected

Files for Self.

Attachment Redlines for Change Order Affected

Files for Others

Cancel Checkout All Design File Changes

Checkin All Design File Changes

Checkin All Markups

Checkout All Design File Changes

Cancel Checkout Designs
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Cancel checkout for File Folders

Checkin Designs

Checkin for File Folders

Checkin My Markups

Checkout Designs

Checkout for File Folders

Checkout My Markups

Checkout All Markups

Create Designs

Create Eng Changes

Create File Folders

Create Markups

Display No Privilege Fields

Discover Changes

Discover Designs

Enforce Field Level Read.

GetFile All Design File Changes

Modify Design File Changes

Modify Designs

Modify File Folders

Modify My Markups

Modify All Markups

Read Design Changes

Read Designs

Read File Folders

Read My Markups

Read All Markups

ViewFile All Design File Changes

2. Log in as admin user.

3. Create a DFCO.

4. Add Affected Files, create redline.

5. Log in as the privileged user created above.

6.  Search for DFCO.

7. Select the Affected Files row to view.

8. Select a row, which has redlines of admin user, view the file, select the markup 
layer which has admin user's redlines saved.

9. Try to modify the redline made by admin user and save the changes.
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Actual Result: User is not able to save the changes with insufficient privilege error 
though the user has Attachment Redlines for Change Order Affected Files for 
Others Attachment Redlines for Change Order Affected Files for Self privileges.

Expected Result: User should be able to modify the redline created by admin user.

Workaround: Add the privilege: Attachment Redlines for Eng Changes for Others. 
works fine.

22290977

Gantt Chart

Issue: SAVE FROM NAVIGATOR WARNING IS NOT SAVING THE CHANGES 
MADE

Steps to Reproduce:

1. Log in to Web Client.

2. Launch single-project Gantt.

3. In Gantt, create a new project, P1.

4. Without updating Gantt, invoke Navigator and add another root project, e.g. P2, 
and apply.

5. Delete the P1 row from Navigator and click on Apply/Exit.

Note: It prompts warning to save unsaved data with 'Save, Discard and Cancel' 
buttons.

Actual Result: The click on Save is not saving the new project, P1, to the server and 
not removing P1 from Gantt display.

Expected Result: Click on Apply in Navigator dialog, save warning gets prompted, 
there click on Discard is not removing the new project row from Gantt by ignoring 
the newly created project. The Gantt error display area is showing invalid error 
saying 'Activity <ID> does not exists'.

Workaround: N/A

22297464

Folders, Files, and Attachments

Issue: GETTING ERROR WHILE EDITING FF->P2/P3 LARGE TEXT ATTRIBUTEB

Steps to Reproduce: 

1. Log in to Java Client.

2. Open Smart rules from System settings and set object Edit Conflict to Disallow.

3. Enable File Folder Pagetwo/Pagethree Large text attributes.

4. Log in to Web Client.

5. Create a File Folder and try to edit P2,P3Large text attributes.

Actual Result: Get the following error:

This object has been modified by another user. Saving your changes will overwrite 
previous changes. Select Continue to save your changes or select Cancel to cancel 
your changes.
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Expected Result: The error message should come up only when more than one user 
is trying to edit the same file folder. The same issue occurs when the smart rule is 
set to Warning.

Workaround: N/A

22299179

Folders, Files, and Attachments

Issue: NOT ISSUING ERROR MESSAGE OF CURRENT REDLINE PROCESS WHEN 
USER TRIES TO MODIFY REDLINE

Steps to Reproduce:

1. Create a Design, add files and check in.

2. Add Design to ECR, redline the files.

3. Add Design to ECO - Affected Item (Attachments), redline the files.

4. Create a DFCO on Design.

5. Add Design.

6. Select Design, Navigate to Redline/markup files table.

7. Associate redlines of ECO/ECR.

8. View the associated makrups from redline/markup files table and try to edit 
already done markups.

Actual Result: Issues a error message: Cannot find this redline (may be its not 
associated with current file). Please see the server log to find more detail regarding 
exact cause of failure

There is no message to user on editing non current redline process.

Expected Result: There should be a message to the user regarding editing the non- 
current redline process.

Workaround: N/A

22350941

Folders, Files, and Attachments

Issue:  SHOULD NOT ALLOW TO CREATE/MODIFY REDLINE IN CANCELED 
WORKFLOW STATUS

Steps to Reproduce:

1. Access a DFCO; Set "Default Design File Change Orders" workflow.

2. Add Affected Files, do redline.

3. Route the status to cancel.

4.  Select Affected Files > Redline/markup files table. Select mkd file to 
View/Redline.

5. Try to redline from viewer for the Affected Files|Redline/markup files tab in 
cancelled status.

Actual Result: User can create redlines in canceled status.
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Expected Result: The user should not be able to create/modify redline in canceled 
workflow status from redline/markup table.

Workaround: N/A
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